part of everyday life

net
Make the Inter and money!

and save time

ghe

* Getting Started

* Exploring the Internet

* E-mailing

* Quick Communicating

* Your Personal Finances
* Bargain Shopping

* Selling on the Internet
* Hobbies and Pastimes

Peter Weverka




The Everyday
Internet

ALL-IN-ONE DESK REFERENCE

|JO)

DUMMIES

by Peter Weverka

WILEY
Wiley Publishing, Inc.






The Everyday
Internet

ALL-IN-ONE DESK REFERENCE

FOR

DUMMIES







The Everyday
Internet

ALL-IN-ONE DESK REFERENCE

|JO)

DUMMIES

by Peter Weverka

WILEY
Wiley Publishing, Inc.



The Everyday Internet All-In-One Desk Reference For Dummies®

Published by

Wiley Publishing, Inc.
111 River Street
Hoboken, NJ 07030-5774
www.wiley.com

Copyright © 2005 by Wiley Publishing, Inc., Indianapolis, Indiana
Published by Wiley Publishing, Inc., Indianapolis, Indiana
Published simultaneously in Canada

No part of this publication may be reproduced, stored in a retrieval system or transmitted in any form or
by any means, electronic, mechanical, photocopying, recording, scanning or otherwise, except as permit-
ted under Sections 107 or 108 of the 1976 United States Copyright Act, without either the prior written
permission of the Publisher, or authorization through payment of the appropriate per-copy fee to the
Copyright Clearance Center, 222 Rosewood Drive, Danvers, MA 01923, (978) 750-8400, fax (978) 646-8600.
Requests to the Publisher for permission should be addressed to the Legal Department, Wiley Publishing,
Inc., 10475 Crosspoint Blvd., Indianapolis, IN 46256, (317) 572-3447, fax (317) 572-4355, or online at
http://www.wiley.com/go/permissions.

Trademarks: Wiley, the Wiley Publishing logo, For Dummies, the Dummies Man logo, A Reference for the
Rest of Us!, The Dummies Way, Dummies Daily, The Fun and Easy Way, Dummies.com, and related trade
dress are trademarks or registered trademarks of John Wiley & Sons, Inc. and/or its affiliates in the United
States and other countries, and may not be used without written permission. [Insert third party trade-
marks from book title or included logos here.] All other trademarks are the property of their respective
owners. Wiley Publishing, Inc., is not associated with any product or vendor mentioned in this book.

LIMIT OF LIABILITY/DISCLAIMER OF WARRANTY: THE PUBLISHER AND THE AUTHOR MAKE NO REPRESENTATIONS
OR WARRANTIES WITH RESPECT TO THE ACCURACY OR COMPLETENESS OF THE CONTENTS OF THIS WORK AND
SPECIFICALLY DISCLAIM ALL WARRANTIES, INCLUDING WITHOUT LIMITATION WARRANTIES OF FITNESS FOR A
PARTICULAR PURPOSE. NO WARRANTY MAY BE CREATED OR EXTENDED BY SALES OR PROMOTIONAL MATERIALS.
THE ADVICE AND STRATEGIES CONTAINED HEREIN MAY NOT BE SUITABLE FOR EVERY SITUATION. THIS WORK IS
SOLD WITH THE UNDERSTANDING THAT THE PUBLISHER IS NOT ENGAGED IN RENDERING LEGAL, ACCOUNTING,
OR OTHER PROFESSIONAL SERVICES. IF PROFESSIONAL ASSISTANCE IS REQUIRED, THE SERVICES OF A COMPE-
TENT PROFESSIONAL PERSON SHOULD BE SOUGHT. NEITHER THE PUBLISHER NOR THE AUTHOR SHALL BE LIABLE
FOR DAMAGES ARISING HEREFROM. THE FACT THAT AN ORGANIZATION OR WEBSITE IS REFERRED TO IN THIS
WORK AS A CITATION AND/OR A POTENTIAL SOURCE OF FURTHER INFORMATION DOES NOT MEAN THAT THE
AUTHOR OR THE PUBLISHER ENDORSES THE INFORMATION THE ORGANIZATION OR WEBSITE MAY PROVIDE OR
RECOMMENDATIONS IT MAY MAKE. FURTHER, READERS SHOULD BE AWARE THAT INTERNET WEBSITES LISTED IN
THIS WORK MAY HAVE CHANGED OR DISAPPEARED BETWEEN WHEN THIS WORK WAS WRITTEN AND WHEN IT
IS READ. FULFILLMENT OF EACH COUPON OFFER IS THE SOLE RESPONSIBILITY OF THE OFFEROR.

For general information on our other products and services, please contact our Customer Care
Department within the U.S. at 800-762-2974, outside the U.S. at 317-572-3993, or fax 317-572-4002.

For technical support, please visit www.wiley.com/techsupport.

Wiley also publishes its books in a variety of electronic formats. Some content that appears in print may
not be available in electronic books.

Library of Congress Control Number: 2005923066
ISBN-13: 978-0-7645-8875-4

ISBN-10: 0-7645-8875-3

Manufactured in the United States of America
109 87654321

10/RY/QU/QV/IN

WILEY



About the Author

Peter Weverka is the bestselling author of several For Dummies books,
including Microsoft Office 2003 All-in-One Desk Reference For Dummies and
Microsoft Money 2005 For Dummies. He has written a grand total of 25 com-
puter books. His humorous articles and stories — none related to computers,
thankfully — have appeared in Harper’s, SPY, and other magazines for
grownups.






Dedication

For Aiko Sofia and Henry Gabriel.

Author’s Acknowledgments

This book owes a lot to many hard-working people at the offices of John
Wiley & Sons in Indiana. | would especially like to thank Steve Hayes for his
good advice and for giving me the opportunity to write this and other books
for Wiley.

The Internet is a big subject. I called on many friends and acquaintances to
help me illuminate the far corners of the Internet. Thank you very much

Jack Arnoux, John Boit, John Calder, Mona Dahl, Phil Gough, Kenneth Howard,
Rob Rummel-Hudson, Michael Taylor, and Valentine Wannop.

Many thanks as well go to Beth Taylor, this book’s project editor, for her
diligence and grace under pressure, and John Edwards for copyediting the
manuscript with so much care and attention. [ would also like to thank Lee
Musick, the technical editor, for following in my footsteps and making sure
this book is indeed accurate. The witty cartoons on the pages of this book
were drawn and captioned by Rich Tennant, and I thank him for it. [ would
also like to thank Anne Leach for writing the index.

Finally, thanks go to my family — Sofia, Henry, and Addie — for tolerating my
odd working hours and my vampire demeanor at daybreak.



Publisher’s Acknowledgments

We're proud of this book; please send us your comments through our online registration form located
at www.dummies.com/register/.

Some of the people who helped bring this book to market include the following:

Acquisitions, Editorial, and Composition Services

Media Development Project Coordinator: Nancee Reeves

Project Editor: Beth Taylor Layout and Graphics: Andrea Dahl,

Acquisitions Editor: Steven Hayes Denny Hager, Stephanie D. Jumper,
Barry Offringa, Melanee Prendergast,

C Editor: John Edward
opy Editor: John Edwards Heather Ryan

Technical Editor: Lee Musick

Editorial Manager: Leah Cameron

Proofreaders: John Greenough, Leeann Harney

Indexer: Anne Leach
Media Development Supervisor:

Richard Graves
Editorial Assistant: Amanda Foxworth

Cartoons: Rich Tennant (www.the5thwave.com)

Publishing and Editorial for Technology Dummies
Richard Swadley, Vice President and Executive Group Publisher
Andy Cummings, Vice President and Publisher
Mary Bednarek, Executive Acquisitions Director
Mary C. Corder, Editorial Director
Publishing for Consumer Dummies
Diane Graves Steele, Vice President and Publisher
Joyce Pepple, Acquisitions Director
Composition Services
Gerry Fahey, Vice President of Production Services

Debbie Stailey, Director of Composition Services



Contents at a Glance

INEFOAUCEION .......eeeeeeeeeeaaaeeeeeeeeeennnnaeeeeeeeeeennnnnseeeeeeeeenns ]

Book I: Getting Started ..............cccueecceneiceecacencaseecaneeesd

Chapter 1: Getting Acquainted with the Internet ............cccccoieiiiiiciinieneeecee, 11
Chapter 2: Choosing an Internet SErvicCe .........ccoccovvieriineiieriiniienienieneestese e 25
Chapter 3: Setting Up Your Internet Connections ..........cccccecevvierviencienieeneeneeneeneeenne 31
Chapter 4: Protecting Your Privacy and S€CUFitY ........ccccecveeciieciierieciienienieneecieeieeee 39
Chapter 5: Using America ONINE ..........coovevieeiieeieiienieneeie et see e sreesaeeeseeanas 57
Chapter 6: Getting the Plug-Ins You Need .........ccocvvviiniriiniiniinieniccceceeeeeeen 67
Chapter 7: The Internet for Children and Parents .........cccccoccevvievvienciencenieneeneeniennne. 75
Book 11: Exploring the Internet..............ccceeceeeceeeiceeeen 85
Chapter 1: Browsing around the Internet ...........ccccccoeveeieiieiiniiciececcceeeee e, 87
Chapter 2: A Look at Different BrOWSETIS .........cccceviivieiiieiiieiicteeeeeeseeee e 103
Chapter 3: Strategies for Internet Searching ..........coceeveeviniinienienienieeeeeieeiens 113
Chapter 4: Advanced Tools for Scholars and Researchers ..........cccccoecvevirveeviennnnnns 135
Chapter 5: The Internet as a Reference Library .........ccccocoeevievieevenienieneeseeieeiens 149
Chapter 6: Read All aDOUL It ......ccooeriiiriniiiiircieeeer et 157
Book 111: E-MAilinng............cccceeeeeeeeecceeecceeeeceeneicneanens 171
Chapter 1: A Quick Introduction to E-Mailing .........cccceveviiriiiniieniienieniiienceieeiens 173
Chapter 2: E-Mailing with OUtlook .........cccoeciiriiiiiiiiiiicceeeeeeeee e 181
Chapter 3: E-Mailing with Outlook EXPress .........cccccoevieviieiiieiiinieeieceeseeeesieeie e 209
Chapter 4: Yahoo! and Other Web-Based E-Mail Services ..........ccceovevvevieevieecieennenns 223
Chapter 5: Only You Can Prevent Spam ..........ccccceceeeieriereninesieeeceeesesee e 237

Book 1V: Quick Communicating.................cccceeereeecneeec 249

Chapter 1: Instant MeSSAGING ......ccceeviriiiriiiriiiniinieriereesteese et etesee e esbeesbeesaeesesneeens 251
Chapter 2: Blogs and Online JOUrnals .........cccccceevverienienieiieiecieceeseeseese e eae e 261
Chapter 3: Mailing Lists and Message Boards .........ccccccceeevieciieieeienienieeeesieeieenens 273
Chapter 4: Newsgroups and the Usenet ..........cccccooieviiniriiniiiniieniienieneenieenieeieeeens 283
Chapter 5: Joining, Starting, and Managing a Yahoo! Group ...........ccccceeveevereeneennne. 305
Chapter 6: Chatting ONINE ..........ccceiieiiieiiieieciececeee et saeeaeeee e 325
Chapter 7: Free Web Sites at Yahoo! GEOCIties .......ccceveeciieciiiieeieniesiieeeeeieeeens 331
Chapter 8: Making Friends and Connections Online .............ccccoevevvieneinennenniennnnnns 349

Chapter 9: Using Your PC as a Telephone ...........cccovievieiiniiiniieniieneeneeeenieeieenens 361



Book U: Your Personal Finances..............cccccoeuecceeeeecec 307

Chapter 1: Searching for Financial Information ...........ccccoeceviiniiniininniinnineniennne 369
Chapter 2: Monitoring and Tracking Investments ..........cccccoceeveevieeviencieniienieeneenieens 383
Chapter 3: Banking and Paying Bills Online ...........ccccoceviririnnniinenenenceceeeienns 393

Book Ul: Bargain Shopping...............ccceeecveececeeeeees 401

Chapter 1: Searching for Bargains .........coccevevviiiiniiiniiinienicieceeeeese e 403
Chapter 2: Buying at an Online AUCHION ........cccocuiriiiriieniieniieeeeeceee e 413
Chapter 3: Using PayPal ........cccooiiiiiiie ettt 429
Chapter 4: Taking a Stroll through the Cyberbazaar .........cccccocevinerenncceneeninnne, 435
Book UlI: Selling on the Internet..............cccceeeeeeenee. 545
Chapter 1: Selling [tems 0n €Bay .......cccccevieriiiiiiiiinienieeetteeeee e 447
Chapter 2: Selling [tems ONliNe ..........ccocevieriiiiiiiiinienieeenteeeeeeee e 457
Chapter 3: Sending It t0 the BUYET .......ccccveviiiiiiiiiiiiciececteeeeee e 463
Book VIIl: Hobbies and Pastimes .................ccccccveeee... 569
Chapter 1: Playing Games ONlNe .........ccccoeiriririieniineresieeeeee e 471
Chapter 2: Planning Your Next Vacation ..........ccccoeveviinieninninnennienieniesienceieeiens 479
Chapter 3: Let Me Entertain YOU .......cccccoevievieviiiiiniienienienteseeseesieeee e see e saeen 497
Chapter 4: The Internet for MUSIC LOVETS ......cccccieiieiiiienieiicieeiecieeie e 509
Chapter 5: Buying and Playing Music with iTunes ..........ccccocceeveienenenenncceeeienn, 517
Chapter 6: Genealogy ONIINE .........ccocoviiriiriiiiniiiieniente et ens 531
Book 1X: Appendixes ............ccccuecceeiceeeieeesnvencaseneanes 541
Appendix A: Signing Up for a Yahoo! ID .........ccccveievierienieececeeeeeeee e 543
Appendix B: Getting a .NET PaSSPOIt ......ccccccveiieiiieiieieeiecieseeeeieeieeve e 551
Appendix C: Getting a Google ACCOUNT ......ccooueeuieiiiiiieieeeeee e 555
Glossary of Internet TEIMS .........ccccevivirieiieieieereec ettt sae e snens 557

I0deft ..c..eeeaaeaaaecnacaeeceeaneceesnennessasnesaessnesnessaeses D 1 |



Table of Contents

JEFOAUCEION «..aeeeeeeeeeeaaeeeeeeeeeennnaaeeeeeeeeennnnnnseeseeeeeennnnns ]

What’s in This BOOK, ANYWAY? ......ccoviiiiiriiiiiriinienienteseeieeie e 1
Book I: Getting Started .........cocevienieniiniiiieeicceeeece e 1
Book II: Exploring the Internet ...........cccocoveeeiiiiiiniiceeeeeeee 2
BOOK III: E-MAIlING ...cveeiieiiieieeieciiciteieeieee ettt 2
Book IV: Quick Communicating ........ccecceevveevierieneeneenieeieesieeveseeenenn 3
Book V: Your Personal Finances .........ccccoccevvveviincienensinninieeieeeenen 3
Book VI: Bargain Shopping ........ccccceevieviviiniiiniinicncceeieeeseeseenen 4
Book VII: Selling on the Internet .........ccccoccevvirviinviiniinninneneneeieee, 4
Book VIII: Hobbies and Pastimes ............cccoecvveireienienenenecceeceeeene 4
BOOK IX: ADPENAIXES ....ooevieeieeiieciieiieiieieete ettt reeaeeaessaeseeas 5

How I Selected Web Sites for This BoOK ..........cccccvevvenieveeviiciicieeieeees 5

Foolish ASSUMPIONS .....cccuiviiiiiiiiiriciecececectest ettt 6

Conventions Used in This BOOK ........cccoccovviiriiiniiiniiniiieieciecieeieeceeene 6

Icons Used in This BOOK ......cccoctiriiniiiiiiiiiiiinientctceceeieeee et 7

GOoOd LUCK, REAAET! ..ottt s e s e 7

Book I: Getting Started..............ccccueeicueecceeeaceeeaseecascenesd

Contents at @ GIANCE ........ccoociiviiniiriiieeieeeteee et 10
Chapter 1: Getting Acquainted with the Internet ................. 1"
What Is the INternet? ...ttt 11

How the Internet WOrks ..........ccoooveeiririeieieeeeceeeeeee e 14

A mercifully brief history of the Internet .........c.ccccoooveviirveneenennn. 14

The World Wide WED ........cccooiieiiiieiceceeeeeeeeeeee e 15

WED AdAYESSES ....coveviieiiiiieieeieeteetese ettt st st saeesae e s 17

[P AddYESSES ...oovieiieiieiiiieeteetet ettt sttt 18

Finding a Web site’s IP address ..........ccceeveviiniinienenncniiniecieneee 20

How Web Pages WOTK ........cccuiiiiiiiieiiieieeceeeeeeee ettt 21
Chapter 2: Choosing an Internet Service ........................ 25
The Equipment and Software You Need .........ccccoccvevievieecieeciecieeeeeeeieenne. 25
Broadband versus Dialup Connections ...........ccccccevevenenienenieneneneeenen. 26
Types Of CONNECHIONS .....ccueeviiiiriiiierieeieeieeeet e sre et eeesae e 27
Choosing an Internet Service Provider ..........ccccoccevvveveeveeviencennieneeneenne. 28
Monthly service charge ........ccccocovieriininieniinienceeeeeeee e 28

The SEtUP fE€ ...veieeeeeeeeeeee e 28
Long-distance dialup .........ccccceriiieeiiiriiieieecieeeeeee e 28

ONINE HIME ..ovvivieiieiicieeieeeeese ettt be b e aeeaesnae e 28

Server space for your Web Pages .......cccceecveeieeienieeneenieenieenieeeeneens 28

Spam blocking and virus protection ..........c.ccceccevveeveevercierrienieenieenns 29



xii The Everyday Internet All-In-One Desk Reference For Dummies

Length-of-service contracts ........cccceveeveevieniiinnieniienieneeneeieeeeseene 29
Technical Relp .....oociiviiiiiieeeee e 29
Chapter 3: Setting Up Your Internet Connections ................. 31
Connecting with a Dialup Modem ..........ccoceviiniiniininnienienieneeeeeeeeee, 31
Before you Degin .........cccoecvieeciiiiieeeceeeeeeeee e 32
Dialup connections for Windows XP USEers .........cccccevvevieerieevennnnne 33
Dialup connections for Windows 98, 2000, and Me users .............. 34
Connecting with a DSL or Cable Modem ...........cccceeveeviervierrierieniieneenenenes 34
Before YOU DEZIN .......cceeeiiiiieiieeceeeeee et 35
Making the cOnnection ...........ccoceceevieeienienenecieeee e 35
Setting Up an E-Mail ACCOUNt .......ccceeeieviieiiieieeieceeceeceee e 36
Chapter 4: Protecting Your Privacy and Security ................. 39
Preventing a Virus Attack .......cccccooeeerinieieieeeeeeeeee e 39
Only you can prevent viruses from spreading ............cccceecevereencnne 40
Differentiating types of VIruSes ........cccooeevueeiiiniencienenreeeciecieeeee 42

How virus infections spread ...........ccoccoveeverciencieniieneeneeieeieeieneene 42
Looking at antivirus software ..........c.ccoceevevviiniiiniienennenieeieeieneene 43
Making Sure Your Copy of Windows Is Up to Date .........ccccceevieriiniennnnne. 46
Checking whether Windows is up to date — and updating ........... 46
Choosing how to update your copy of Windows .........cc.ccceeeeeenens 47
Protecting Your Computer with a Firewall ...........cccccovvvvviiviniiinciiniennne, 49
A'look at third-party firewalls .........cceceviiiiiiiniiiineceee 49
Turning the Windows XP firewall on or off ........c..ccccoviniininnnnnn. 50
What to Do about Spyware and Adware .........ccccocevvievvienenninnennienieneene 51
Preventing Identification Theft ...........ccocooieiirininineee, 53
Chapter 5: Using AmericaOnline .............................. 57
INStAllING AOL ...cooiiiiiiieieeeeee ettt ettt st ees 57
SigNINg 0N 10 AOL ...c..ooviieieiieieiecieceeeeeeeeeete ettt ettt e aaas 58
A Short Geography LESSON ........cccceeveeiieieieieieece et 59
Handling Incoming E-Mail ........ccccooviiiiiiiininiiniiicneeceeeeeeeeeee e 60
Reading incoming mail .........cccceeviiniiniininiinienienccceceeeee e 60
Receiving a file .......ooooiiiiiiiiiiie e 61
Managing your €-mail ..........ccocceeiririiiiienieeeeee e 62
Composing and Sending E-Mail ........ccccocovviriiiiininininineeeieeeeceeeen 63
Writing an e-mail .......cccoveevieriiriiniecieceeeeeeeeee e 63
Replying to and forwarding messages ........cccoccevvververeenieeniersveninenne 64
Sending @ file .......coceviiiiiriiiiece e 64
Maintaining an Address BOOK .........ccoocevviiiiniienieniieniecccceeeeeeeeeee 64
Exploring the Internet in AOL ........cccoociviiieiiininieeee e 66
Chapter 6: Getting the Plug-Ins YouNeed ....................... 67
Introducing PIUG-INS ....cc.cooiiiiiiiiiiiieeeeetteeeee e 67
A Roster of Plug-In Programs ...........ccccceevverienieeiieecieeieeeeseeseesieesieeve e e 68
Acrobat Reader .........coccoiiiiiiniiiiiieeeeeee e 68

FIash PIAYEY .....ocviviiiiiiieiecteceeteteteeee ettt 70



Table of Contents  XIII

Microsoft Office Programs ..........ccccocevvienvieniienieneenenieniesieneeneenne 71
QUICKTIME PIAYET ....ccevvieiiieiieeeeeeeee et 71
REAIPIAYET ...ceveiiiiiiieeiietete ettt ettt 72
Windows Media PIayer .........ccccccoeieeienieciieieeiecieeeeseesee e 74
Chapter 7: The Internet for Children and Parents ................ 75
Supervising Kids on the Internet ...........cccoccoceveiinininnieierereseeeeee 75
Talking to Children about the Internet ..........c.ccccoevveviinieiiniiiecieceeeee 76
Looking at filtering and monitoring software .........c..ccccoevenenenen. 7
Discovering search engines designed for children ......................... 78
Finding Parenting Help on the Internet ............ccccoviniiniiniininiiceee, 79
Finding a School for Your Child ..........ccoeieiiiiiiiiieeeeee e 81
Kids” HEAlth ...ovoiiiiiieieee ettt 81
Getting Help with Your HOmMework .........cccoocveviiviiiiiniieieceeceeceeeeee, 82
Finding Colleges and College Scholarships ..........cccccoceevierciinieniencenennee. 83

Book I1: Exploring the Internet ..............c..ccceueeceeeceeeenn 85

Contents at @ GIANCE .......ccoeeeieiiienieneeeee et 86
Chapter 1: Browsing around the Internet ........................ 87
Navigation BaSICS .....cccceviiiiiiieiiiecieee ettt 87
Visiting a Web site whose address you Know .........c.cccceevvevvvenvennnnne 88

Clicking hyperlinks to get from page to page ......c..ccccoccevevenencnen. 89

Revisiting Web pages you’ve been to before .........ccccccoecierieninnenns 90

Choosing Your Home Page ..........cccooerivininieieeeeecceeeeeee e 91
Bookmarking Your Favorite Web Pages .........ccccoceviiviiecienciecieneeeeeee, 93
Going to a page you bookmarked ...........ccccoecvevienienienniincienieeieneene 93
Bookmarking a favorite page ..........ccccoceevieniinieneeneeeeeeeeeeee 94

Renaming, deleting, and managing bookmarks .........c.ccccceeeencnnen. 95

Backing up your bookmarks ...........cocceeveriieniiniiniinnenieieneeneeeee 97

Social Bookmarking, or Sharing Bookmarks with Others ........................ 98
Downloading and Copying Files from the Internet ..........c..ccccoceeiniinniie. 100
Chapter 2: A Look at Different Browsers ....................... 103
Comparing the Different BIOWSErs ........ccccocoveiininininnieieneneeneeeeene 103
Customizing YOUr BrOWSET .......cccooiivienieiiieieeiecieeteetesee st see e 106
Making the text easier to read .........cccoceeveeveeveecenrienieeieeeeneee 106

Wrestling with the toolbars and status bar ..........cccocevvieneenennne. 108
Preventing and controlling pop-UpPS .......ccccceeveevuervieniieniienieneeneenne 109

Choosing a default search engine ...........ccccoeoeeveeciieciiecieecieeeeneenne. 111

Chapter 3: Strategies for Internet Searching .................... 113
Finding Out about Search Engines .........c.ccccoeeiinininnnneneneneceeeeeene 113

How directories WOrK ..........cccocoveeiriniienieninineeteeeee e 114

How standard search engines work ..........ccccooceviiiiniieiniinniennnenn. 117

How meta-search engines wWork ..........cccccoeveveeverciensiensiensieneeneenne 120



Xiv  The Everyday Internet All-In-One Desk Reference For Dummies

Which Search Engine Should [ Use? .........ccccceveviiiriiniinieniiecieeeeieneen 121
Crafting a Thorough but Precise Internet Search ...........ccccooviivinninnins 123
Formulating your search .........cccccoceviiviniiniinniniinceeeeeeeee, 123
Avoiding Booleans with advanced search commands ................. 125
Using Boolean operators for searching .........ccccceceevvevvevieecrennnne 125
More techniques for narrowing a search .........cccceceevcvenvenueenenen. 127
Searching the “Invisible Web” ..........ccccooiiiriiniiieeeee 132
Evaluating Whether Information at a Web Site Is Valid ....................... 132
Chapter 4: Advanced Tools for Scholars and Researchers ....... 135
Discovering Specialty Search Engines ........ccccccoceviiviiviniininnienniencenen. 135
Finding Out about the Google Toolbar ............cccceceveieriereninineeieierenns 138
Installing the Google TooIbar ..........cccccoviriniiiienienenereneeeeene 138
Using the Google TooIbar .........cccceecuieviieiinienieceeeeeeeee e 139
Making Google the Internet Explorer default searcher ................ 140
Searching for Images, Audio, and VIid€o .........ccccceecevvuervieriiniiencienieneenenn 142
Asking a Google EXPert ......cccoovevieniiniiniiicieeiecteeteeee s 144
Exploring the Google Answers DireCtory ..........ccceecevcerverceesveneennens 145
Logging in to your Google Answers account ...........cocoeceeeevieneenee 146
AsSKINg @ QUESTION ....cceovuieiieiiciiceciececcee e 146
Online Translation SErviCes .......c..coccooevierineniniinieeiccencreseeeeeeeeene 146
Chapter 5: The Internet as a Reference Library ................. 149
Finding General-Purpose Information ........c.cccccoevievvieniinienninnensenciennne 149
Taking Advantage of Online Reference Books ...........ccccocvrvieriiencienennnen. 150
ENCYClOPEAIAS .....ooeveeieieierieeieeeeee et 150
DICHONATIES ..ottt 152
TRESAUIUSES ....ooiiiiiiiiiieeee ettt 152
LooKing up qUOLAtiONS .......cceeeeieieiiciiceceeeeeese e 153
Finding Lost Friends and LOVErS ........ccccccevviiviiniiniinenienieeieeieseeseeneen 154
Looking Up Phone Numbers and Addresses .........cccccecevverviencieneeneennen. 154
Chapter 6: Read All about It .......................c.coiatt. 157
Gathering the News with an Aggregator ...........cccccecevveriiiniieniienieenennens 157
How aggregators WOTK .......cccccovcieieriininieieceteieseeee e 158
Subscribing to a Web Site .......cccccoeeeeeciiiciiciececeeeeeeee e 160
Using the Bloglines aggregator ........c.ccccoveevieveeneenennennenneeneenne 161
Using the Yahoo! aggregator .........cccccovvivvievvienienieneeneeieeieeene 162
Finding RSS feeds with a search engine .........ccccccocvevvvnvenenciennnne. 164
Getting News Alerts from Google by E-Mail .........cccccovviiviiiniiiniiininncnnnn, 164
News Search ENGINES .......cccoccovviiriiniiniiiieieeietetesteeeeee e 166
Starting from a News Portal ........ccccceoieviieiicciieiececeeeee e 167
Reading Online NEWSPAPETS .......ccceeeriiierieniinieniieiieterteiesie et 168

Getting the News from Abroad ..........ccccceeieiienieniienieeieeieeieeeeseeeeiens 169



Table of Contents xv

Book I1I: E-Mailing.............cccecceeeereeiceeeareeicvcnaneesanenss 171

Contents at @ GIaNCe .......cccceceeieiieniininereeeeeeeee et 172
Chapter 1: A Quick Introduction to E-Mailing ................... 173
Web-Based E-Mail and E-Mail Programs ...........cccccceevevvieniienienceeneenennen. 173
Looking at E-Mail AddreSSes ........ccoovveeieeeieieniieeceeeeeteeesresesvee e eeennns 175
Discovering How E-Mail Is Sent and Delivered ..........ccccecevieniinernuennnen. 176
Compressing Files to Make Sending Them Easier ..........ccccocevvvvneennn. 177
Compressing fil€s ........cocevieviiriririeieeeee e 177
Uncompressing files ........ccocieveeiieeieniienieneeseeeee e 179
Chapter 2: E-Mailing with Qutlook ............................ 181
Finding Your Way Around Outlook .........cccccccveviiiiiieiieciienienieseeseeieeenn 181
Addressing and Sending E-Mail MeSSagES .......ccceovvvveeiercienienieneenieennens 183
The basics: Sending an e-mail message .........ccocceeceevvervierviencveneene. 183
Addressing an e-mail MeSSAZE .......cceevvevveriinieniirieeeeeeeee e 185
Replying to and forwarding e-mail messages ...........ccccccvveeveennn. 186
Distribution lists for sending messages to groups ..........ccecceceeuc.. 187
Sending a file along with a MesSSage .......cccceevveveeecieeciieiecieeeeeee 189
Including a picture in an e-mail message .........cccccceeevviervieneennnenne. 190
Choosing which account to send messages with .............c...c........ 191
Comparing the Message FOrmats .........ccccoeceevervinnienienieniienieneenceseeenn 191
Receiving E-Mail MeSSAGES ......ccocevruiiriiniiiiiiiieieeeeeteeteste et 193
Getting your e-mail ........ccocoiiriniiiiieeee e 193
Being notified that e-mail has arrived ..........cccoceevieviniinciicienne, 194
Reading your e-mail in the Inbox window .........cccccooceiiiinninnien. 195
Handling Files That Were Sent to YOU ......ccccocevviirvienieniienienienceseeeeene 196
Maintaining a Happy and Healthy Contacts Folder .........cccccooveneenenneen. 197
Entering a new contact in the Contacts folder ...........cccccvvernennen. 197
Importing e-mail and addresses from another program .............. 200
Techniques for Organizing E-Mail MeSSages .........cccocecveevieevenveneenreennen. 200
Flagging e-mail MeSSAZES ......ccevvverierierieniieneesieecie e 201
Being reminded to take care of e-mail messages ...........cccecueuuenne. 202
Earmarking messages as they arrive .........ccccccevvevvinvenviencenenne, 203
Looking into the Different E-Mail Folders ...........cccecvevvenieiieneeceeieene. 205
Moving e-mail messages to different folders ..........cccccceevveeurennnne. 205
Creating a new folder for storing e-mail .........cccccceeviirciiecieneennenne. 206
Deleting E-Mail Messages (and Contacts, Tasks, and Other Items) ...... 206

Finding and Backing Up Your Outlook File ........ccccocoveeviiiiincnininnnnnne 207



XVi  The Everyday Internet All-In-One Desk Reference For Dummies

Chapter 3: E-Mailing with Outlook Express .................... 209
A Short Geography LESSON .....c.cccveciieiieriieiecieciecteee e 209
Writing and Sending E-Mail MeSSAZES ......cccevvveriiriereenieerieeieereeieeeeeeen 211

Writing an e-mail MeSSAZE .......cccecuvvierieniiiiieiieieeieeeestese e 211
Replying to and forwarding e-mail messages ...........ccoceevervuernnnne. 213
Sending a file along with a message ..........cccecevvevievieneecieeieee, 213
Sending a picture along with a message .........cccocceveverercierieneennnne 213
A Word about Mail-Sending Formats ..........ccccceeieviiiciinienieeneeeeceeenee, 214
Receiving and Reading Your E-Mail ........ccccoceeiiiniiniinienieiieeeeeeene 215
Reading your e-mail mesSSages .........cocevvverieriieneeneenieenieeniesieeiennns 215
Opening and saving files that were sent to you .........cccceecveueennen. 216
Deleting MESSALES .....ccceeevvieeiieeiieeieeesieeecee e esreeeeseesseessseesseessaeeseeenns 216
Organizing Your E-Mail MeSSages ........cccocevevinirirnieienieneseeeeeeeeee e 217
Creating a New folder ........cccocieiieiieiiieiiceceeeeee e 218
Moving items into different folders ...........cccecevvverieniinienenciennne 219
Creating mesSSage TULES ........cccevvierierienieniereeeee e 219
Keeping the Addresses of Friends, Family, and Clients ............cccc........ 220
Entering names and addresses ........c.ccocvevienieneeneenennennieneeneenes 220
Looking up names and addresses .......c..ccoceeveeveeneeniennenneenseenneenne 221

Chapter 4: Yahoo! and Other Web-Based E-Mail Services ....... 223
Why Have a Free Web-Based E-Mail Account? ..........ccccoocevevineneecenenne. 223
Looking at Some Web-Based E-Mail Services ........cccccocoveevecieecieccveneennen. 224
Handling Your E-Mail with Yahoo! Mail ..........ccccceevviiiiiiiniiniinieeieeeee, 226

Opening your Yahoo! mailboX ........cccccoeceenieniinennencienienienieneeenn 226
Finding your way around the Yahoo! Mail windows ..................... 227
Reading your e-mail ..........cccceeeiiiniiiiiieeiceeeeeee e 228
Composing (and replying to) e-mail messages ..........cccceceevveenenne. 229
Sending @ fil€ .......cccveeieiieiieiececeee e 230
Receiving a file that someone sent to you ........cccceevevvevieeeennnnnne. 231
Organizing your mail in folders .........ccccoovivvviinennincinninienieneeen. 232
Collecting your mail from a conventional mail service ................ 234
Keeping an Address BOOK ........cccocvevievieeciieciieiececeeeeeeee e 235

Chapter 5: Only You Can PreventSpam ........................ 237
Looking at It from the Spammer’s Point of View ..........ccccoovvrvirvncennnnnns 238
How Spammers Obtain E-Mail Addresses ..........ccceceevievienenencreeceeniennns 239
Preventative Medicine for Spam ........cccccceeceviiniineenieceeceee e 240

Rules for preventing spam from reaching your mailbox .............. 241

The secondary e-mail address strategy
for preventing SPAM ......ccccooceeviirienenienite e 244
Looking at Spam-Filtering Software ...........ccccccovvveviecieciecieeeeceeeee, 245
Bayesian filtering software ............ccccooevirininienenee e 247

Challenge-response SOftware ..........cccccecveeeereeneecieecieenieeieeeeseeeeeens 247



Table of Contents xvii

Book 1V: Quick Communicating ..............cccoueeeeeeeceeeeec 249

Contents at @ GLANCE .......ccoeiiiiriiiiiieee et 250

Chapter 1: Instant Messaging .................ccooivviinnnnnn. 251

Introducing Instant Messaging .......ccccceeceviiiiniiiniinniiieeeeeee e 251

Knowing How to Preserve Your Privacy .......ccccccevevcenvienieneencenennen. 253

Using AOL Instant MESSENGET .......cccevveevervieriieriienienienteneeneesieeseeeseeeeeas 253

Using MSN MESSENGET .....c.eoveuieieierierieeeieieeeiesieseeseeseeseessessessessesssensensens 255

Using Yahoo! MESSENGET ........ccoecveriiriiriiriieieieienienie ettt see e eeeens 257

USING ICQ ittt ettt te e te e ae et e et e s e s st e saaesseenseensean 258

Chapter 2: Blogs and Online Journals ......................... 261

What Are Blogs and Online Journals? ..........ccccocevviinieneesieecieeciecieeeene 261

What Makes for a Good Blog or Online Journal? ........c.ccceevercveneenrennen. 264

Blog Search Engines and Directories ..........cccccooevvierciencieniienieneeneenennen. 265

Free Web Sites for Creating Blogs and Online Journals ....................... 265

Running a Blog or Online Journal at MOtime .........cccccoceevviiniiniencnniennen. 266

Signing up with MOtIME ........cccoooeeviiiriiiieiieeeeeeeeee e 267

Creating a NEW DlOg ....cceovieiiiieeiecteceeeeeeee e 267

Starting from the Control Center ..........cccovveveeveevieeciinsienieseeneene 268

Writing and editing blog entries ..........cccecevvienieneeninsenrienieneee 268

Putting links on your blog page .......c.cccoceevivvernieriennenienieneeneee 271

Chapter 3: Mailing Lists and Message Boards .................. 273

Trading Ideas on a Mailing List ........cccccocevviiniiiniiniiineeeieteeeeeen 273

Categories of mailing lists ........ccccocevviiniiniiniieeee, 274

Finding a mailing list .......cccoceriiiriiniinieeeeceeeee 274
Distinguishing between the list address

and administrative address ........c..ccccooevenenieninnienieneneneeeee. 275

Subscribing to a Mailing List .......cccccoeveviiniiiiniinierieceeeseceeeeen 278

Sending messages to a mailing list .........cccceveeveniiniiniiniienieenne, 278

Digesting and organizing the mail ..........ccccooceviiiinnniinnine, 278

Unsubscribing and other tasks ........ccccoceviivinniniinninninieeeeee, 280

Spouting Your Opinion on a Message Board ..........cccccceevvevienvenneennennnen. 280

Chapter 4: Newsgroups and the Usenet ........................ 283

Introducing NEWSZIOUPS .....c.ccceeieiiirienierieeieeie e eteeeeseesreeseeesseesseessees 284

Figuring Out Newsgroup NAIMES .........ccccceeveeriieiieerieniienieneeneeneeseeesseennens 285

Google versus the NeWSreaders ........ccooceeveevieriieniieniieniienieneeseeseeseeeeenns 286

Exploring Newsgroups with Google ............coccoovirviiniiiniiiniinienieneeeeen, 287

Searching for newsgroup postings .........ccoccevveeverviervienniensienceeneenne 287

Subscribing t0 @ NEWSZIOUD .......cceeuiririerieiineeteeeeie e 288

Posting messages to @ NEWSZIOUD ......ccceevveevieereeecieeiesieeeeseeneeenes 289



XVIil  The Everyday Internet All-In-One Desk Reference For Dummies

Exploring Newsgroups with Outlook EXpress ...........cccccovvvvieniienciennnnnen. 289
Connecting t0 @ NEWS SEIVEY ......cccceevuervierierieneenieenieeieesieeeeseesaees 290
Downloading newsgroups to Outlook Express ..........ccccceceeeveennn. 292
Exploring the different newsgroups ..........cccccceeveevievieriesieecieenene, 293
Subscribing and unsubscribing ...........cccceeeevenieniienieeeeee 294
Getting the latest messages from a newsgroup ..........cccceeeveeueennen. 294
Reading and posting messages in newsgroups .........c.cceceevverunenne 295

Downloading Multimedia Files with a Binary Newsreader .................... 296
Downloading binary files with Outlook Express ........c.cccccecveunne. 298
Downloading binary files with Binary Boy .........ccccocvevieciieciennnnnne. 299

Chapter 5: Joining, Starting, and Managing a Yahoo! Group ...... 305

Introducing Yahoo! GIroups .........cccceceeieiieiieneninieieceieiesese et 305

Finding and Joining a Yahoo! Group ........ccccecevviinieniecieeniecieeieeeeeeeeen 307
FINAINg @ GYOUP ..ooovveiiiiiiieeieetecetee et 307
Joining a Yahoo! roup .......cccccecevviiniiniininnieinieeeeseestesteseeieenne 308
Visiting a group to which you belong .........cccocevviiniiniincnnennnnnne 309
Reading messages and downloading files and photos ................. 309
Changing how messages from a group are delivered ................... 311

Leaving a Yahoo! GIOUD .....ccccoeviiriirieiieiiieieciecee sttt este e aesne s 312

Posting a Message t0 @ GYOUPD .......ccceecueeeereenienieneenieeieeiesieesesseseeennees 312

Sending Files and Photos to a Group .......c.ccceceveevervenvensiniieniienieneeneen 313

Starting and Managing a Yahoo! Group .......c..cceceeveeveriienniensiennienieeneennens 315
Before you begin . . . ..ocooioerieieeee e 315
Starting a Yahoo! Sroup ........ccccceeeeceeciieciiecieccieseeceeseee e 315
Customizing and managing a group .......c.ccceceeveerreecreesveesvesseeseennnns 318

Chapter 6: Chatting Online ..................cccvviiiiinnnnnnn. 325

Introducing Online Chats .........cccccceeieviiiieniinicecieeeeeeee e 325

Finding Out the Rules of the Road .........ccccccovviiniininniiiinieeceee, 327

Private, Web-Based Chat SErviCeS .........oovvvvvvviiiviiiiiiiieeiieeeeee e 327

Chatting On IRC ......cooiiiiitee et 327
Finding and bookmarking channels ...........cccccooceniiiinninnnncnnnnne. 328
Engaging in @ chat .........cccooeviieviiiiinieeeee e 330

Chapter 7: Free Web Sites at Yahoo! GeoCities ................. 331

Deciding on a Free Web-Hosting Service .........cccoeveeeiecieecieecieeciecieseeen. 332

A Few Design Considerations ........c..cccccoeveeveeneesiieienieneeseeseesieesieeneennes 335
Ask yourself, “Who’s my audience?” .........c.cccevvervienvenvenernrennenn 335
Be consistent from page to page .......ccccoccevviriiiniieniieneeneeeeen 335
Use the home page as an introductory page to your site ............ 336
Divide your Web site into distinct topics .......ccccevceviriincieceniennne 336
Hyperlink your site to other sites on the Internet ........................ 336

Choose page backgrounds carefully .........cccccoevvevirciirniinciencieneenen. 337



Table of Contents xix

Write the text and assemble the graphics beforehand ................ 337
Avoid using t00 Many GiZMOS .......cccceeeveverierreeirereeeeese e 337
Creating the Web Site .......ccocieiiiiirinieeeeeeeeeee e 337
Building Your Site from the Web
Site Accounts WINAOW .......cccoieiiniriiiiieeneneseeeteteee e 339
Creating a page with a PageWizard ...........cccocevievinvincnnvicneennnne, 340
Creating a page with PageBuilder ..........cccccoovevviivinninninieniennenne, 341
Constructing a Web Page with PageBuilder ...........ccccocovviininninnennennen. 342
Choosing a background color or picture ..........c.ccecceevveecieeeenneenne. 343
Entering text and headings on a Web page .........cccccceevvveieevenennne. 343
Putting hyperlinks on your Web pages .........cccoceeveeviincienceeneenneene. 344
Putting a picture or photograph on a Web page ..........cccccccn...... 345
Managing the FIles ........ccooovviriiiiiniinieecectceeeestete e 346
Submitting Your Web Site to Search Engines .........ccccoccevvievinninncnnennen. 347
Chapter 8: Making Friends and Connections Online ............. 349
Social NetWOrKing ........cccoceeveriiiniiiniiieeeeceeeeeeeee et 349
Finding New Friends in Your Town or City ........ccccoceeerienieneneneneneeenne 354
Meeting new people at Meetup.CoOm .......cccoceevueecieecieecieeeeseeneeene 354
Planning nighttime adventures at Upcoming.org ...........ccccceeuenee. 356
Looking for Love in the Yahoo! Personals ..........ccccecevcienviinieneencennennnen. 357
Searching for Mr. or Ms. Right ........cccccoovviinininiieeeeeeeeee, 357
Submitting a profile to Yahoo! Personals .........cccccecenviininncnnnnnn. 358
If someone responds to your profile ...........ccocoeveevieiieniineniniennenns 359
Reuniting with Old Friends .........cccocoiiiiiininiieeeeeeeeeene 359
Chapter 9: Using Your PC as a Telephone ...................... 361
Calling with @ VOIP SEIVICEe .......cccooiviririieiiieeseeeeteeeee e 361
Free Telephone Calling with SKYPe .......cccccoeviiriiiiiiiniiiciicieeeeeeee, 363
Downloading and configuring the software ..........c.cccocceevvenvennnne. 364
Assembling a Contacts list .......cccocevvieeievienenieiceeeeeee e 365
Talking on the SKkype Phone ........cccoceveieieneniieieeeeeeee e 365
GUArding YOUT PYIVACY ...cceecviecieeiieeienienieesreeseeseeeereesessesssesssesseesses 366

Book U: Your Personal Finances..............ccccccuueceeeennae. 307

Contents at @ GIANCE .........ccoceeieriiniinieeeeeereee ettt 368
Chapter 1: Searching for Financial Information ................. 369
Getting Lessons in How to InVest ........ccccoveiiiiiiiniiiniiiniiieiececeee, 369
Devising an Investment Strategy .........ccccocevevieniniinienreeeereeeeeeeene 370
Discovering Basic Researching Techniques .........ccccccceveiirvieniienninnnnen. 371

The big, gaudy financial portals ..........ccccceeeevienvienieenencieieeieeeene, 372
Researching a company online ........c.cccoceeveveevercenniensiensieneeneenes 373

Researching in mailing lists and newsgroups .........cccccecceevcreeneee 374



XX The Everyday Internet All-In-One Desk Reference For Dummies

Getting the Latest Financial NEWS .......ccccooceviiniininiieniiiiiinieteecceiens 374
MajOr NEWS SEIVICES ....occvveeiieeeiieeieeeieeeteeeteeeteeeeeeesaeesaeeseseennnens 374
Financial newspapers and magazines ..........c.ccoccevevvererereereeruennns 375
Online NeWSIELErS ......cccooivirieieieeeeeee e 376

Researching Mutual Funds, Stocks, and Bonds on the Internet ........... 376
Researching a mutual fund on the Internet ..........cccoecvvviennennnnne. 377
Researching stocks on the Internet ...........ccccocevviiniiininnnnennennen. 378
Researching bonds on the Internet ............ccccooveniiniiininninnennnnen. 380

FINAINg @ BrOKEY .....ocuoviiieieiiieeteeeeee ettt 381

Chapter 2: Monitoring and Tracking Investments ............... 383

Introducing Investment Portfolios ...........cccocoeevvieinieneneninieceeeene 383

Comparing the Online Portfolio Web Sites ..........cccoocevinininninneninne 384

Tracking Your Investments in a Yahoo! Portfolio ..........c.cccecuvevervennnnen. 385
Before you begin . . . ...ocoovviiiieiiiiee e 387
Setting up an online portfolio .........ccoceveeviiriiniiniiiniieeeeeeeee, 387
Examining and updating your investments ..........cccccoceeverveennenne. 389

Financial Software-Management Programs ...........c.cccccevevereneneeceenuennens 390

Chapter 3: Banking and Paying Bills Online .................... 393

Banking ONINe .......cccoceeiieiiinirieiieeeeesee ettt 393

Paying Your Bills Online .........cccooiriiiiiiieiininenieieteeieseee et 397

Online Banking and Bill Paying with Microsoft Money and Quicken .....399

Searching for a Credit Card Online .........cccccoevvevieneenieneniinieeiesieeeeeen 400

Book Ul: Bargain Shopping ...............cccceeceeecaceeeiacene 501

Contents at @ GIanCe ..ottt 402
Chapter 1: Searching for Bargains ............................ 403
Some Rules for Buying Items Online ............ccccoevveveeniecieiencienieeeeeeeeen 403
Shopping Search ENgines .........ccccccveveievieninicecieieereseeeee e 405
Looking at Some Price-Comparison Web Sites ..........ccccovvrviirvienrieneennen. 407
Reading Online Catalogs .......ccccoevieriiveiiiinnienienientestesieeeete e 408
Hunting for Bargains at Online Stores .........ccccocvevieciecieceeciecieceeeeee, 409
Product Reviews and Consumer Reports ..........ccccoceveveninincnennienennns 410
Chapter 2: Buying at an Online Auction ........................ 413
Looking at the Online Auction HOUSES ..........cccccvevieciieciiecieeieeiecieeee, 414
Using Auction Search ENgINes ..........cccocvveviieieniiiniiinieneeseeieeieeveeeeeeenn 415
Registering with €Bay .......c.ccoceeieieieieeeeceeeeeeee e 415

Signing in to Your My eBay Page .........cccovviriiiniiiniiniiiceeieeeeieeeen 416



Table of Contents xxi

Searching for Items of Interest .........ccccoceeverviniinieniiniineeeeeen 417
A straight Search .......ccocoovivieieieeeeee e 418
Browsing eBay Categories .......c.ccccevevirriereninenieeeteese e 419
Browsing to and searching a single category ..........ccccceeeveevenennne. 420
Saving searches, categories, and sellers .........cccceeverviercieneennnenne. 420
Managing your All Favorites list .........ccccevvieviernernenniinienieeeeeee, 422

Keeping a Watching List .......cccccovviiriiniininniiiiiiecececstcteteceeee e 422

Knowing the Rules of the Road .........ccooceeviiiiniiiiiniiceeee, 423

Bidding On ILEMS ......c.cccviiiieiieieciececeeeee ettt 424
How bidding WOTKS .......cccuieiiiiiieiecieteeeeeeee e 424
Placing @ bid .....cccooeevieiiiieieieeceeeeeeee s 425
Strategies for successful bidding ..........cccocevveevervinniniiniinieeene, 426

Making the PUrchase .........coccooviiviiiiiniiiececeeeeete e 427

Chapter3:UsingPayPal ................ .. oiiiiiiiiint.. 429

Discovering PayPal ...ttt 429
Types of PayPal accounts .........ccccocevveriienienieneinensienieeieneeseene 430
Costs of using PayPal .........ccoccveiieienienieeceeeee e 430

Signing Up for a PayPal Account ...........cccoeeieiininennienieeneneseeeeeeene 431

Logging in to the PayPal Window .........cccocceviiieiiiiviiniieniecieceeseeseeeeen 431

Sending a Payment through PayPal .........cccccoiiiviniiniiniiniinieeeee, 432

Receiving a Payment ..........cccooviiviiiiiniinieicccceceeestestest e 433

Chapter 4: Taking a Stroll through the Cyberbazaar ............. 435

Book VII: Selling on the Internet ...............ccccceveeeeeee. 545

Contents at @ GIANCE .......coceeeeieiieriirireeeeteeeeeeetet e 446
Chapter 1: Selling ItemsoneBay ..........................ut 447
Figuring the Costs of Selling on €Bay .........cccccocvevieeieniiencienieseeseeeee, 447
Signing Up to Sell 0n €Bay .......cccccoviiniiniiiiiiiciececececeesee e 448
Doing the Background WOTK ...........ccoceeieiieierieninieeeeeeeeereseeeee s 450
Researching the cost of the item ........ccccoocviviiiiniiniiniiiee, 450
Writing your item description ..........cccoccevevieiinienceneneneceeeeeeeen 451
Taking the photograph .......cccceiieiiiiieiicceeee e 451
Putting Up an Item for Bidding ...........cccceeveevievieniieiieeeeeeeeeeeeeeeens 451
ChoOSING @ CALEZOTY ...ocuveeveieiicieeieeeeeeee ettt esnens 452
Describing your it€m .........cccoccvveeieiecieiereneeeeee e 452
Providing the pictures and item details ........ccccecevviinviinviinennennne. 453
Choosing the payment and shipping methods ..............ccccuc........ 454
Reviewing and submitting ..........cccccceevveviinienienececceeeeeeeeeeee 454
Monitoring the AUCHON .........ccooviviieiiiicieeeeeeeee e 455

CloSING the SALE ......ccviviicieeiieieieeere ettt ae st e e seesnens 455



xxil

The Everyday Internet All-In-One Desk Reference For Dummies

Chapter 2: Selling ltems Online ............................... 457
Choosing the Right Market ..........ccccoecveviiiiiinieieecceee e 457
Setting Up YOUr WED Site .....ccocceouieieieieieieeeceeeeeeeeee e 458
E-Commerce SOftWare .........ccccocooeeiriiienenineceteeeeereseeeeeceeeeeee e 460

Chapter 3: Sending Ittothe Buyer ............................. 463
Determining the Shipping COStS ......ccccvviriiriieniienierieeeeeieee e 463
PaCKING IE ...eeiiiieieeeeeeee ettt saeenean 465
Buying Postage Stamps Online ...........cccccveeeeiienieneeneeieeceeie e 466
Tracking It ..ottt 467

Book VIII: Hobbies and Pastimes.............ceeuuueeeeeee..69

Contents at @ GIANCE .......cccooeviieirieieieereceeee et eees 470
Chapter 1: Playing Games Online ............................. an
AlI-PUrpose Game SIteS .......ccvecviecieeieiiieiteereete ettt re e 471
MSN ZONE ..ottt ete e e st e s e e steebeeaeeseesaesseessa e saesasnsennnas 471
Yahoo! GAIMES .......ccceevuieiiieiieiieiecieeeeseete et see e sae e e eee 473
POZGO ottt a e 474
IESYOUITUITL .oeeieiiiieiieieceeteee ettt 474
BOXEIJAIM .eiiiiiiiiiiieiieieceetee ettt sttt 474
Some Slightly Off-the-Wall Games .........ccccccveveerieneecieeeceee e 474
20 QUESHIONS ..ecvvieeiiceiiciieeieece ettt re et e e be e beebeeaeeaaeeanas 474

CityY CrEatOr ....ocvieeiieiieeiieciecieete ettt sve e sbeebe e e e saaesneas 475

The ESP GAME .....ccooovieiiiicieeieceeeeteee ettt re e 475
GEOCACNING ...eveiiiiiieieteeee ettt 476
Playing Fantasy Sports Online .........c..cccvvevieniinienieneenenienieeieneeneens 477
WeDb Sites fOr GAMETS .......cccveieriirieriieieeeeee ettt 478
Chapter 2: Planning Your Next Vacation ....................... 479
Figuring Out Where to Begin .........ccccoeeieeiiiiinieececeeeee e 479
Finding a Travel Bargain ........ccccoccevviriienieniinieneieeeeeeeeeeeeeee e 481
FIYING TRETE ..ottt ettt ettt et et aeeae e 482
Finding a Hotel or Motel ROOM .......c.cccevieiiiiieniicciecececeeecee e 483
Exchanging Your Home with Another Family’s .........cccccocenvnnnnincnces 484
DYQiVING TREYE ...ooevieieeieeeeeeee ettt saesneas 485
Advanced MapPiNg ......cccecoveeiiieiiiecieeeieeeeeeee e e et e esreessreesreesaeesseaeas 486
How’s the Weather? ...ttt 487
Deciding What to Do When You Get There .........ccccocoveeieiieciecciecieeeenen. 488
Armchair Traveling ........ccocceeiiiiierienieeieseeee e 489

Outdoor AAVENTULING ....ccvevvierieiiieiieieeieetest et eie et seesnesaesaeens 490



Table of Contents xxiii

Traveling by Rail .....cocooviiriiiiiiiiteee e 491
Resources for Traveling Abroad .........cccccocceeverienviiniieniieniienieneeseeeeenn 491
Eccentric Sites for Eccentric Travelers .........c.cccocvevvinennenenncncncnnens 493
Chapter 3: Let Me EntertainYou ........................coet. 497
Playing Internet Shorts Online ............ccccoceveienininienneieeeeeeeeeeeene 497
GOoINg t0 the MOVIES ..c.ovuieiiiiiieieiieee ettt 498

Sites for MOVie fans ........cccccoevireririniee e 498

Choosing a g00d MOVIE ........cceeeeeieieieieieeeeeeeee et enns 500

Getting your local movie listings .........ccccoeveeveeveriinvinienienieeene 500

Renting DVDs over the Internet ............ccoccevevievenencencecieriereneseeeeeens 501
Getting Your Local TV LiStings .......cccccceeeeeiieiiieiiieieciecieceesee e 502
Listening to Internet Radio .........cccceeeeveeievieiiieeececeeeeeeeeseeve e 503
Finding an Internet radio station .........c.ccceceeveeveecieciincencieceeeeene, 504

Receiving an Internet radio station ...........c.cccceeeeeveevieveneneeeenennans 505

Finding BOOKS ONINE ........ccccceoveiieriirieeeieeeieeseeesee et eeeneens 507
Chapter 4: The Internet for Music Lovers ....................... 509
Web Sites for MusiC LOVETS .......ccccoevirireririiienenencneeeeeeeseneeieeieenees 509
Buying MUusic ONlNE ........cccocveiieiieriirireeieteieieseee et e see e eneeeennens 511
Trading Free Music Files on the Internet ...........ccoceveeieiininencncnenen. 512
Chapter 5: Buying and Playing Music with iTunes .............. 517
Introducing iTUNES .......cccoeirieieiieeeeee et 517
Downloading iTunes SOftware ..........ccccoceeveevierienenenenieteteesee e 519
Buying Songs from the Apple Music Store .........cccceeveeviercienienieneecieeen. 519
Starting an account with Apple .......cccoocveviiniiniiniininieceeeee, 520

Searching for @ SONG t0 BUY ......ovcvevieriiniiiiieiecieeeeeeeseee e 520

BUYING @ SONG ..oovviiiiieiieieieiee ettt ennens 521

Playing SONZS .....cooiiviriiiiieieieteteese ettt sttt neens 522
Organizing Your Songs with Playlists and the Library ...........ccccceeuun.... 524
Adding Your Own Songs to Your iTunes Collection .........c.cccceeveereenenen. 525
Copying songs from your CD collection ...........cccceevevierenreeennnnnns 525

Adding songs you didn’t get from Apple to the Library ............... 526

BUIning @ CD .....cooiiiiececcceeeese ettt nen 527
Chapter 6: Genealogy Online ....................cccviiiinnt.. 531
Doing the Detective WOTK ........cccoovvirieieiieieeseeeeee e 532
Organizing Your Genealogical Data ........c.ccecevverenininieieieiececeeeeeeene 533
All-Purpose Searching Sites .........ccccocvviriiiienininerieeeeeeeeeeeeee 533
Obtaining Vital Information from the Social Security Death Index ....... 534
Searching the Census and Other Vital Records ...........ccccoeeveniinvneennns 535
Searching for Information about a Surname ..........ccccoecevvierviiniieneenennnen. 536

Searching the Passenger LiSts .........ccoccoviiviiiiniinniiniienienientececeeeenn 538



XXV The Everyday Internet All-In-One Desk Reference For Dummies

Obtaining Data from Localities ........c.cccocevvieriiiniininniiienenieeieeeeneeee 538
Writing to Obtain Vital Records ..........ccocoovvvivincinincieieeeceeeeeeeee, 540

Book IX: Appendixes...........ccccceeceeeiiueiareeieesineesceaees 341

Contents at @ GIANCE .......cceoevvieiieieieieiese e sa e seees 542
Appendix A: Signing Up fora Yahoo! ID ....................... 543
What You Get with a Yahoo! Account ..........cccecevviiniininninnenienieneenee, 543
Getting @ YahOO! ACCOUNL ......c.ecivieieieiireceececeeeeee et 544
Signing In and Signing OUt ..........ccecieiiiiiiienineeeeeeeeeee e 546

All about Yahoo! Profiles .........cceecveeieiieiieiecieciecteceeeee e 547
Describing yourself in a profile ............ccccoevveevienveenieninneeneeieeee 548

Checking out others’ profiles ..........ccccecevieniineesencinnenenieneeeen 548

Changing Your Yahoo! ID .......cccccecieieiecieneneseeeece et 549
Closing a YahoOo! ACCOUNL ......c.ccciririeieiereeerceeeteteeeee e eee e sseneens 549
Appendix B: Getting a .NET Passport .......................... 551
What Is a .NET PasSPOTt? .....cccceeveirieiiieieeeeiecee ettt 551
Obtaining a .NET PaSSPOIt .....c.ccceeiiiieeieeieeeeeteete et 552
Signing In and Signing OUt ..........cccecieiieiieeiiinieeeceee e 553
Managing Your .NET Passport ACCOUNt .........cccceeveeeevierienieeeeeeeeeeenienns 554
Appendix C: Getting a Google Account ........................ 555
What You Get with a Google Account ..........c.cceeeveeeeecieneneeeeeeeererene. 555
Obtaining a Google ACCOUNL ..........ccoevieviiriireeieicteeeee e 555
Glossary of InternetTerms .................ccoiviiiiinnnnnn.. 557

JOACK «.neeeeeeeeeeeaeeeeeeeeeeaeaeaeaeanneseeasaeaaannnssseeesssasaanness DT ]



Introduction

Tlese are exciting times for the Internet. Peer-to-peer file sharing, news
aggregators, and other advances in technology have inspired a new gen-
eration of Web sites and services. Never before have this many Web sites
and services been available on the Internet.

The idea behind this book is to present everything on the Internet that’s
worth doing because it’s useful, it’s a lot of fun, or it’s innovative and there-
fore worth checking out. Close to a thousand different Web sites are
described in this book, but this book isn’t a directory of Web sites on the
Internet. The focus is on doing things — researching, online banking, com-
municating, making new friends, playing games, talking over the Internet
telephone, online shopping, online selling, and blogging. In the course of
describing these and other activities — everyday activities that can be part
of your Internet repertoire — I introduce you to the Internet’s best Web sites
and services.

What's in This Book, Anyway?

You are invited to dip into this book wherever you please or consult the
Table of Contents or Index to find a topic that interests you. Either way, you
will discover things about the Internet that you didn’t know. This book was
written in the spirit of the Internet itself. It is meant to be an adventure for
the people who read it. Here is a bare outline of what you’ll find in this book.

Book I: Getting Started

Book I is meant to help you get going on the Internet.

In case you're curious about the technical aspects of the Internet, Chapter 1
explains in layman’s terms how the Internet works, what an IP address is,
how to read a Web-page address, and what goes on behind the scenes when
you open a Web page. In Chapter 2, you find out how to select an Internet
service provider and what the different modems are, and in Chapter 3, you
get instructions for connecting your computer to the Internet.

Chapter 4 looks at a subject that seems to be on everyone’s mind these

days: how to protect your privacy and security while you're on the Internet.
It explains how to protect your computer from viruses and spyware, what a
firewall is, how to update Windows XP, and how to keep yourself from being
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a victim of identity theft. Chapter 5 detours into America Online and explains
to AOL subscribers how to use that program on the Internet. Chapter 6
explains how to use plug-ins — companion programs such as Acrobat
Reader, Flash Player, and Windows Media Player — that you need to make
the most out of the Internet experience. In Chapter 7, I tell you how to make
exploring the Internet a safe and rewarding experience for children. This
chapter describes many Web sites for children, as well as Web sites for
moms and dads looking for advice about parenting.

Book 1I: Exploring the Internet

Book Il shows you how to use a Web browser and how to be an Internet
researcher, or better yet, an Internet detective. It explains how you can
reach into all corners of the Internet to find the information you need.

Chapter 1 describes the basics of browsing, how to bookmark Web sites so
that you can revisit them, and how to engage in “social bookmarking” (shar-
ing bookmarks with others). Chapter 2 explains how to customize the
Internet Explorer browser as well as another browser, Mozilla, which I
strongly suggest you check out.

Chapter 3 is the first of three chapters that explain how to conduct research
over the Internet. It explains how search engines work and compares differ-
ent search engines, their strengths, and their weaknesses. It also advises you
on choosing a search engine and explains how to craft a thorough but pene-
trating search of the Internet. Chapter 4 looks at some specialty search
engines designed for searching different areas of the Internet. It also explains
how to search for images, audio, and video and tells you how to get help on
the Internet from other researchers — you know, the human kind. In Chapter
5, I point you to online encyclopedias and other references and show you
how to look up people, addresses, and telephone numbers on the Internet.

Chapter 6 examines how to get the latest news, where the online newspapers
are, and how to get the news from abroad. It introduces an exciting new
technology for staying on the top of the news — aggregators, which are soft-
ware programs that gather news from different sources, including blogs, in
one place so that you have all your favorite news sources at your fingertips.

Book 111: E-Mailing

Book IIl explains more than a mere mortal needs to know about e-mailing, as
well as how to protect yourself against spam, the junk e-mail that infests so
many mailboxes.

Chapter 1 compares the merits of software and Web-based e-mail programs.
It looks behind the scenes at how e-mailing works and tells you how to
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compress files to make sending them easier. Chapters 2, 3, and 4, respec-
tively, describe how to handle e-mail with Outlook 2003, Outlook Express,
and Yahoo! Mail. Not only do you find out how to send and receive e-mail
and files, but you also discover how to organize e-mail so that you can
always find the message you are looking for. To keep your inbox from getting
too crowded, I show you how to send e-mail straight to different folders as
soon as it arrives.

Chapter 5 explains strategies for stopping spam once and for all. It looks at
how spammers get e-mail addresses, the preventative measures you can
take against spam, and antispam software.

Book 1V: Quick Communicating

Book IV examines all the different ways that you can communicate quickly
with friends and strangers on the Internet.

Chapter 1 delves into AOL Instant Messenger, MSN Messenger, Yahoo!
Messenger, and ICQ. It explains how to use these programs and maintain your
privacy at the same time. Chapter 2 explains what blogs are, what makes for
a good blog, and how to create a blog of your own. In Chapter 3, I look at two
ways to exercise your ideas and obsessions on the Internet — mailing lists
and message boards.

Chapter 4 looks at a much-neglected tool for researchers. It explains how to
conduct research in newsgroups and subscribe to newsgroups with Outlook
Express. Chapter 5 delves into the easiest way to connect and manage a group
of likeminded people on the Internet — create a Yahoo! group. In Chapter 6,

I explain how to chat on the IRC with people all around the world and how to
create your own chat room.

Chapter 7 explains how you, too, can be a Web-site developer, and how you
can do it on the cheap with online Web-site—creation tools. You also find out
how to submit your Web site to search engines and make it more likely to
appear in Internet searches. Chapter 8 explores the new online phenomenon
of social networking. It describes Meetup.com, Upcoming.org, and other Web
sites and services where you can make new friends and reunite with old ones.

Chapter 9 looks at what I think is the best deal on the Internet — free tele-
phone calling anywhere in the world with Skype.

Book U: Vour Personal Finances

Book V is all about improving your personal finances and making the bank-
ing chores go more smoothly.
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Chapter 1 explains how to research different types of investments, get the
latest financial news, and choose a broker. In Chapter 2, I describe how to
maintain an online investment portfolio and be able to tell minute by minute
how well or poorly your investments are doing. Chapter 3 looks at online
banking — getting checking account balances online, paying bills online, and
shopping for credit cards online.

Book VI: Bargain Shopping

Book VI is devoted to the idea that if you want it, you can find it on the
Internet at a good price. For that matter, if you want it but can’t afford it, you
can at least find it on the Internet and dream about purchasing it one of these
days.

Chapter 1 points you to some shopping search engines and Web sites that
specialize in comparison shopping, as well as online catalogs, stores for bar-
gain hunters, and consumer-report Web sites. In Chapter 2, I briefly take you
to some online auction houses, and then you go to the granddaddy of auc-
tion houses, eBay, where you discover how to search for, bid on, and buy
items. Chapter 3 looks into using PayPal, an excellent service for paying for
items you purchased over the Internet. Finally, Chapter 4 presents a huge
shopping bazaar of Web sites that sell items online. The Web sites are cate-
gorized so that you can find stores that interest you.

Book VII: Selling on the Internet

Book VII looks at how you can be the first on your block to be an online
seller.

Chapter 1 explains everything you need to know to sell items successfully on
eBay. It shows how to price items, make them attractive to buyers, manage
an online auction, and close out a sale. Chapter 2 offers guidance for people
who are thinking of selling items or services on the Internet. It explores how
to find a market and set up an online store. Chapter 3 is a hands-on chapter
with advice for packing the items you sold and buying postal services over
the Internet.

Book VIII: Hobbies and Pastimes

Book VIII explains how to pursue different hobbies and exercise different
pastimes on the Internet. 'm warning you: Some of the Web sites listed in
Book VIII are addicting.

Chapter 1 is for people who like to play games — online video games, card
games, and arcade-style games. You discover fantasy sports Web sites, as
well as some unusual games begat by the Internet, such as the Geocaching.
Chapter 2 is for travelers, armchair travelers, and adventurers of all stripes
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and varieties. It looks at how to plan a vacation and book airline tickets,
hotels, and rental cars. You also find out where to go on the Internet to get
travel advice.

Chapter 4 describes how to turn your lowly computer into an entertainment
console. You find out how to view Internet movies, rent a DVD online, get
your local television listings, play Internet radio, and find a book online. In
Chapter 5, the focus is on music. You discover some Web sites for music
lovers, look at online music stores, and survey services for sharing music
files with others over the Internet. Chapter 6 takes you on a tour of iTunes,
as you find out how to buy music from this online store, play and organize
your music with iTunes software, and burn CDs. Chapter 6 shows amateur
genealogists some of the many different Web sites and services they can use
to search for their ancestors online.

Appendixes

Just when you thought you’d had enough torture, I tacked on three appen-
dices and a glossary to the end of this book.

Appendix A explains how to register with and sign in to Yahoo! so that you
can take advantage of Yahoo!’s many online services. Appendix B describes
how to get a .NET passport so that you can play games online at the MSN
Game Zone or open a Hotmail account. Appendix C explains how to sign up
for a Google account.

Turn to the glossary at the end of this book whenever you are stumped by
Internet terminology. I've done my best to define every Internet term, no
matter how strange or obscure. Do you know what airsnarf means? How
about Googlewhacking?

How | Selected Web Sites for This Book

You find descriptions and addresses of about a thousand Web sites in this
book. Some people collect stamps. Some people collect butterflies. I collect
Web sites. I am intrigued by the idea that a Web site is a creative endeavor in
and of itself — that a Web site is a clickable piece of artwork. For this book,

I chose not only Web sites that are useful for finding information or buying
things but also Web sites that I consider intriguing, wonderful, astonishing,
bizarre, or entertaining.

I stay away from the big corporate Web sites. Most Internet adventurers can
find them on their own for one thing, and for another, those Web sites are
too easy to get lost in. For shopping on the Internet, [ prefer specialty stores
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to megastores that offer everything under the sun. It’s easier to find interest-
ing things at the specialty stores, and they’re more fun. For the news, I prefer
Web sites that specialize in one area to Web sites that blanket the earth,
because the earth is too big to blanket. I still believe that the Internet is a
democratic medium where the little guy has as much of a chance as the
deep-pockets crowd to attract visitors to a Web site. I'm inclined to favor
little-guy Web sites for that reason.

[ also try to steer clear of Web sites and Web services that you have to pay
for. Some Web sites are worth paying for. Ancestry.com, for example, is a
bargain at $20 per month if you are doing genealogical research. I describe
Ancestry.com and Web sites like it that are a bargain. Otherwise — and you
can call me a cheapskate if you want — if [ could find a way to get a service
without paying, [ did it. 'm trying to save you and me a buck.

Foolish Assumptions

Please forgive me, but I made one or two foolish assumptions about you, the
reader of this book. | assumed that:

4 You have a computer and modem.

4+ A Web browser — software for exploring the Internet — is installed on
your computer.

4 You are kind to small animals.

Most of the computer instructions in this book are aimed at Windows users
running the Windows XP operating system. My apologies to users of the
Macintosh and to people running older versions of Windows. But take conso-
lation: Except for instructions about setting up an Internet connection in
Book Il and instructions for using a Web browser in Book IlI, it doesn’t matter
which operating system or kind of computer you have. This book does you

right anyway:.

Conventions Used in This Book

[ want you to understand all the instructions in this book, and in that spirit,
I've adopted a few conventions.

To show you how to step through command sequences, [ use the => symbol.
For example, to create a playlist in iTunes, you choose File=> New Playlist.
This is just a shorthand method of saying “Choose New Playlist on the File
menu.”
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Besides pressing hot keys to give commands, you can press combinations of
keys. For example, pressing Ctrl+N is another way to create a new playlist in
iTunes. In other words, you can hold down the Ctrl key and press the N key.
Where you see Ctrl+, Alt+, or Shift+ and a key name or key names, press the
keys simultaneously.

Where you see boldface letters or numbers in this book, it means that you
should type the letters or numbers. For example, “Enter 125 in the Zoom
box” means to do exactly that: Enter the number 125.

Icons Used in This Book

To help you get the most out of this book, I've placed icons here and there.
Here’s what the icons mean:

All things being equal, nearly every Web site listed in this book deserves a
Cool Web site icon. | wouldn’t put a Web site in this book unless there was
something special about it. Still, where you see the Cool Web site icon, I
describe Web sites that are especially good, entertaining, intriguing, or useful.

Next to the Tip icon, you can find shortcuts and tricks of the trade to make
your travels on the Internet more enjoyable.

Where you see the Warning icon, tread softly and carefully. It means that you
are about to do something that you may regret later.

When I explain a juicy little fact that bears remembering, [ mark it with a
Remember icon. When you see this icon, prick up your ears. You will dis-
cover something that you need to remember throughout your adventures on
the Internet.

When [ am forced to describe high-tech stuff, a Technical Stuff icon appears
in the margin. You don’t have to read what’s beside the Technical Stuff icons
if you don’t want to, although these technical descriptions often help you
understand how a software feature works.

Good Luck, Reader!

If you have a comment about this book, a question, or a Web site you

would like to share with me, send an e-mail message to me at this address:
weverka@sbcglobal.net. Be advised that I usually can’t answer e-mail right
away because I'm too darned busy. I do appreciate comments and questions,
however, because they help me pass my dreary days in captivity.
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Chapter 1: Getting Acquainted
with the Internet

In This Chapter

v Introducing the Internet
v Getting a crash course in how the Internet works

1~ Peeking behind the scenes of a Web page

Fis chapter is devoted to people who aren’t sure what the Internet is
and people who are sure what it is but don’t know how it works. How
does a Web page that was created by someone on the other side of the
planet take only a second or two to arrive on your computer screen? What
is a Web address, anyway? How are Web pages constructed? These and
other inscrutable mysteries are unscrewed in this chapter.

What Is the Internet?

The Internet is many things to many people. Erik-Lars Nelson, a New York
Daily News columnist, famously called it “. . . a vanity press for the demented,
the conspiratorial or the merely self-important.” A newspaperman, Nelson
lamented the fact that information presented on the Internet does not have
to undergo a rigorous examination as to its accuracy. Whereas newspapers
hold themselves to standards of truth and employ editors and fact-checkers
to make sure what they print is accurate, fools can say whatever they want
on the Internet — and they do so with complete confidence that somebody,
somewhere will believe them.

In contrast to Nelson’s dim view of the Internet, others describe the Internet
in utopian terms. To these people, the Internet is a vast town meeting in
which everyone can participate and everyone’s voice is heard. The utopians
see the Internet as a valuable tool for democracy and knowledge, a sort of
international conversation for the greater good.
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Figure 1-1:
The home
page of Alta
Vista, a
search
engine.

So what is the Internet? By the time you finish reading this book, you will
decide for yourself. Meanwhile, here are some activities you can do on the
Internet:

4 Research a topic: If you know how to conduct a meaningful search, you
can nearly always find the information you need on the Internet. Book II
explains researching on the Internet. Figure 1-1 shows the home page of
Alta Vista, a search engine.

4 Get the mail: F-mail, or electronic mail, travels much faster than conven-
tional mail. An e-mail message you send this instant can take as little as
three seconds to reach its recipient, although you can’t enclose a lock
of hair or scent your e-mail message with evocative perfume. Book III
explains e-mailing.

4+ Connect to other researchers: By joining newsgroups, mailing lists, and
Yahoo! groups, you can get information about many different topics from
other Internet researchers. Book IV looks into this subject.

4+ Trade instant messages: If you have teenagers, I bet you already know
about instant messaging. Instant messaging permits a dozen or more
people to gossip with one another while exercising their fingers on the
keyboard. Book IV, Chapter 1 looks into instant messaging.
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Turn your PC into a telephone: Besides trading text messages, you can
trade voice messages, and you can do it in real time such that your com-
puter behaves like a telephone. Book IV, Chapter 9 shows how a PC

can be made to act like a telephone.

Share your thoughts in a blog or online diary: A blog, or Web log, is a
journal, sometimes written anonymously, that anyone exploring the
Internet can find and read. Book IV, Chapter 2 explains blogs, the latest
Internet fad.

Join a social networking group: You can make friends and connections
online with people who share your passions and interests. Book IV,
Chapter 8 explores this topic.

Improve your financial picture: The Internet offers a thousand different
ways to research financial opportunities, and you can also track your
finances and bank online, as Book V explains.

Go shopping: On the Internet, you can shop till you drop without leaving
your own home. The Internet offers discount houses, auction houses,
and better yet, Web sites where you can compare prices and find out
whether an item is really worth buying. Book VI looks into shopping on
the Internet.

Hold a rummage sale: You can be a seller as well as a buyer. Selling your
treasures and trinkets over the Internet is easier than you think, as you
find out in Book VII.

Play games: You can always find a card game on the Internet, not to
mention a chess game and a poker game. Book VIII, Chapter 1 tells how
to find a game for you.

Plan your next vacation: For the sake of mental health, everyone needs
to look forward to his or her next vacation. Book VIII, Chapter 2 explains
how to plan and book ahead for your next trip to an exotic place.

Watch a movie: Now that computers have more storage capacity and
downloading files over the Internet is faster, you can watch movies on
your computer. Just make sure that the boss doesn’t see you do it.
Book VIII, Chapter 3 shows how to temporarily turn your computer
into a movie theater.

Turn your computer into a jukebox: Downloading songs from the
Internet is easier than ever, as Book VIII, Chapter 5 explains.

Trace your genealogy: You can find many online databases with infor-
mation about the dead, and many of them are free to explore. See Book
VIII, Chapter 6.
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How the Internet Works

In my experience, there are two kinds of people: the curious, who look under
the hood of the car to figure out how the car runs, and the others, whose
blind faith in machinery makes them indifferent. Even if you fall in the second
category, knowing a little about the workings of the Internet is worthwhile.
Someday you may decide to create a Web site. Or, you may wonder why your
Internet connection isn’t working. In times like those, it pays to know some-
thing about the Internet.

These pages explain in simple terms how the Internet works. And to help
you understand the workings of the Internet, I start with a history lesson.

A mercifully brief history of the Internet

Most historians trace the beginning of the Internet to Sputnik, the first satel-
lite to successfully orbit the earth. After Russia launched Sputnik in 1957,
the United States embarked on an ambitious national project to bridge what
was called the “technology gap” and catch up to the Russians in science and
technology. As part of that effort, the Department of Defense established the
Advanced Research Projects Agency, or ARPA, in 1958. The agency’s job was
to oversee the research and development of new technology for military use.

ARPA employed scientists and engineers in universities and laboratories
throughout the United States. These scientists and engineers needed a way
to exchange information and collaborate with one another. To this end, ARPA
developed the first computer network, called ARPANET, in 1969. The network
permitted researchers throughout the United States to dial in to and access
four host computers — three in California and one in Utah — over the tele-
phone lines.

To speed the transmission of data, ARPANET employed a novel means of
sending information over the telephone lines called packet switching. Instead
of data being sent in a continuous stream, it was divided into smaller units
called packets and sent all at once over available telephone lines. Arriving at
their destination, the packets were recompiled — in other words, the data
were reassembled so that it could be read or interpreted. Like ARPANET, the
Internet is a packet-switching network. Packet switching makes it possible
for data to travel very quickly, because the packets can arrive out of order,
withstand delays in transmission, and travel by many different routes to
their destination. By the strictest definition, the Internet is simply a packet-
delivery system. It can deliver information packets anywhere in the world in
less than a second.
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ARPANET was the forerunner of the Internet. In ARPANET, data did not pass
through a central hub; instead, all the host computers were connected to
all the other host computers. This revolutionary decentralized design per-
mitted data to take many different routes from one computer to another
because the computers were interconnected. And if one part of the network
failed, the network’s interconnectedness made it possible for other parts

to pick up the slack and continue transmitting data by a different route.
Moreover, the decentralized structure of ARPANET made it easier to add
computers to the network.

In the beginning, only four host computers — computers that other comput-
ers can connect to, similar to what we call Web servers — were available on
ARPANET, but universities and research centers soon understood the value
of being able to collaborate over a network, and more host computers were
added. By 1971, there were 23 host computers on ARPANET. In 1972, e-mail
was invented so that researchers could quickly exchange messages, and net-
work traffic increased dramatically. In 1977, ARPANET featured 111 host com-
puters. By 1989, ARPANET had become a “network of networks,” with some
100,000 host computers.

ARPANET had turned into the Gargantua that we call the Internet. ARPANET’s
designers envisioned an interconnected network with no central authority to
which new networks could be added. ARPANET succeeded beyond its design-
ers’ wildest dreams. Estimates of how many people worldwide use the Internet
range from 600 to 730 million. In 2001, for the first time, the number of hours
that Americans watch television shrank because the Internet had become an
alternative to television watching. Today, no single organization controls the
Internet. Each organization with a host computer is responsible for maintain-
ing its part of the Internet so that data packets can speed merrily along to
their destinations.

The Open Directory Project, a Web directory maintained by volunteers,
offers a Web page with links where you can get statistics about Internet use.
The Web page is located at this address: http://dmoz.org/Computers/
Internet/Statistics_and_Demographics.

The World Wide Web

The early Internet was strictly for academics and researchers. To retrieve
documents, you had to know advanced programming commands. You had to
remember arcane numerical Internet addresses. Each host computer had a
different command set for accessing files.

Book |
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Figure 1-2:
Ever
wondered
what a Web
address is
all about?

Starting in the late 1980s, however, innovations in computer science made
the Internet available to everyone. In 1989, a protocol called http, or hypertext
transfer protocol, made it easy to transfer files over the Internet. In computer
terminology, a protocol is set of rules by which computers communicate with
one another. You no longer had to learn a different set of commands to trans-
fer a file from a host computer to your computer because each host computer
stuck to the http standard. The letters http at the start of Web addresses refer
to the hypertext transfer protocol (see Figure 1-2).

The late 1980s also saw the invention of the World Wide Web, also known
simply as “the Web.” The letters www in Web addresses stand for World
Wide Web (refer to Figure 1-2). The man who coined this term, a computer
scientist named Tim Berners-Lee, called the Web “the universe of network-
accessible information, an embodiment of human knowledge.” Berners-Lee
was one of those utopians | mention at the start of this chapter. In prosaic
terms, the World Wide Web is just the sum of all the files — the Web pages,
audio files, movie files, and computer programs — that you can bring into
your computer from the Internet by way of the hypertext transfer protocol.
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Web addresses

Besides inventing the term World Wide Web, Tim Berners-Lee invented the
addressing system for locating files on the Web. Previous to this system, you
had to enter a hard-to-remember IP address number to visit a Web site, but
the system replaced numbers with descriptive domain names. In the system,
file addresses are designated by a domain name and then by a folder name
within the domain. To see how Web addresses work, consider the address of
the Web page shown in Figure 1-2:

http://www.ruthasawa.com/Pages/AsawasArt.htm
A computer reads this address like so:

4 http://: The file at this address can be transferred using the hypertext
transfer protocol.

4+ www: The file is located on the World Wide Web.

4+ ruthasawa.com: The domain name of the Web site to connect to is
ruthasawa.com. The next section in this chapter explains what domain
names are and how computers use them to locate computers on the
Internet. The . com ending on the domain name tells you that the site is
commercial (for-profit) in nature.

4 /Pages: Within the ruthasawa.com Web site, the file is found in a folder
called Pages. Files on Web sites are stored in folders, just as files are
stored in folders on your computer.

4+ /AsawasArt.htm: The file to be transferred is called AsawasArt.htm.
The . htm file extension means that the file is written in hypertext
markup language.

The addressing convention that Tim Berners-Lee invented made it possible
for computers to quickly locate and download files from the World Wide
Web. His addressing convention also made the Web more weblike. Now that
everyone agreed on how to address Web pages, linking Web pages became
much easier. Hyperlinks began appearing on Web pages. For the first time,
you could point to and click a hyperlink on one Web page and go straight
to another page. (By the way, Berners-Lee called Web addresses uniform
resource locators, or URLs, a term that is thankfully falling out of favor. I only
mention URLs here in case someone mentions them to you and you want to
nod your head wisely because you know what URLs are. In this book, I refer
to URLs as Web addresses.)
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More computer science innovations brought the Internet even closer to
home. Faster modems decreased the amount of time you had to wait for Web
pages to arrive on your computer. In the early 1990s, the first Web browser,
Mosaic, appeared. Now a program made especially for exploring the Internet
was available. Also in the mid-1990s, the Java computer language made it
possible to incorporate video and sound on Web pages. And don’t forget the
mouse! All hail the mouse! Where would we be without it? You can explore
the Internet for hours at a time without touching the keyboard thanks to this
furry little animal. And it’s amazing that the mouse didn’t become a com-
puter apparatus on Macs until 1986 and on PCs until 1987.

1P addresses

Every computer that’s connected to the Internet has an Internet Protocol
address, better known as an IP address. Computers use these addresses to
locate data and to send data over the Internet.

Want to know your computer’s IP address?

Follow these steps to find out your computer's 2. Enter ipconfig and press Enter.

IPEntieEs The window shows you information about

1. Choose Start->Programs->Accessories~> your computer, including its IP address.
Command Prompt (choose MS-DOS instead
of Command Prompt if you are running
Windows 98 or Windows Me).

The Command Prompt window opens.

Here's an even faster way to find out your IP
address. Open your Web browser, enter this
address in the Address bar, and press Enter:

www.whatismyip.com

B Command Prompt = =] |
Hicrosoft Windows WP [Uersion 5.1.26801 ﬂ
(C) Copyright 198528081 Microszoft Corp. _J

C:nDocuments and Settings Perk>ipconfiyg

lindows [P Configueation

Ethernet adapter Local firea Connection:

Connection—specific DHS Suffix . :
IP Address. . . . . . . . . . . . : 165.168.1.181
Subnet Mask . . . . . . . . . . . 255355 356 @
Default Gateway . . . . . . . . . : 1e5.168.1.1

C:vDocuments and Settings“Perk>ipconfig
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If yours is a DSL Internet connection or cable modem connection, your IP
address is permanent and unchanging. If yours is a dialup Internet connec-
tion, your Internet provider assigns you a new IP address each time you con-
nect to the Internet.

An IP address is a 32-bit (4-byte) binary number, which needn’t concern you
very much. The point is that the number identifies a computer on the
Internet. Here is an example of an IP address:

216.239.39.99

Each domain name — google.com, yahoo.com,and microsoft.com, for
example — is assigned an IP address. The IP address just listed, for example,
belongs to the domain name google.com. When you enter a Web address in
your browser to view a Web page, your computer takes note of the domain
name part of the address (google.com, yahoo.com, or microsoft.com,

for example) and sends a query to a domain name server asking for the IP
address that’s assigned to the domain name. The domain name server, in
turn, sends the IP address of the domain name back to your computer. Your
computer then sends a request for Web-page files from the IP address in
question, and in less than a second, if you have a fast Internet connection,

a Web page appears on your computer screen.

Something similar happens when you send an e-mail message. Your com-
puter sends a query asking for the IP address of the domain name, the
part of the e-mail address after the at (@) symbol. When the IP number is
returned, the e-mail message is sent.

To see how IP addresses work, try this simple exercise:

1. Open your Web browser.
2. In the Address bar, type www.google.com and press Enter.

Your browser opens to the Google home page, as shown at the top of
Figure 1-3.

3. Delete the www.google.com in the Address bar and enter the
following:
216.239.39.99
4. Press Enter.

You see the Google home page again, as shown at the bottom of
Figure 1-3, because the number you entered in Step 3 is the IP address
of google.com.

Book |

[x]
=
)
=
=3
@
-
-

Jousaju| ayy yum
pajuienbay buyag



20  How the Internet Works

Domain name IP address

55 Google - Mozilla
File Edit View Go Book ks Tools | Wind Help
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i File Edit View Go Bookmarks Tools Window |Help

4.2 .32 E 3 = asea S -
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Figure 1-3: Adwanced Search
Normally, A |_Google Search | I'm Fesling Lucky | e i
your
computer
enters the Advertising Programs - Business Solutions - About Google
IP address @2004 Gaogle - Seaiching 4,285, 198,774 web pages
for you. T P—

In the old days, before the domain-name addressing system for locating files
on the Web, you had to enter IP addresses. Aren’t you glad you don’t live in

the old days? Entering descriptive Web addresses sure beats entering 32-bit
binary numbers.

Finding a Web site’s 1P address

If you are called on to play Internet detective and find the IP address of a
Web site, you can follow these steps to find it:
1. Choose Start=>Programs->Accessories->Command Prompt.

If you are running the Windows 98 or Windows Me operating system,
choose MS-DOS instead of Command Prompt. You see the Command
Prompt window.

2. Enter ping and a blank space.

3. Enter the domain name of the Web site whose IP address you need.



Figure 1-4:
You can
“ping” to
find IP
addresses
on the
Internet.
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For example, to find the IP address of google.com, enter google.com, as
shown in Figure 1-4.

4. Press Enter.

The Command Prompt window tells you the Web site’s IP address (refer
to Figure 1-4). Notice the “approximate round trip times in milli-seconds”
in the Command Prompt window. It took my computer only 76 millisec-
onds to ask for and receive the IP address of google.com. That’s less
than a tenth of a second. Information travels fast on the Internet.

B3 Command Prompt ol x|
Microzsoft Windows WP [Uersion 5.1.26881 -
{Cy Copyright 1985-2001 Microsoft Corp.

C:xDocunents and Settings Ferk>ping google.con
Pinging google.com [216.239.37.991 with 32 bytes of data:

Reply From 216.239.37.9%: hytes=32 time=77ns TTL=237
Reply from 216.239.37.99: bytes=32 time=77nsz TIL=237
Reply from 216.239.37.99: hytes=32 time=T6ms TIL=237
Reply from 216.237.37.99: bytes=32 time=76ms TTL=237

Ping statistics for 216.239.37.99:

Packets: Sent = 4, Received = 4, Lost = @ (B loss).
Approximate round trip times in milli-—seconds:

Mininum = P6ms, Maximum = 77ms, Average = 76ns

C:sDocuments and SettingsPerk>

How Web Pages Work

If a friend tells you to go to the such-and-such Web page because it is enter-
taining, thought provoking, or funny, and you go there, you aren’t really
going anywhere. Really, the Web page is coming to you. The files with which
the Web page is composed come to your computer so that you can view
them.

All but the simplest Web page consists of many different files — text files,
graphic files, and sometimes animation, video, and sound files. To see what
I mean, take a look at Figure 1-5, a Web page from amazon . com. The top half
of the figure shows the Web page without the graphic images; in the bottom
half of the figure, you can see where the graphic image files have been
plugged into the Web page. This Web page consists of a dozen or more files.

When you bring a Web page like this to your computer, the image files tag
along behind the Web page. Hypertext markup language in the Web page
tells your Web browser where to plug in each tag-along file, and the result is
a full-fledged Web page.
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Figure 1-5:
Most Web
pages
consist of
many
different
files.

Missing image files

&1 Amazon.com: Books: Office 2003 Allin-me Ap<k A Aidie N mtunaumies - Microsoft Internet Explorer = (03 |
ay

Eile Edit View —Favoiites_Todis sy’ / /] ||\ "
B

. . BROWSE < . - ES E-BODKS
SEARCH SUBIECTS BESTSELLERS MAGAZINES

CORPORATE
ACCOUNTS % DOCS

BARGAIN BOOKS U

EIT Office 2003 All-in-One Desk
Books +| Referencd for Dummies

by Peter welerks Quantity: 1 |v|

#dd to Shopping Cart

List Price: §20.00
Price: $19.79 &

aeligible for Sian in to tum on 1-Click
= P FREE Super ardering.
Saver
Shipping on
orders over
$25. See 74 used & new from
details. $6.29
You Save: $._;Ec;§0 Available for in-store
Bl infi Search inside this book . - > ick f 5
uying info Awvailability: Usually pickup now from: $27.00
sditorial reviews  ships within 24 hours Prige mal bany, based-on (ol
R T T auailability 2]
< i >

&] Amazon.com: Books: Office 2003 All-in-One Desk Reference for Dummies - Microsoft Interet Explorer 'E@ﬁ1

File Edit View Favorites Tools Help 'i':.’

Address | & hitp:f e amazon.com/exec fobidas tajdetail - 0764536637 /qid=1098732268/sr=1-1/ref=sr_1_1/103-3514531-50958427v=q| -

amazon.com.

|~

N VIEW CART | WISHUIST |  YOUR ACCOUNT ) | HELP

“APPAREL & TOYS &
ACCESSDRIES | ELECTRONICS | Ganges m

BROWSE | CORPORATE | E-BDOI
! ALCOUNTS & DO

60+ sport, outdoor, and fan shop:

Gear up and get out N Shop Sports & Outdoors

Office 2003 All-in-One Desk
Books 2l Eyepfizfcjgfetg Dummies e T
e © rto o
List Price: §23.93
Price: $19.70 & or
A eligible for Bign in to turn on 1-Click
If@. WERSEAICH] FREE Super ardering.

Saver
shippirig ori MORE BUYING CHOICES

orders over

L 74 used & new from

$2E5. See
detais, B | $6:29
7 You Save: $10.20 B .
BOOK INFORMATION i ? $3Q% Available for in-store
rempre Saarch inzida thiz b ¢ '
buying info e e Availability: Usually pickup now from: $27.00 |y

< I >




Figure 1-6:
HTML
codes for
the Web
page shown
in Figure 1-5.
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Web pages are written in hypertext markup language, or HTML, the computer
language that tells the Web browser how to lay out and construct Web pages
from the different files with which they are made. Want to see something
scary? In your browser, choose View=>Source (in Internet Explorer) or
Views>Page Source (in Mozilla) to see the HTML codes with which a Web
page is constructed. Figure 1-6 shows some of the HTML code used to con-
struct part of the page shown in Figure 1-5.

These codes are scary, but don’t be discouraged if you want to create a Web
site of your own. Thanks to the miracle of modern computer science, you
can create Web pages and Web sites without having to know or write HTML
codes, as Book IV, Chapter 7 explains. Keep your chin up. All is not lost.

& 103-95145315095842[1] - Notepad [B[=]x]
File Edit Format View Help |
{a -~
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Chapter 2: Choosing an Internet
Service

In This Chapter

+* Looking at the equipment you need
v Comparing broadband and dialup connections
1 Comparing the types of Internet connections

v~ Asking the right questions when you choose an Internet service
provider

rlis short chapter is for people who want to jump aboard the Internet
but haven’t chosen an ISP yet. ISP stands for Internet service provider.
You need to sign up with an ISP to explore the Internet and send and receive
e-mail. This chapter gets you up to speed on speedy broadband connections
and slower dialup connections. It compares the types of Internet connec-
tions and explains what to look for as you choose an ISP.

The Equipment and Software You Need

As nice as it is to connect to the Internet and view Web pages by relying on
your psychic powers alone, most people can’t do that. Besides a computer,
most people need a Web browser and a modem.

A Web browser is a software program for exploring the Internet. Popular
browsers include Internet Explorer and Mozilla. If your computer runs
Windows, the Internet Explorer browser is already loaded on your com-
puter. (Book II, Chapter 2 describes and compares the different Web
browsers.)

A modem is a hardware device for linking a computer through the telephone
lines to the Internet. Modems convert digital data (electronic signals repre-
senting binary numbers) to analog data (signals that can have many varia-
tions) so that the data can travel over the telephone lines. After the analog
signal arrives, the modem on the receiving end converts the analog data
back into digital data that computers can understand. Modem stands for
modulator/demodulator.
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Data transmission rates for Internet dialup modems are measured in kilobits
per second (Kbps). Faster broadband modem rates are given in megabits per
second (Mbps). Table 2-1 describes the different speeds at which modems
operate. The first two entries in the table are dialup connections; the others
are broadband (more about that in a minute).

Table 2-1 Modem Types

Modem Connection Description
Speed

Dialup Connections

Internal 56 Kbps The modem is plugged into the motherboard of the com-
puter — in other words, it's inside the computer. To
connect to the Internet, you plug the phone line into
a port on the back or side of your computer.

External 56 Kbps The modem is attached to your computer through a par-
allel, serial, or USB (Universal Serial Bus) port. An exter-
nal modem is separate from your computer. You plug the
modem into your computer and the telephone line into
your modem.

Broadband Connections

ISDN 128 Kbps This requires installing ISDN (Integrated Services Digital
Network) adapters in your computer. The connection is
made through high-speed digital cables installed by the
phone computer or a service provider.

Cable 384 Mbps This type of modem can be an external or internal type.
Through a cable wall outlet, the computer is connected
to the cable TV line.

DSL 384 Mbps This type of modem can also be internal or external. It
requires a network adapter.

Want to test the speed of your modem? Go to the Test Your Internet Speed
Web page at this address: http://modem.4mg.com. Click the Test Your
Internet Speed link, and you go to a page with a graph that plainly shows
how fast or slow your Internet connection is.

Broadband versus Dialup Connections

Connections between a computer and the Internet fall in two categories:
broadband and dialup. A broadband connection is an Internet connection
that is always on and is capable of transmitting data very quickly. Broadband
services can be delivered over the telephone lines, by way of a private
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network, by way of a cable modem, or in a wireless network. A broadband Book |
connection is much faster than a dialup connection. If you plan to spend Chapter 2
more than an hour a day on the Internet and do sophisticated stuff like play
video games online or download music, you owe it to yourself to spend the
extra money for a broadband connection.

A dialup connection is one in which the computer literally dials a telephone
number whenever you connect with the Internet. The only advantage of a
dialup connection over a broadband connection is the cost. At $10-$25 per
month, dialup service costs a third as much as broadband service, which is
$40-$60 per month. If you've explored the Internet using a broadband serv-
ice, it’s hard to go back to the slower dialup method. What’s more, if you
have broadband service, you can simultaneously talk on the telephone while
you explore the Internet. With a dialup connection, the phone line is occu-
pied, so you can’t make a phone call while you’re online — nor can anyone
call you. (The next chapter in this mini-book explains how to connect a com-
puter to the Internet.)
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Types of Connections

Table 2-2 compares the types of Internet connections. Apart from dialup con-
nections, not all ISPs offer the connection types listed in the table. Before
you can install a DSL connection, the telephone company must verify that
the lines in your area can support DSL. With a cable connection, data are
delivered over the same line that carries the television signal.

Table 2-2 Types of Internet Connections

Connection Speed* Equipment Cost

Dialup 50 Kbps Internal or external modem, $10-25
telephone line

DSL 384 Mbps Ethernet card, external $40-60
cable modem, Cat-5 cable

Cable 384 Mbps Ethernet card, external $40-60
cable modem, Cat-5 cable

Satellite 400 Mbps Ethernet card, dialup modem $50-110

plus installation

*Upload average speed; download speeds are typically five to ten times higher.
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Choosing an Internet Service Provider

If you intend to explore the Internet, send and receive e-mail, or create a Web
site for the Internet, your first task is to choose an ISP. An ISP is a company
that provides customers access to the Internet, e-mail services, and in some
cases, the opportunity to post Web sites. You've probably heard of popular
ISPs such as America Online (AOL), MSN, and EarthLink. Some 7,000 ISPs can
be found in the United States. How do you choose which one is right for you?
Following are some considerations to make as you choose an ISP.

Monthly service charge

Monthly service charges range from $10 to $30 (for people who use dialup
modems) to $30 or more per month for a fast digital subscriber line (DSL),
cable modem, or T1 connection.

The setup fee

Most ISPs charge a one-time setup or enrollment fee. Depending on how
many ISPs are located in your area and how stiff the competition among ISPs
is, fees vary from no charge to $40.

Long-distance dialup

If you connect to the Internet by dialup modem, the modem in your com-
puter calls the ISP’s computers. If that telephone call is a long-distance call,
going on the Internet becomes an expensive proposition because you have
to pay long-distance rates for each connection time. National ISPs, such as
those run by the major telephone companies, offer regional phone numbers
that you can call no matter where you travel. If you travel a lot and have to
connect a laptop computer to the Internet from various cities and regions,
consider signing on with an ISP that offers points of presence (or simply
POPs), which are the regional telephone numbers that you can dial to con-
nect to an ISP.

Online time

Nowadays, nearly every ISP charges a flat monthly rate to go online for as
many hours as you want. Still, find out whether the ISP that you’re consider-
ing charges a flat rate or a by-the-hour rate. That way, you know what to
expect from your first bill.

Server space for your Web pages

Some ISPs offer their subscribers the opportunity to post Web sites at no
extra charge on their company servers; others charge an additional fee to
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subscribers who want to put their Web sites on the Internet. Most ISPs allow
1-2MB to as much as 50MB of server space. If you are new to the Internet, the
prospect of creating Web pages probably seems foreign to you, but believe
me, you may well consider creating a Web site down the road, and you will
need a place to put it on the Internet. If you can get free server space for your
Web pages, more power to you.

Spam blocking and virus protection

Some ISPs have built-in software that screens out spam, which is the Internet
equivalent of junk mail. Some ISPs screen all files for viruses as well. On the
face of it, virus screening seems like a good deal, but some virus screeners
aren’t sophisticated and merely block certain kinds of files, such as .exe
(executable) files or files that are larger than a certain number of megabytes.
You may legitimately receive these kinds of files from coworkers, in which
case virus screening isn’t for you. Besides, you can rely on your own antivirus
software to block viruses. (Book I, Chapter 4 looks into viruses and other
security considerations; Book III, Chapter 5 explains how to prevent spam.)

Length-of-service contracts

Anybody who has a cell phone knows that length-of-service contracts can
be a real burden. Under these contracts, you have to sign on for a year (and
sometimes longer). If the service doesn’t suit you, you can’t quit the service
during the contract period without paying a fee. If an ISP that you're consid-
ering requires you to sign a length-of-service contract, make sure that you
investigate the ISP — especially its billing policies — before you sign your
name on the dotted line.

Technical help

Typically, the big corporate ISPs such as SBC and Earthlink don’t offer very
good technical assistance to customers. Try to get assistance from them,
and you have to negotiate a phone tree and be very patient. Small, local ISPs
do a much better job of providing assistance. You can get a real, live human
on the phone very quickly. However, local ISPs sometimes charge a higher
monthly rate for service than the corporate behemoths.

Try to get an idea of how long the company takes to reply to e-mail queries
for technical assistance. Find out as well whether the ISP maintains a 24-hour
telephone line that you can call if you need technical assistance. (By the
way, queries as to what to do about smoke coming from a modem should

be directed to the local fire department, which is obliged to respond faster
than an ISP.)

Book |
Chapter 2

921MI3G Jawidju|

ue buisooyq



30 BookI: Getting Started



WMBER
&‘&
&

Chapter 3: Setting Up Your
Internet Connections

In This Chapter

+ Connecting to the Internet with a dialup modem
v+~ Connecting to the Internet with a DSL or cable modem

1~ Setting up an e-mail account for an e-mail program

Before you can climb aboard the Internet, you have to take care of all
the Internet connections. You need to configure your software so that
it knows how to connect to your Internet service provider (ISP). You need to
set up an e-mail account.

Fortunately, the people who sell and set up Internet connections have made
this business considerably easier than it used to be. You were probably sent
a kit with a CD and other material that explains and takes you step by step
through the setup procedures. This chapter explains those procedures and
describes how to set up an e-mail account so that you can send and receive
e-mail. (If you haven’t chosen an ISP yet, refer to the previous chapter.)

Making a successful connection to the Internet for the first time is more your
ISP’s responsibility than yours. Do not hesitate to ask for help from your ISP
to complete this task! This chapter gives general instructions for connecting,
but every ISP is different. If you have any questions, call your ISP.

Connecting with a Dialup Modem

As the previous chapter explains, a dialup connection is one in which the
computer literally dials a telephone number to connect to the Internet. To
connect, you use a dialup modem. These modems can either be located
inside the computer or be a separate device that sits on the desk or floor
(where they collect dust and inevitably get kicked around a little). If you're
lucky, your ISP has provided you with an automated program on a CD to
help with the setup. But even if you're not lucky, setting up isn’t that hard,
especially if you’re running Windows XP, which offers the New Connection
Wizard for setup purposes. These pages explain — for Windows users of
either XP or an earlier version — how to connect to the Internet with a
dialup modem.
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Connecting with a Dialup Modem

Before you begin
Before you tell Windows how to connect your computer to the Internet, you
need this information:

4+ ISP name: Your ISP’s domain name. The domain name is the part of a
Web address after the www. It ends with the letters .comor .net.
Example: sbcglobal.net

4+ Telephone number: The phone number to call your ISP. (See the follow-
ing Tip for advice about entering the telephone number.) In some areas,
you must dial the area code, even when making a local call. Example:
301-555-9753

4+ Username: The name on your account. If you have an e-mail address,
your username is the part of the address before the at (@) symbol. Your
ISP gives you the opportunity to choose this name. Example: KennyNYC

4+ Password: The combination of letters and numbers that you must enter
when you connect to the Internet. Example: 4kings

How you enter your telephone number depends on whether you are dialing
outside your area code, whether you are dialing from an office or other place
where you have to dial 9 or another number to get an outside line, and
whether call waiting is installed on your telephone:

4+ Area code: If the ISP telephone number that you call is outside your area
code, include 1 and the area code in the telephone number with which
you call your ISP. (I respectfully suggest that you find another way to
reach your ISP or think of changing ISPs if you are dialing a different area
code. Dialing outside your area code can cost you dearly if you spend a
lot of time on the Internet.)

4 Outside line: Enter the number, probably 9, that you need to get an out-
side line before entering the telephone number. Enter commas as well
after the 9; each comma tells your computer to pause for three seconds
before continuing to dial the outside line. For example, enter these num-
bers and commas to dial an outside line, pause six seconds to wait to get
the outside line, and then dial an ISP:

9,.,555-9753

4+ Call waiting: If you have call waiting, you have to disable it while you
are exploring the Internet, because if someone calls, your connection to
the Internet will be disrupted. Most setup programs have a Disable Call
Waiting option. If yours doesn’t, you can disable call waiting by entering
*70 or 1170 before the telephone number you dial to connect to your ISP.
For example, these numbers disable call waiting and dial an ISP:

1170 555-9753



Figure 3-1:
The
Network
Connection
Type dialog
box.
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Dialup connections for Windows XP users

Use one of these techniques to set up a dialup connection on a computer
that runs Windows XP:

4 Click the Connect to the Internet Icon on your desktop.

4 Choose Start>All Programst>AccessoriesoCommunicationst>Internet

Connection Wizard.

You see the Internet Connection Wizard dialog box. Follow these steps to tell
the Wizard what kind of connection you want:

1. Click the Next button to bring up the Network Connection Type dialog
box, shown in Figure 3-1.

New Connection Wizard

Metwork Connection Type =
“whal do vous wart 1o do?

P

Connect to the Internet 20 pou can brovess the 'Web and read smail

© Connect to the network at my workplace:
Connect to & business network [Lsng diskup o WPN) 20 you can wark fram home,
2 field office. or another location

) Set up a home or small office network
Connect to an existing home or smal offics network, or 528 up 3 new one,

) Set up an advanced connection

Canrect directly bo zecther computer using your zendl, paralel, or sérared port, or
2ot up tez computer 2o that other computers can connect ta it

¢Back || Mew> | [ Canesl ]

2. Select the first option, Connect to the Internet; then click the Next
button.

3. Select the second option, Set Up My Connection Manually; then click
the Next button.

=

Select the first option, Connect Using a Dial-Up Modem.

bl

Keep clicking the Next button and answering the Wizard’s questions.

You are asked for your ISP’s name, its phone number, and your user-
name and password (see the previous section in this chapter). You are
also asked whether to “Use the name and password you enter when
anyone connects to the Internet from this computer.” Select this check
box if you don’t mind others who share your computer connecting to
the Internet with your ISP.
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If your connection needs adjusting, go to the Internet Properties dialog box.
To get there, choose Start=>Control Panel. In the Control Panel window,
switch the Control Panel to Category view, if necessary, click the Network
and Internet Connection Settings link, and then click the Set Up or Change
Your Internet Connection link. In the dialog box, select the name of your
dialup connection and then click the Settings button.

Dialup connections for Windows 98,
2000, and Me users

If you don’t have the latest version of Windows — Windows XP — don’t
despair. People with Windows 98, 2000, or Me on their computers can
establish a dialup Internet connection by following these steps:

1. Choose Start>Programs->Accessories->Communications->Internet
Connection Wizard.
The Internet Connection Wizard appears.

2. Select the third option button, I Want to Set Up My Internet
Connection Manually; then click the Next button.

3. Select the first option button, I Connect through a Phone Line and a
Modem; then click the Next button.

4. In the remaining dialog boxes, enter your phone number, username,
password, and a connection name (so that you can identify the con-
nection if you need to alter if).

Earlier in this chapter, “Before you begin” explains what this stuff is.
5. Select Yes to create the connection.
If your connection needs changing, open the Control Panel and click the
Internet Options link. The Internet Properties dialog box appears. Click the

Connections tab, select a connection, and click the Settings button. Then
change the connection settings in the Settings dialog box.

Connecting with a DSL or Cable Modem

As the previous chapter explains, DSL and cable-modem connections are the
fastest way to travel the Internet. Besides the price, which is two to three
times higher with cable-modem or DSL service, the only drawback to DSL
and cable-modem connections is having to wait for the ISP to come to your
home and install your DSL or cable modem. It can take several weeks,
depending on the ISP.
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Before you begin
Gather this information before you tell Windows how to connect your com-
puter to the Internet:

4 ISP name: Your ISP’s domain name. This is the part of a Web address
after the www. It ends with the letters .comor .net. Example:
sbcglobal.net

4+ Username: The name on your account. If you have an e-mail address,
your username is the part of the address before the at (@) symbol. Your
ISP gives you the opportunity to choose this name. Example: BillyNYC

4+ Password: The combination of letters and numbers that you must enter
when you connect to the Internet. Example: king444

Making the connection

With a little luck, the person who installed your DSL or cable modem left
behind a CD that handles connecting the modem for you. Better yet, the kind
installer did the connection setup work for you. If that wasn’t the case, how-
ever, making the connection is your job. To set up a DSL or cable-modem
connection, start by doing one of the following:

4 Click the Connect to the Internet icon on your desktop.
4 Choose Starte>All Programst>Accessories>Communicationst>Internet

Connection Wizard.

The Internet Connection Wizard dialog box appears. Follow these steps to
set up your Internet connection with the wizard:

1. Click the Next button to see the Network Connection Type dialog box
(refer to Figure 3-1).

2. Click the first option, Connect to the Internet; then click the Next
button.

3. Select the second option, Set Up My Connection Manually; then click
the Next button.

4. Select the second or the third option.

Which option you choose depends on whether your connection is made
automatically when you start your computer or whether you have to
enter your username and password each time you connect to the
Internet.
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5. Keep clicking the Next button and answering the wizard’s questions.

You're done if your connection is always on. If a username and password
are required, you are asked for your ISP’s name, a username, and a pass-
word. You are also asked whether to “Use the name and password you
enter when anyone connects to the Internet from this computer.” Select
this check box if you don’t mind others who share your computer con-
necting to the Internet with your ISP.

If your connection needs adjusting, choose Start=>Control Panel. Switch
the Control Panel to Category view, if necessary, click the Network and
Internet Connection Settings link, and then click the Set Up or Change
Your Internet Connection link. In the dialog box, select the name of your
connection and then click the Settings button to change your connection
settings.

Setting Up an E-Mail Account

Before you can send and receive e-mail with an e-mail program, you need to
set up an e-mail account. By setting up an account, you identify yourself to
your ISP and make it possible for others to send you e-mail. By the way, Book
III, Chapter 1 explains how e-mail is sent and delivered, in case you're inter-
ested in what goes on backstage.

The particulars of setting up an e-mail account differ from program to pro-
gram, but no matter which e-mail program you use, you provide this infor-
mation to set up your account:

4+ Incoming mail server type: Find out whether your ISP operates a POP3
or IMAP incoming mail server. It probably operates a POP3 server.

4+ Incoming mail address (POP3): E-mail addressed to you is kept on your
ISP’s incoming mail server until you go online to collect it, which is why
you need this address. The address begins with the letters pop and
looks something like this:

pop.sbcglobal.net

4 Outgoing mail address (SMTP): This address begins with the letters
smtp and looks something like this:

smtp.sbglobal.net

+

Account name: Your account name is the same as your e-mail address.

4+ Password: Enter the password you recorded with your ISP when you set
up your Internet connection.
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Figure 3-2 shows a dialog box for setting up an e-mail account in Outlook Book I
Express. Here is how to create an e-mail account in different software Chapter 3
programs:

4+ Eudora: Choose Toolsw>Personalities, and right-click and choose
Account Settings. Then click the Next button and provide the account
information.

4+ Netscape Mail: Choose Edit=>Mail/News Account Settings, click New
Account, and negotiate the New Account Wizard.

TIRETTI,)
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4 Outlook Express: Choose Tools>Accounts, and in the Internet Accounts
dialog box, select the Mail tab and click the Add button.

4 Outlook: Choose Tools=>E-mail Accounts, select Add a New E-Mail
Account in the E-Mail Accounts dialog box, and click the Next button.
Then negotiate the wizard dialog boxes.

4+ Pegasus: Choose FilecoNetwork Configuration, and in the Pegasus Mail
Options dialog box, select the Network tab and enter the information.

Internet Connection Wizard &

E-mail Server Names

My ncoming mail gervet i a | POP3 ve | smrver

Incoming mal [POFZ. IMAP or HTTP) server
pop.sboglobal net

Ain SMTP zeaver is the server that iz used for pour oubgoing email

Figure 3-2: Dutgorg mal [SMTP) server:
Setting up smip sheglobal et

an e-mail

accountin

Outlook

Express. Back [ mest> | [ Concal
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Chapter 4: Protecting Vour
Privacy and Security

In This Chapter

v Protecting your computer from viruses
v+~ Updating your copy of Windows

v Using a firewall to protect your computer
v Taking on spyware and adware

1+ Preventing identification theft

Fe Internet brings the world to your doorstep, but it also brings hoax-
ters, scam artists, and phishers (this chapter explains who they are).
Without the right protection, your computer is subject to getting sick from a
virus. Spyware and adware, as this chapter explains, have probably already
made their way into your computer. How’s your firewall doing, anyway?

This chapter looks into how you can enjoy all the benefits of exploring the
Internet without any of the hassles or catastrophes that come from not
being properly protected. You discover how viruses work and how to pro-
tect your computer from viruses, how to throw a protective firewall around
your computer, and what to do about spyware and adware. This chapter
details how scam artists are stealing identifications on the Internet and why
keeping your copy of Windows up to date can do a world of good where
Internet security is concerned.

Preventing a Uirus Attack

A virus is a software program that hides inside other software without anyone
knowing it. Viruses are created with malicious intent, either to damage com-
puters or to call attention to themselves and their anonymous creators.
About 200 new viruses are introduced to the Internet each month. What
makes some viruses dangerous is the speed with which they spread. In 2004,
a virus called Mydoom infected a quarter-million computers worldwide in a
single day. In 1999, the Melissa virus caused such havoc on the Internet that
many companies, Microsoft included, shut down their e-mail systems.
Viruses range in virulence from the docile Hank virus, which simply wished
a happy birthday to someone named Hank, to the Michelangelo virus, which
attempted to reformat computers’ hard drives.
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These pages explain how to prevent viruses from spreading, the different
kinds of viruses, and how viruses spread. They also look at how to choose
antivirus software and different antivirus programs.

Virus Bulletin (www.virusbtn.com) reviews and tests antivirus software.
When you want to compare features and shop for antivirus software, it’s the
place to go. Next time somebody sends you a panicky e-mail claiming that
you may have been hit with a virus, look up the virus’s name at Vmyths
(http://vmyths.com). This Web site catalogs virus hoaxes for the benefit
of nervous Nellies.

Only you can prevent viruses from spreading

Ninety percent of viruses are spread in e-mail attachments sent over the
Internet. The only way to prevent viruses from spreading is to use antivirus
software, be careful which files you download from the Internet, only open
files sent to you by e-mail if you know and trust the sender, and apply the
same vigilance to files given to you on floppy disks and CDs as you do to files
sent to you by e-mail.

“&N\BEH It’s generally understood that if a stranger sneezes near you in a crowded

& bus, you may get the stranger’s germs. Why, then, do some people not think
twice about opening files sent to them by strangers over the Internet? These
files, like the stranger’s germs, could well be infected. If you get an e-mail
attachment from an address and person you don’t recognize, start by assum-
ing the worst. Assume you've been sent a file infected with a virus. Then
study the file’s three-letter extension to find out which kind of file was sent
in the attachment. The file types listed in Table 4-1 are capable of carrying

viruses.
Table 4-1 File Types That Can Carry Viruses
Extension File Type Notes
.bas BASIC program file These are executable files.
.bat Batch Batch files are MS-DOS program files.
.class Java program A_s executiable files, these can carry
viruses.
.cmd Windows Batch These can include viruses.
.com Executable Computers can read and execute com-
mands in these files.
.doc Word Word files can cor}tain macros, and
macros can contain viruses.
.dot Word template Word templates can also contain

macros.
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Extension File Type Notes

.exe Executable A very dangerous kind of file. Many
computer programs are executable
files.

.hta HTML application A computer program that can contain
viruses.

LJv Java Java code can include executable
commands.

.mdb Access These files can contain macros, and
macros can contain viruses.

.msi Windows Installer These program files tell Windows how
to install other programs.

.0CX ActiveX module This is an executable file.

.pif Program Information ~ These programs tell Windows how to
run DOS programs.

.ppt PowerPoint PowerPoint presentations may contain
viruses if they contain macros.

.scr Screen saver file This is an executable file.

vbe, .vbs, .vg Visual Basic Script Viruses can be written in Visual Basic,
a computer language.

.vsd Visio template file This file type can contain macros.

WS, .WSC, .wsTf Windows Script Host ~ These scripts can include executable
commands.

.x1s Excel Excel spreadsheets can contain
viruses if they also contain macros.

X1t Excel template Excel template files can contain

viruses, too.

If the file sent to you is one listed in Table 4-1, don’t open the file. Either

delete the file immediately oy, if you think the file may be legitimate, ask the
person who sent it what is in the file and why it was sent. By the way, don’t
be fooled because the return address looks legitimate. Attaching a convincing-
looking return address to an e-mail message is easy. There’s even a word for
it — e-mail spoofing.

Windows hides some kinds of file extensions. To be able to see all file exten-
sions on your computer and adequately judge whether they may be carrying
viruses, follow these steps:
1. Open Windows Explorer or My Computer.
2. Choose Tools->Folder Options.
The Options dialog box opens.
3. Select the View tab.
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4. Deselect the Hide Extensions for Known File Types check box.
5. Click the OK button.

As Book III, Chapter 1 explains, you can roll several files into one file, called a
Zip file, to make sending the files easier. Normally, antivirus software detects
viruses in incoming mail, but that isn’t so of Zip files. Because the files have
been zipped, or compressed, antivirus software can’t read them to tell
whether they contain viruses. The moral of the story is to examine files care-
fully after you unzip them. Unzipped files can contain viruses.

Differentiating types of viruses

Viruses come in these different shapes and forms:

4+ E-mail virus: This kind of virus reproduces itself by going into the recipi-
ent’s Address Book, taking down names, and e-mailing itself to tens or
hundreds of people at once. It’s important to remember that no virus
can spread inside an e-mail message. Viruses travel by e-mail, but not
inside messages — they travel in files attached to e-mail messages.

4+ Time bomb: This is a virus that is programmed to lie quietly in wait on a
computer until the appointed hour, when it “explodes” and causes
damage.

4+ Trojan horse: This virus masquerades as one kind of program but is
really another. The game you thought you downloaded turns out not to
be a game at all, but a virus. Trojan horses travel on the Internet by
stealth, not by reproducing themselves quickly like other viruses.

4+ Worm: This is a virus that quickly makes copies of itself on many com-
puters. Worms infect a security hole in a network, and when they are
inside the network, quickly copy themselves from computer to com-
puter. Code Red, the most notorious worm, copied itself to a quarter-
million computers during one day in July 2001.

Viruses slow Internet traffic. They clog computer networks. They make com-
puters run more slowly by tying up a computer’s processor. They destroy
important files. Always be on the alert for viruses, and make sure that
antivirus software is installed on your computer.

How virus infections spread

When you open a program or file that contains a virus, the virus scans your
computer for programs or files that it can attach to, and before it opens, it
infects those programs or files. Now several programs or files on your com-
puter are infected with the virus. In this way, the virus reproduces itself.
Eventually, some activity — the arrival of a certain date, for example —
triggers the virus to go into action.
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Protecting your computer from viruses in macros

Files made with these Microsoft Office pro-
grams can contain viruses: Access, Excel,
PowerPoint, and Word. They can contain
viruses because they are capable of running
macros. A macrois a set of command instruc-
tions recorded under one name. When you exe-
cute a macro, the program carries out the
instructions. Macros are written in Visual
Basic, a computer language. As such, they can
contain viruses.

To protect your computer from macro viruses in
Access, Excel, PowerPoint, and Word files, you
can tell your computer to run macros only if the
file to which they belong originated with a
trusted source. If you try to run a macro from an
untrusted source, either the macro doesn‘t run
or you are warned beforehand that the macro
may contain a virus.

Follow these steps in Access, Excel, PowerPoint,
or Word to tell the program how to handle the
virus-macro problem:

1. Choose Tools=>Options.
The Options dialog box opens.

2. Select the Security tah.

3. Click the Macro Security button.
You see the Security dialog box.

4. Choose a security setting — Very High,
High, Medium, or Low.

. Click the OK button in the Security dialog

box.
. Click the OK button in the Options dialog
hox.

With the Very High and High settings, only
macros from files containing a digital sig-
nature can be run. Choose the Medium set-
ting to display a warning whenever you run
amacro. Choose the Low setting if you trust
your antivirus software to detect viruses in
all macros. With the Low rating, all macros
are run without a warning.

To disable all macros, select the Trusted
Publishers tab and deselect the Trust All
Installed Add-Ins and Templates check box.

Security 2[*]

Trusted Publishers

(&) ery High. Orly macros installed in trusted locations wil be Slowed
ta run. All other signed and unsigned macros are disabled,

2 High, Only skaned macros From trusted sources wil be allowed to
run. Unsigned macros are autamatically dsabled,

{0 Medium. You can choose whether or not to ron patentialy unsafe
macros.,

) Lowe irt recommended), You are not protected from potentially
unsafe macros, Use this sstting only § you have virus scanning
software installed, or you have checked the safety of al documenits
Yo open.

Wirus scanner(s) instalied.

OK ] l Cancel

Other viruses appropriate e-mail addresses from the receiver’s address book
and send e-mail with infected files to those addresses. Still others take
advantage of the intimate relationships between computers on the same net-
work to spread from computer to computer.

Looking at antivirus software

I know what you’re thinking: “I'm already shelling out $10 to $40 a month for
an Internet connection with an ISP. Do [ have to shell out another $40 to $80
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a year for antivirus software?” The answer is “Yes.” Antivirus software is a
bit like car insurance. You may not need it, but if you get in an accident,
you're very glad you have it. Figure 4-1 shows an antivirus program called

Norton AntiVirus at work.

Every antivirus software program keeps up-to-date virus definitions. To see
whether files are infected on a computer, these programs scan the computer,

comparing their virus definitions against each file. If a match is found, it
means that the file is infected, and the file is cleaned of the virus. An
antivirus software worthy of the name should have these features:

4+ Disk scanning and cleaning: You can choose a disk drive on your com-
puter to be scanned for and cleaned of viruses. The software should tell
you whether any viruses were found and whether they were successfully

eradicated.

4+ Automatic updates: You can go on the Internet and download virus defi-
nitions into the software. This way, the software is always cognizant of
the latest viruses and can delete them from your computer. The software

should tell you when your virus definitions are out of date and need

updating.
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4 Scanning of incoming e-mail: Incoming e-mail messages with attached
files are scanned automatically for viruses. If a virus is found, it is
removed from the e-mail attachment. Some antivirus software also scans
outgoing e-mail to prevent viruses from spreading.

All the antivirus software listed in Table 4-2 meets these requirements. These
are the most popular and best-known antivirus software programs, and for
good reason. They are all reliable, easy to install, and easy to use. Table 4-3
lists free antivirus software programs. These programs can scan your hard
disk for viruses, but they don’t offer all the services you get when you pay
for antivirus software.

Table 4-2 Antivirus Software

Software Web Address Price  Notes

F-Secure Internet www.f-secure.com $80 Includes anti-spam and

Security spyware features. For
parents, comes with
Web-site—blocking tools.
No phone support.

McAfee Virus http://us.mcafee.com $40 Includes anti-spyware

Scan Home features. Phone support
costs extra.

Norton AntiVirus wWww.Symantec.com $50 No anti-spyware fea-
tures. No phone support.
Easy-to-use program.

Trend Micro PC-cillin ~ www.trendmicro.com $45 Includes a firewall and

Internet Security anti-spam and -spyware
features. Tech support
by phone is free.

Table 4-3 Free Antivirus Software

Software Web Address Notes

AntiVir Personal Edition www. free-av.com Does not scan incoming e-mail

Avast 4 Home Edition www.avast.com/eng/ Scans all e-mail services

avast_4_home.html

BitDefender Free Edition www.bitdefender.com  Does notscan e-mail

Another way to scan your hard drive for viruses without paying is to go to
Panda ActiveScan (www.pandasoftware.com/activescan). Access this
antivirus utility by way of your Web browser without downloading any soft-
ware. It works using ActiveX technology. McAfee, the antivirus software
maker, also offers free antivirus scanning from a Web site at this address:
http://us.mcafee.com/root/mfs. Because three’s the charm, Trend Micro
Housecall (http://housecall.trendmicro.com) also offers the service.
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Making Sure Your Copy of Windows Is Up to Date

One way to thwart hackers and viruses is to make sure that your copy of
Windows is up to date. As security holes are discovered in the Windows soft-
ware, Microsoft issues updates to Windows. These updates patch the secu-
rity holes. My copy of Windows has been patched so many times it’s starting

to resemble a ragamuffin, but that’s another story.

If you want, Microsoft can update your copy of Windows automatically. It
can also alert you when updates to its Windows software are available for
downloading from the Internet so that you can download them yourself.
You’ll know when an update is available because a balloon caption with
these words will appear in the notification area by the clock on your desk-
top: “Stay current with automatic updates/Click here to keep your computer
up-to-date automatically with downloads from Windows Update.” Clicking
the balloon takes you to a Web page where you can download a Windows

update patch.

Checking whether Windows is
up to date — and updating

To find out whether your copy of Windows is up to date and, if it’s not up to
date, how to update it, choose Start=>All Programs=>Windows Update (you
can find this command near the top of the All Programs menu).

Windows Service Pack 2

In October 2004, Microsoft issued an upgrade
to its Windows XP software called Service
Pack 2. The upgrade is designed to make
Windows XP computers less susceptible to
attacks from viruses and hackers. If you bought
your computer in or after October 2004, you
probably don't need to concern yourself with
Service Pack 2, because your Windows XP
software is up to date. But if your computer is
older than October 2004 and it runs Windows
XP, you owe it to yourself to load the Service
Pack 2 software on your computer.

Unfortunately, at 50-250MB, depending on how
much updating your software needs, Service
Pack 2 is a big chunk of software code.

Downloading and installing it on my computer
took two hours, and | have a fast Internet con-
nection. You can follow the instructions
“Checking whether Windows is up to date —
and updating,” earlier in this chapter, to find out
whether Service Pack 2 is installed on your
computer, and download the software if need
be. If yours is a slow Internet connection and
you don’t have the patience to wait all day
while Service Pack 2 downloads, you can ask
Microsoft to send the software to you on a CD
by going to this Web address:

www.microsoft.com/windowsxp/
downloads/updates/sp2/cd
order/en_us/default.mspx




Figure 4-2:
Is your copy
of Windows
up to date?
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Your Web browser opens a page at microsoft.com. The page tells you
whether your copy of windows needs updating and instructs you how to
download the latest updates, as shown in Figure 4-2.

Choosing how to update your copy of Windows

When it comes to updating your copy of Windows, you have the choice of
updating automatically, updating when you give the order, or not updating
automatically. If you opt for automatic updates, your computer queries
Microsoft when you are online to find out whether any Windows updates are
available. To tell your computer when and how to update your copy of
Windows, follow these steps:

1. Choose Start~>Control Panel.
The Control Panel window opens.

2. Click the Security Center link.

The Windows Security Center window appears (as long as Service Pack
2 is installed). This window tells you whether a firewall is installed and
working on your computer, whether you are updating your copy of
Windows automatically, and whether your computer is protected from

viruses.
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Horme wWindows Family | Windows Catalog | Office Family
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[ Settings sCans your computer to see what updates are required and

provides you with a list of updates tailared just for you. Fick a time to install updates.

[ Administrator options J) Hews

Windows XP RTM -
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questions download, and install only the critical and security
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Sanice Pack 27
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Yaur Computer
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Figure 4-3:
Choosing
how to
update
Windows.

3. Click the Automatic Updates link.

Making Sure Your Copy of Windows Is Up to Date

You can find this link at the bottom of the window. You see the
Automatic Updates tab of the Automatic Updates dialog box, as shown

in Figure 4-3.
4. Choose an Update option:

¢ Automatic: Update files are sent to your computer and installed
automatically. You can schedule updates in the drop-down menus. If
your computer is turned off at the scheduled time, the update files
are downloaded at the next opportunity when you connect to the

Internet.

¢ Download Updates for Me: Updates are downloaded in the back-
ground without your noticing. To inform you that update files have
arrived, the balloon caption and the Windows Update icon appear in
the notification area. Click the icon or the caption to install the

updates.

¢ Notify Me but Don’t Automatically Download: If updates are avail-
able, the balloon caption and the Windows Update icon appear in the
notification area. Click either one to go on the Internet and download
the updates and install them on your computer.

Windows Security Center

Automatic Updates

{Turning on Automatic Updates mey astomatically update Windows Update
software first, bef thy dates.)

(%) Automatic {recommended)

Automaticaly download recarmended updates For my
computer and install them:

Every day v] ot [z0oam (v

() Download updates for me, but ket me choose when ko install them.
() MokiFy me but don't automaticaly download or instal ther,

() Tuen off Automatic Updates.
‘faur computer wil be more sulnerable unless you Instal
updates reqularly,

Install updates fram the Windows

‘Windows can regularly check fior important updates and install them For you,

@ Security Center
Help protect your PC

Windows securiby ssthings. To help protect your comrguter, make sure the
. IF the settings are nok ON, folow the recommendations. To return o the
el

my computer?
© 0N |
3 © 0N %
@ ON | =

to date and vinus scanning is on. Antivirus seftware helos probect your
ecurity threats, How does anbivirus software help probeck my compuber?

re that Windows can monitor, Click Recommendations to find out how,

Manage security settings for:

'ﬁ Automatic Updates 9 Internet Options e Windows Firewall
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e Turn Off Automatic Updates: You are not notified or given the Book I
opportunity to download update files. Choose this option if you want Chapter 4
to update your copy of Windows on your own (see the previous sec-
tion in this chapter).

5. Click the OK button.
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Protecting Your Computer with a Firewall

In the real world, a firewall is a wall between buildings that is designed to
prevent a fire from spreading from one building to the next. A computer fire-
wall does much the same thing — only digitally. A firewall is a software pro-
gram or hardware device that serves as a gateway between a computer and
the Internet. The firewall scans data as it arrives from the Internet and slams
the door on unwanted intruders. To be specific, a firewall blocks ports on
your computer to certain kinds of data. For example, data from certain
domains and IP addresses may be blocked. A firewall may block data
requests made using the Telnet or ftp protocol because those protocols can
be used to commandeer others’ computers. In short, a firewall protects a
computer from unauthorized access and virus threats. It also hides a com-
puter’s IP address so that hackers can’t target a computer.

Not so long ago, firewalls were deemed necessary only for computers con-
nected to a company network, but because security threats from the Internet
are on the rise and because people with DSL and cable-modem connections
stay online for hours at a time, the current thinking is that all computers
should be protected by a firewall. Microsoft as much as acknowledged how
necessary firewalls have become when it began including a firewall with its
Windows XP operating system software. If you have a copy of Windows XP
issued after October 2004 or if you installed Service Pack 2, a firewall is
already installed on your computer (see the sidebar “Windows Service

Pack 27).

Want to test how strong your firewall is and whether your computer is sus-
ceptible to threats from the Internet? Take the Shields UP! test at the follow-
ing address. The test looks at your computer’s service ports and file-sharing
vulnerabilities, among other things. (Notice in this Web address the letters
https, not http. The s indicates that you are on a secure Web site.)

https://www.grc.com/x/ne.d11?2bh0bkyd2

A look at third-party firewalls
The firewall that comes with Windows XP is not the best, but it is more than

adequate if you use it along with antivirus software. The Windows XP firewall
doesn’t scan outgoing files sent over the Internet for viruses. Some firewalls
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do that to keep viruses from spreading. It also doesn’t offer spoofing protec-
tion to keep hackers from commandeering your computer. Table 4-4 describes
some firewalls that are worth looking into if your computer doesn’t already
have a firewall.

Table 4-4 Firewalls

Firewall Software Web Address Notes Price
Kerio Personal www.kerio.com/us/ Very configurable soft-  $45
Firewall kpf_home.html ware; not for novices.

Outpost Firewall www.agnitum.com Blocks cookies and $30

conceals your surfing
history, among other

features.
Sygate Personal http://smb.sygate. Very customizable $48
Firewall com/products/spf_ with a friendly
standard.htm interface.
ZoneAlarm www.zonelabs.com Can quarantine e-mail. $70

Turning the Windows XP firewall on or off

Sometimes it’s necessary to turn the Windows XP firewall off for a minute or
turn it off altogether. Sometimes you have to turn the firewall off temporarily
to upload Web-site pages to a Web server. Sometimes you have to turn it off
permanently in favor of using a different firewall. Follow these steps to turn
the Windows XP firewall on or off:

1. Choose Start>Control Panel to open the Control Panel window.
2. Click the Network and Internet Connections link.

If you don’t see this link, switch to Category View in the Control Panel.
3. Click the Windows Firewall link.

The Windows Firewall dialog box appears.

4. On the General tab, select the On or Off option button to turn the fire-
wall on or off.

5. Click the OK button to close the dialog box.

Some software programs have to breach the firewall to go on the Internet
and do what they’re supposed to do. When that is the case, you see a
Windows Security Alert dialog box like the one shown on the right side of
Figure 4-4. Click the Unblock button to open a port on your computer so that



Figure 4-4:
Clicking the
Unblock
button
exempts a
program so
thatit can
bypass the
firewall.
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What to Do about Spyware and Adware

the program can go on the Internet. Programs that you unblock this way are
added to an Exceptions list, a list of programs that can disregard the firewall,
as shown on the left side of Figure 4-4. To remove a program from the
Exceptions list, go to the Exceptions tab of the Windows Firewall dialog box,
select the program, and click the Delete button. The step-by-step instruc-
tions previous to this paragraph explain how to open the Windows Firewall
dialog box.

& Windows Firewall =]

| General | Exceplions | Advanced | [ Windows Security Alert (%]
‘windaws Firewal is bBlocking incaming netwark col
progiams and serdces selected belov. Adding ex

o work better but might increase your security risk,

B 1o help protect your computer, Windows Firewall has blocked
some features of this program.

Programs and Services

Name ﬂ Mame:  iTunes

110 Appication :
] Interrist Esplarer “=  Publizher: Apple Compaiter, Inc,

Do you want to keep blocking thiz program?

[ k.azaa Media Deskiop

mlRC

MSH Messenger 6.2

[¥] Remocte Assistance

[ Remcte Desktop

] Shareaza Ultinate File Shaing
[ Skype

[I1IPeP Frameini

Keep Blacking Unbiock [ sk Me Later
| J [ J

“windows Firewall has bBlacked this program from sccepling connections rom the
Intesret ar & netwark If pou b i pracram of lrust the publzher, you can
unblock it When should | inb tam

[ addPrgam, | [ AddPat. |[  Edt. ||  Deee

[] Diisplay & potilication when Wwindows Firewal blocks a progiam

What to Do about Spyware and Adware

According to the National Cyber Security Alliance, eight of ten computers
are infected with spyware and adware. Spyware is a kind of software that is
installed surreptitiously on a computer. It gathers information about the
computer’s owner without his or her knowledge. Some spyware programs
can obtain personal information and send it to marketers or, worse, identity
thieves. Adware is a variety of spyware. It, too, is installed without anyone
knowing. Adware programs gather information about a user’s browsing
habits and send it to marketers. Adware programs display pop-up advertise-
ments in the browser window tailored to the user’s tastes and browsing
patterns.

These programs are a nuisance at best and a menace at worst. Spyware pro-
grams called keyloggers can record keystrokes, including 16-digit credit card

Book |
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numbers and eight-digit Social Security numbers, and send them to a remote
computer. Spyware slows computers. To use the terminology of the people
who monitor spyware, spyware has a large “clot factor” — it loads down the
computer with unnecessary folders and registry entries. Spyware can turn
an adventure on the Internet into a frustrating misadventure of pop-up
windows and screaming advertisements. Does this sound familiar? If your
computer is anything close to typical, it is already infected with spyware.
The first time I ran Webroot Spy Sweeper, my anti-spyware program of
choice, I discovered 17 spyware programs on my computer.

Spyware finds its way onto computers on the back of shareware programs
and file-sharing programs. The most notorious example of spyware piggy-
backing on another program was Kazaa, a program for sharing MP3 files on
the Internet. Kazaa was a sort of Typhoid Mary of the World Wide Web.
According to its manufacturer, 214 million computers downloaded Kazaa.
And every single one of them ran a bit slower because of it.

The only way to remove spyware is to employ the services of an anti-
spyware program. Experts recommend using at least two anti-spyware pro-
grams because no single program can find and eradicate all varieties of
spyware. Table 4-5 describes the leading anti-spyware programs. These pro-
grams scan computer files, comparing the programs’ spyware definitions
against the files. When a match is found, the spyware is quarantined. Anti-
spyware programs give you the chance to examine the spyware before you
delete it. You can download the anti-spyware programs listed in Table 4-5 at
Cnet.com (www.cnet.com)and TUCOWS (www.tucows.com). Figure 4-5
shows the Webroot Spy Sweeper anti-spyware program at work.

Table 4-5 Anti-Spyware Programs
Program Web Address Notes Price
Ad-Aware http://www.lava  One of the first anti-spyware Free
SE Personal soft.de programs.
Edition
Spybot www.safer-net Removes cookies as well as spy- Free
Search working.org ware. Don't be put off by the unpro-
& Destroy fessional-looking interface — it
works well.

Spy- www.intermute. Tells you when spyware was $30
Subtract com/products/ installed and rates virulence of

spysubtract.html found spyware programs.
Webroot www.webroot.com  Besides removing spyware, prevents $30
Spy bookmarks from being added and
Sweeper the home page from being changed

without permission.
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Program Web Address Notes Price
Windows www.microsoft. Formerly Giant AntiSpyware, an Free
Anti- com/athome/ award-winning program; it was to
Spyware security/ purchased by Microsoft in Windows
spyware/software January 2005. users

& Spy Sweeper

éﬁ | sweep Now
iﬁ Remove

"j_:: Results
"““ Cuararkined
|0

g‘{; Shiekds
_’f‘j Cptlons

A\ e

) .#] Step 1: Sweep System

Spy Sweeper is performing
an in-depth examination of
your computer. Thorough
sweeps will ensure system
and data privacy.

Sweeping hard drives

Now inspecting...
cijwindows\system3zidicacheyowconn.di

Spyware Fingerprints Loaded: 'ﬁ
Memory Items Inspected: '1—.2‘30
Registry Items Inspected: 'm

Files/Folders Inspected: ’W

Spyware Found: 8

Traces Found: 307

op ] (" eane ]

Detected runring speware: TopSearch - topsearch.dl

Detected runring speware: Cpdoor Pesrto-Pesr Dependercy - od_clint.dll

Adware found: Alexa Toolbar
Adware found: CoolwebSeanch (CwS)
Adware found: CWS-AboutBlank

Do not, I repeat, do not buy anti-spyware programs on the recommendation
of pop-up advertisements in your Web browser. Ironically, some programs
that profess to be anti-spyware are themselves spyware!

Preventing ldentification Theft

Identification theft occurs when someone steals your credit card number,
PayPal account number, Social Security number, checking account number,
password to a Web site, or other valuable piece of information and pretends
to be you. The thief makes purchases in your name — purchases that show
up a month later on your credit card statement. Worse yet, the thief buys a
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Figure 4-6:
Phishing for
suckers on
the Internet.

Preventing ldentification Theft

cell phone or takes out a credit card or loan in your name. You can find your-
self in the difficult and slightly schizophrenic position of having to convince
creditors and the telephone company that you are you and not the person
who has been spending so lavishly in your name.

According to a Federal Trade Commission report, nearly 10 million
Americans were probably victims of some form of identification theft in
2003. Is the Internet making it easier for identification thieves to operate? No
question about it. The anonymity of the Internet makes it that much easier
for the thieves to pose as people and institutions they aren’t. A term has
even been coined for masquerading as someone else with fraudulent intent
on the Internet: phishing. Phishing means to fraudulently solicit credit card
information, identifications, usernames, and passwords by means of realis-
tic-looking Web pages or e-mail messages that appear to come from genuine
institutions. The word comes from the expression “going on a fishing expedi-
tion,” which means to vaguely and unhurriedly look into others’ affairs with
the hope of finding something damaging.

Figure 4-6 shows an example of phishing. This e-mail message appears to
have come from a real bank, but it’s a sham. If you click the link in the mes-
sage, you go to a Web page with all the official trappings of the bank, where
you are asked to enter your bank account numbers and other personal infor-
mation. The Address bar on the Web page even appears to show the bank’s
Web address, but the real Address bar is hidden, something that can be done
with the Java computer language.

=1 Washington Mutual: urgent security notification for clients == =]
File Edit VMiew Tools HMessage Help il';"
From: ‘washingbon Motual

Date: ‘Wednesday, December 01, 2004 11:55 PM
To: WEWANSOG2S@SBCELOBAL. NET
Subject: Washington Mutual: urgent security notFication For chents

Technical services of the Bank are carrying out a planned software upgrade.
We earnesily ask you to visit the following link to start the procedure of
confirmation of customers' data

hittp: ffweerw wamu.com/pers onal/welcom e/confirmusersdata. htm

This instruction has been sent to all bank customers and is obligatory to follow.

Thank you for co-operating

Customers support service.
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Phishers are good at creating the illusion that they are real. They dress up
Web pages with all the tell-tale signs — the logos and graphics — of the insti-
tution that they are pretending to represent. A false request for usernames
and passwords appears to have really come from eBay, for example, because
it is dressed in the eBay colors. A request for Social Security numbers is
accompanied by the American flag and appears to have really come from the
United States government. Even the return address looks real. But faking an
e-mail address, or e-mail spoofing, is just part of the illusion.

No legitimate institution will ever solicit personal information or ask you to
update your account by e-mail. Nor will they ask you to enter personal infor-
mation online, except for the first time you provide the information. Except
for the first time, any attempt to get personal information from you is fraudu-
lent. You can do everyone a favor by reporting these solicitations to the
institution that the phishers are pretending to represent.

The Anti-Phishing Working Group maintains an archive of phishing examples
at this Web address: www.antiphishing.org/phishing_archive.htm.
Take a look at some of these examples to see just how sophisticated phish-

ers can be.
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Chapter 5: Using America Online

In This Chapter

v~ Installing and signing on to AOL

+ Reading e-mail and receiving files

v Organizing and storing e-mail messages
v Sending e-mail and files

1 Tracking addresses in the Address Book
v Surfing the Internet with AOL

A merica Online (AOL) is an online service for surfing the Internet, send-
ing and receiving e-mail, storing addresses, and doing a few other
things besides. As of this writing, the cost of the service is $24 per month
(AOL usually offers free service for the first month or two). If you bought
your computer at a big-time electronics store, it probably comes with the
AOL icon on the desktop. Having that icon doesn’t mean that you have to
subscribe to AOL, but lots of people do. AOL has many fans and many
detractors. In general, people who fall on the novice side of computing
favor AOL over the hardier, more sophisticated programs for handling the
Internet because AOL is easy to use. Starting from one place, you can surf
the Internet and trade e-mail messages. AOL’s keywords (you find out more
about them shortly) make it possible to visit Web sites without having to
enter cumbersome Web-site addresses. This chapter explains how to handle
e-mail and surf the Internet with America Online.

Installing AOL

If AOL isn’t installed on your computer, you can either install it from a CD
or download the program from this address on the Internet: www.aol.com.
As part of the installation, you are asked for a screen name and a password.
You need this name and password each time you log on to AOL.

If you have trouble with the installation or trouble connecting to the Internet
with AOL, call 800-827-6364. If you get frustrated and want to cancel the serv-
ice, call 888-265-8008. You can find out more about AOL’s cancellation policy
by entering Cancel in the Keyword dialog box.
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Signing on to AOL

Signing on to AOL

You must sign on to AOL each time you run the program. To sign on, either
double-click the America Online icon on your desktop or choose Starte>
Programs=>America Onlinec>America Online. You see the Sign On window
shown in Figure 5-1. Choose your screen name if you have more than one,
enter your password, and click the Sign On button.

#. America Online!

Get Help
Screen Name: | Thms j
L . = |
F e W s [ W Save Password Forgat Pessword?
J'\.'\’\ER',CA PTIMIZED) - e
{7 9 Location: | Home D5L L]
m—
[siononoptions | [ sion onagain |
WOW! Special Holiday Offer? Send Voice Messages to Your Loved Ones inthe
. Miltary Overzeasz... Fras!
m Shop Simple, Shop Smart: Shop Online 1or the Holidenys
F_ 5-1 Store At A0L Keyword: inStore
I.QUI-'e i Try This! The ABCs of AOL: Try ACL From &10 Z, a Ditectory of Fasluras & Services
Signing on
to AOL. You have spera | minuz oriine.  our pricing plan this biling cyele s for unlmined uss.

Changing and deleting passwords

and screen names

AOL makes it easy to change and delete screen
names and passwords. (Who doesn't need
another Internet personality now and then?)
AOL permits you to have as many as seven dif-
ferent screen names. Follow these steps to
manage passwords and screen names:

1. Press Ctrl+K or click the Keyword button
on the Quick Start toolbar.

The Keyword dialog box appears.

2. Enter this keyword: screen names.
3. Click the Go button.

A dialog box for changing and deleting
passwords and screen names appears.

4. Click the appropriate link, and answer the
questions in the dialog boxes as they
appear.

Don’t worry — this is real simple stuff.
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A Short Geography Lesson

When you start AOL, you see a window screen like the one in Figure 5-2.
wager that the menu bar and row of buttons along the top of the screen are
not foreign to you — they are found in lots of computer programs. From left
to right, here are the things that may make the AOL screen seem unusual:

Quick Start window

Next and Previous

%, Ameriea Online provided by Dells [BEE]

Large Man
Has Big Score

T City's Best Viote ‘o5
Lingnen Fumkdes 1o Fare 0 0 Weekender Newsletter
“ole tar Top Play | KFL Becaps  SF Bay CltyGuide
Wiho Was Left Out?
Mmlchups S for Top Ecwi:

sk
[

Parenting 1
Perscna Asane
Real Estate

Meors From ADL Sports
* IFL Ster Banned for Si=roids?

» e Gtasl Pl 1o Sl Ralbas
* Colege Wi Stobbedin (snuts

Taps Mhewas Attackers HE LS Coreadan

Privin Baes Lo in S0%, 02

iy Liet P | - Get “Cioser”
St B G " [k 3 Co-Sras

) A X = |Ciscuss Ther
inStare oV = 3 |y P L

Figure 5-2:
The AOL tg’mﬁ?—'ﬂ.“. hve us your fuadhaiki = aRABRNAJUTY
screen. .
i 4 Quick Start window: This window is designed to help you do things
Quick Sart

quickly. It includes buttons that are found elsewhere in the AOL window.
Click its Close button if you don’t care to see it. To display the window
after you have closed it, click the Quick Start button.

4+ Next and Previous buttons: Click these buttons to retreat to or go for-
ward to windows either in AOL or on the Internet that you have visited
recently.

visit a Web site. You can click the down arrow and select a site from the
drop-down list to revisit a site you visited recently.

E 4 Web Address box: Enter a Web address here and click the Go button to
]
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B search

4 Search button: Click the Search button to open a new window and
search the Internet.

4+ Favorites: Click the Favorites button (or its drop-down arrow) to visit a

\\3

site you bookmarked because you wanted to visit it again.

When you signed up with AOL, you chose a Toolset and Line Up for the
Welcome screen that appears when you start AOL. If you would like to
rethink those choices, click the Change This Screen link in the lower-left
corner of the Welcome screen. You are presented with a series of dialog
boxes for constructing a Welcome screen.

Handling Incoming E-Mail

Cim

Figure 5-3:
Collecting
the mail.

Benjamin Franklin was wrong. He said that nothing is certain except death
and taxes. What is just as certain as those inevitabilities is this: Anyone who
has an e-mail account will receive ever-increasing amounts of e-mail. Besides
reading this mail, the person must devise strategies for sorting and organiz-
ing it. These topics are covered in the pages that follow.

Reading incoming mail

When someone sends you e-mail, you hear the words “You've got mail” and
a flag rises on the Read button in the upper-left corner of the screen. The
number beside this button tells you how many messages are waiting to be
read. By moving the pointer over the Read button, you can see a drop-down
list with senders’ names and message topics. To open your Mailbox and read
the mail, click the Read button. You see a Mailbox window similar to the one
in Figure 5-3.

1% ThmsW Mailbox G

i BN
€5 Mailbox _ _ (i opvions v ([Fiokr ]

Show me mall from: (Fecryonc L uulcu—lna:l

liﬂmm‘grp] Eoom Confrals  Recondly Dalabed Mol

| Find it Fast an AQL O Holier dage O Becacrld O Cogy Boddie O D P B ool Tors: B ¥ilerindbgr |

T e REFINANCE BEFORE RATES GO UP!

bl AOL USERS, CLICK HERE OR CALL NOW: l{",",},iﬁ'%’f}f

- 1zlagal 1-B00-822-8927
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Here are instructions for reading your mail: Book |
Chapter 5
+ Reading a message: Double-click a message or select it and click the

Read button to open it. The message appears in the Message window,
as shown in Figure 5-4. After you open a message, it is moved to the Old
tab. You can read it by opening the Old tab and double-clicking it there.
(Click the Keep As New button to move a message from the Old tab back
to the New tab.)

auljug
eauawy buisn

#: Sony translation test

Reminder: AGL wil never ask you for your password or biling information

Subject: Sony translation teat

Date: 120202004 7:20:34 PM Pacific Standard Time
From:  Junichs Keffiblickyo com

To: Thms\Weviliaol.com

Sent from the intermst (Dsfils)

Weverka-san,
TEFE NADINETARSZBRLE, VI-DOTANTT,

EALTERHEELVILEXT— 32207, ZBIVEEFhES
WY,

6 (A) RICHEY LTV,
Job No. 9939904000002

Figure 5-4: 3
Reading [ 000K] (2518 |
the mall [ Download ¥ | [Keep Az Hew | [ Delete | "{J Prev  230f27  MNext [/

4+ Deleting a message: Click the Delete button to remove a message.
Messages you delete are sent to the Recently Deleted folder. To recover
a message, open the Recently Deleted folder, select the message, and
click the Restore button. To open the Recently Deleted folder, open the
Manage Mail tab and select the folder in the My Mail Folder list.
¥ To find a stray message in the Mailbox window, enter a word you remember
from the message’s title or text in the Quick Find box (refer to Figure 5-3) and
press Enter.

Receiving a file

You can tell when someone has sent you a file because a little page appears
behind the standard message icon on the left side of the Mailbox window.
The name of the file appears at the bottom of the message window (refer to
Figure 5-4).
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4+ To download the file now, double-click its name, click Yes when AOL
asks whether you really want to download it, and select a folder for stor-
ing the file in the Download Manager dialog box.

4 To retrieve the file later, click the Download button and choose Download
Later. When you want to see the file, choose File>Download Manager.
You see the Download Manager window. Select the file you want to open
and click the Finish Download button. You can find the file in your
C:\My Documents folder.

Manaqmq your e-mai I

If you receive e-mail from many different parties, I strongly suggest creating
e-mail folders for storing your mail. That way, when you want to find a mes-
sage from someone, you will know where to find it. Herewith are instructions
for creating folders for e-mail and moving e-mail to different folders.

Creating a folder for storing e-mail
To create new folders for e-mail, start by selecting the Manage Mail tab in the

Mailbox window. On the left side of this tab is the My Mail Folders list, which
lists the folders where your e-mail is stored. Follow these steps to create a
new folder:
1. Click the Saved on My PC folder.
All new folders become subfolders of this folder.
2. Click the Setup Folders button and choose Create Folder.
You see the Create New Folder dialog box.

3. Enter a folder name and click the Save button.

Be sure to choose a descriptive name. The name of your new folder
appears under the Saved on My PC folder in the folders list.

Moving e-mail messages to different folders
Follow these steps to move an e-mail message to a different folder:

1. Select the e-mail message.

2. Click the Save button and move the pointer over On My PC on the
drop-down list.

You see a list of folders.

3. Select the folder you want to move the e-mail to.
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Composing and Sending E-Mail

In order to get invited to parties, you have to issue a few invitations. And in

Figure 5-5:
Composing
an e-mail
message.

order to get e-mail, you have to send out e-mail. In this section, you find
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instructions for composing e-mail messages, replying to or forwarding mes-

sages, and sending files.

Writing an e-mail

Follow these steps to compose and send an e-mail message:

1. Click the Write button or press Ctrl+M.

You see the Write Mail window shown in Figure 5-5.

5. Wirite Mail FEx
Send Toulavarkai@sboglobal et Copy To ;@
Send Now
Subject; |—are = the file |
Hial =1 10=] (3] B2 (== €01 | (e (D) 20) [40(8) | sendlater
Petar 32 i
Address
Hera'z 11 iz | 1old you shou Bauk
Hobir =
2] Fimll® TIF (405 128,
[ AttachiFils | [ DetachFile | I flequest Teturn Recet [ Strell Chech | Sinatures ¥ |

2. In the Send To box, enter the address of the person who is to receive

the message.

If the address is on file in your Address Book, just type the first two or
three letters to see a list of e-mail addresses that begin with those two
or three letters. Choose a name from the list to enter the whole address.

To send the same e-mail to more than one person, press Enter to go to

the next line of the Send To box and enter another address there.

Enter an address in the Copy To box to send a copy of the message to

someone.

hd

4. Enter the body of the message in the text box.

In the Subject line, enter a descriptive subject for the message.

You can format the message by clicking the Bold or Underline button, for
example. However, only people with e-mail software capable of reading

HTML formats can see the formatting in your e-mail message.
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Chapter 5

auljug
eauawy buisn



64 Maintaining an Address Book

5. Click the Send Now button to send the message.

Or, to postpone sending it, click the Send Later button. You see the Send
Later dialog box. Click the Auto AOL button to schedule a time to send the
message. To send the message later on your own, click the Read button to
open the Mailbox window. Then click the Manage Mail tab and select the
Mail Waiting to Be Sent folder in the My Mail Folders list. Finally, select the
message and click the Send button.

Replying to and forwarding messages

Replying to and forwarding messages is a cinch. All you have to do is click
the Reply, Forward, or Reply All button in the Message window (refer to
Figure 5-4). Inmediately, a Write Mail window opens with the sender’s e-mail
address and subject line already entered. Write a reply or scribble a few
words at the top of the forwarded message and click the Send Now or Send
Later button.

Sending a file

Follow these steps to send a file to someone:
1. Address and compose the message as you normally would.
2. Click the Attach File button in the Write Mail window.

You can find this button in the lower-left corner of the window. You see
the Attached File(s) dialog box.

3. Select the file or files you want to send and click the Open button.
To select more than one file, Ctrl+click the files.

The name of the file or files you want to send appears at the bottom of
the Write Mail window. If you change your mind about sending a file,
select the file and click the Detach File button.

4. Click the Send Now or Send Later button.

Maintaining an Address Book

You can keep street addresses and phone numbers as well as e-mail
addresses in the AOL Address Book. Keeping e-mail addresses is worthwhile
because you don’t have to type an e-mail address to address an e-mail mes-
sage if the address is listed in the Address Book. AOL fills in addresses from
the book automatically.
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Create a group in the Address Book if you need
to send the same e-mail to several different
people at once. For example, if you're the cap-
tain of a softball team, you can compose and
address a message about upcoming games to
allteam members. This spares you the trouble of
composing a dozen or more e-mail messages.

Here are instructions for handling group
addresses:

v~ Starting a group: Click the Add Group
button in the Address Book window. You
see the Manage Group dialog box. Enter a
name for your group. In the Contacts List,
Ctrl+click to select the names of people you
need for the group. Then click the Add
button and click the Save button.

Sending e-mails to groups

v~ Changing around the group members: In
the Address Book, group names are shown
in boldface text. To change around a group,
select its name and click the Edit button.
You see the Manage Group dialog box.
Select names and click the Add or Remove
button to change around the group.

Sending an e-mail to the group’s members:
Select the group in the Address Book, click
the Send To button, and choose a sending
option on the drop-down list. The Write
Mail window appears with the addresses
of the group members already entered.

Deleting a group: Select the group’s name
and click the Delete button.

Choose Mail=>Address Book to open the Address Book. Here are instructions
for doing this, that, and the other thing with addresses:

4+ Entering a new address: Click the Add button. You see the Address Card
for New Contact dialog box shown in Figure 5-6. Fill in the pertinent
information on the different tabs and click the Save button.

#. New Contact

(55 Address Card for New Contact (Lo ]
First Name: Last Name: |Banbenca Uncstegarize |
Contact Home Work Detail
Primary
E-Mail
Screen Hame: | | [
Other E-Mait: | | o
Other E-Mait: | | ©
__ Phone: | Home: =] [wiore ]
oo [ I L —
Entering an [ —
address in
the Address J
BOOk E Cancel
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Exploring the Internet in AOL

4+ Changing address information: Select a name and click the Edit button.

You see the Address Card for New Contact dialog box. Change the infor-
mation there and click the Save button.

4 Deleting an entry: Select a name and click the Delete button.

Exploring the Internet in AOL

As well as conventional ways to search the Internet, AOL offers keywords.
Instead of typing an unwieldy Web-site address, you can enter a keyword.
As long as that keyword corresponds to one of AOL’s channels, you go to
an AOL channel, a Web site with many links to the subject in question. For
example, entering the keyword autos takes you to an AOL-maintained Web
site with links to many sites that concern cars.

Exploring the Internet by keyword isn’t the big deal it used to be. The Internet
is much easier to search and navigate than it was when AOL invented its key-

word scheme. AOL subscribers can use Internet Explorer or Mozilla to search
the Internet. | recommend doing just that. Those browsers are much easier to
use than AOL’s, in my opinion.

You, of course, are entitled to your opinion, and to that end, here are instruc-
tions for exploring the Internet with AOL:

4+ Entering a keyword: On the Quick Start toolbar, enter the keyword in

the Keyword dialog box or type the keyword directly into the Web-site
address box. If the keyword is associated with an AOL channel, you go
to the AOL Web site. Choose Keyword=>Explore Keywords to see all the
AOL keywords.

Surfing the Internet: Enter an address in the Web-site address box and
click the Go button.

Searching: Click the Search button to go to an AOL-maintained site for

searching the Internet. (This site is by no means the best place to start
an Internet search. Conducting a search of the Internet is the subject of
Book II, Chapter 3.)

Bookmarking your favorite Web sites: When you come across a Web
site you want to revisit, bookmark it. Click the Favorites button and, in
the Favorite Places dialog box, choose Add to Favorites=>Favorite
Places. Next time you want to visit the Web site, click the Favorites
button and choose the Web site’s name in the Favorites window.

Don’t forget to click the Previous or Next button to go backward or forward
through Web sites you have visited.



Chapter 6: Getting the Plug-Ins
You Need

In This Chapter

v+~ Finding out what plug-ins are

v+ Choosing which plug-in plays by default
v+~ Examining the different plug-ins

Fis brief chapter describes companion programs called plug-ins that
you need to watch videos, hear audio, and read PDF files on the
Internet. First you find out precisely what a plug-in is. Then you discover
how to decide which plug-in is launched by default, and you take a close
look at all the plug-ins.

Introducing Plug-Ins

A plug-in is a companion program to a Web browser that handles files that

a Web browser can’t handle. To make the most of the Internet — to play
videos or listen to Internet radio — you need the right plug-ins. For exam-
ple, the Internet Explorer Web browser can’t play videos on its own. When
you see a video on a Web page and you click to play it, it doesn’t play unless
Windows Media Player, QuickTime Player, or another plug-in capable of
playing video is installed on your computer.

Table 6-1 lists plug-ins and tells you where to go on the Internet to get informa-
tion about each one. I describe these plug-ins throughout this chapter. With
the exception of the Office programs, you can download the plug-ins in Table
6-1 by going to the Web sites listed in the table or by going to these Web sites:
Cnet (www.cnet.com) or TUCOWS (www.tucows.com). All programs in the
table except the Office programs are free, although many offer upgraded ver-
sions with more features that you can purchase for real green cash.
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Table 6-1 Plug-Ins

Plug-In Opens/Plays These Files Web Address
Audio

RealPlayer .ra,.ram, .rm www.real.com

Flash Animations

Flash Player .swf www.macromedia.com/
software/flash

Microsoft Office Programs

Excel, Power- .doc (Word), .ppt http://office.
Point, Word (PowerPoint), . rtf (Rich microsoft.com
Text Format),. x1s (Excel)

Portable Document Files

Acrobat Reader .pdf www.adobe.com/
products/acrobat/
readermain.html

Video and Audio

QuickTime Player .mov, .mp4 www.apple.com/quicktime

Windows Media .avi,.MP3, www.microsoft.com/

Player .mpeg, .wmv windows/windowsmedia

A Roster of Plug-In Programs

You can’t tell who the players are without reading the roster. These pages
describe a roster of plug-in programs — Acrobat Reader, Flash Player,
Microsoft Office programs, QuickTime Player, RealPlayer, and Windows
Media Player. You also find out how to decide which plug-in gets launched
automatically when you encounter a certain kind of file on the Internet.

Acrobat Reader

Acrobat Reader is a program for displaying portable document files, better
known as PDF files. As shown in Figure 6-1, Acrobat Reader opens inside
your Web-browser window when you open a PDF file on the Internet. PDF
files are often meant to be printed. Many are Internet versions of brochures
and other publications. Search engines read, index, and catalog PDF files as
they do Web pages. Google even has a command for searching for PDF files.
On the Google Advanced Search page (www.google.com/advanced_
search), choose Adobe Acrobat PDF (.pdf) on the File Format drop-down
menu. Go to this Web address to read about Acrobat Reader and download
the program: www.adobe.com/products/acrobat/readermain.html.



Figure 6-1:
A PDFfile
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Reader.
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PDF files can be unwieldy and hard to read, but you can take advantage of
these Acrobat Reader tools to making reading the files a little easier:

4+ Going from page to page: Click the Next Page or Previous Page button,
use the scroll bar, or click the Hand Tool button and drag on-screen.

4 Zooming in and out: Click the Zoom Out button, use the Zoom In or
Zoom Out tool, or enter a percentage in the Zoom text box to shrink or

enlarge the text.

4+ Finding text: Click the Find button, enter a word or words in the Acrobat
Find dialog box, and click the Find button. Click the Find Again button to
search for the next instance of the thing you're looking for.

Copying text from a PDF file can be frustrating. You can click the Text Select
tool and drag over the document, but you can only select blocks of text this
way. It isn’t possible to select one sentence, for example, or a paragraph.
Selecting text in a single column is very frustrating because you have to
select adjoining text in the other columns as well. If you are in the unenvi-
able position of often having to copy text from PDF files to Word files, check
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out these programs, which make doing that considerably easier: Solid
Converter PDF to Word (www.solidpdf.com) and PDF Converter (www.scan
soft.com/pdfconverter).

To convert a Word file to PDF file, try pdf995. You can learn about and down-
load the program at this Web address: http://pdf995. com. OpenOffice, a
free alternative to the Microsoft Office programs, can also convert a Word
file to a PDF file. Go to this Web address to look into OpenOffice: www.open
office.org.

Flash Player

You need Flash Player to play . swf (pronounced “swiff”) Flash animations.
These animations are lot of fun to watch, which makes Flash Player worth
having. You can read about Flash Player and download the program at this
Web address: www.macromedia.com/software/flash.

[ keep seeing more and more Flash animations on the Internet, although,
unfortunately, some of them are advertisements. Check out this Web site for
some creative examples of Flash animations: www.albinoblacksheep.com/
flash. This Japanese Flash animation shows how extraordinary Flash ani-
mations can be: http://yoga.at.infoseek.co.jp/flash/kikkomaso.
swf. You can also find some neat Flash animations at Angry Alien Product-
ions at this Web address: www.angryalien.com. Be sure to check out

the 30-second reenactments of popular movies acted out by bunnies.

Some people believe that Flash animations are a security risk to computers
because Flash animations are displayed in Internet Explorer using ActiveX
controls. ActiveX controls allow programs to interact with the Windows
operating system, exposing Windows to security threats. You can disable the
Flash Player in Internet Explorer by following these steps:

1. Choose Tools=>Manage Add-Ons.

The Manage Add-Ons dialog box appears, as shown in Figure 6-2. It lists
add-on programs installed on your computer.

2. Find Shockwave Flash Object on the list and select it.
3. Under Settings, select the Disable option button.
A message box tells you to exit and restart Internet Explorer.
4. Click the OK button in the message box and close Internet Explorer.
You can tell when you need an add-on or plug-in to view a Web page in

Internet Explorer because the Manage Add-Ons icon appears on the status
bar. You can double-click this icon to open the Manage Add-Ons dialog box.
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dialog box.
Microsoft Office Programs
Microsoft Excel, PowerPoint, and Word files can be loaded on a Web site
along with standard HTML files. Occasionally you run into one of these files,
and to open it, you need Excel, PowerPoint, or Word. These programs are
part of the Microsoft Office Suite.

P By running an advanced search at Google (www.google.com/advanced_

search), you can search for Excel, PowerPoint, and Word files. Open the
File Format drop-down menu and choose Microsoft Excel (. x1s), Microsoft
PowerPoint (. ppt), or Microsoft Word (. doc).

OuickTime Player

QuickTime Player was originally invented for Macintosh computers. Apple
came out with a version of QuickTime Player for Windows PCs in 1998.
Nevertheless, QuickTime Player retains its association with Macintoshes. It
is the only media player that can play .mov (movie) files, the video file stan-
dard created by Macintosh for its computers. QuickTime Player software has
been folded into iTunes, the program for playing music files (see Book VIII,
Chapter 4). QuickTime Player can play MP4 audio files. You can read about it
as this address: www.apple.com/quicktime.It is shown in Figure 6-3.
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RealPlayer

RealPlayer, shown in Figure 6-4, has reinvented itself in recent years as multi-
purpose media player. You can play MP3 and .wav audio files, as well as
.mpeg and . avi video files, with RealPlayer, but [ wouldn’t bother. The only
reason to use this clunky piece of software is to download streaming audio
from the Internet. Occasionally you run across a RealAudio (.ra, .ram, or

. rm) streaming audio file that can only be played with RealPlayer — and
then you have to use the darn thing. You can visit the RealPlayer Web site at

this address: www.real.com.
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Selecting the default plug-in

Suppose you click a video or audio file on a
Web page but the wrong plug-in plays or opens
the file. Perhaps you want video to play by
default in Windows Media Player rather than
QuickTime Player or iTunes. You can be the
master of your fate. You can decide which plug-
in (or program) plays or opens which kind of file
by default. You can do that by following these
steps:

1. Choose Start->Settings=>Control Panel.

2. If necessary, click the Switch to Classic
View link and then double-click the Folder
Options icon.

You see the Folder Options dialog box.
3. Click the File Types tab.

You see a list of registered file types.
Windows recognizes all the files on the list.

4. Scroll down the list and select the type of

file you want to reassign.

In the bottom half of the dialog box, next to
the words “Opens With,” you can see
which plug-in or program automatically
opens the file you chose. When you have
finished reassigning the file, a new plug-in
or program name will appear beside the
words “Opens With.”

5. Click the Change button.

You see the Open With dialog box. It lists
the names of all plug-ins and programs
installed on your computer.

6. Select the name of the plug-in or program

with which you want to open files of the
type in question.

1. Click the OK button in the Open With

Windows has preconceived ideas about dialog box.
which plug-in or program to automaticall . . .
plug-in or prog Y 8. Click the OK button in the Folder Options
open these files in. .
dialog box.
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Windows Media Player

Windows Media Player comes with the Windows operating system. If your
computer is running Windows, I'll bet that Windows Media Player is on your
computer. The program can play movies and audio files as well as tune you
into online radio stations and burn CDs (see Book VIII, Chapter 3). To find
out more about Windows Media Player, go to this Web address: www .
microsoft.com/windows/windowsmedia.



Chapter 7: The Internet for Children
and Parents

In This Chapter

v Supervising children’s Internet use

v+ Comparing the filtering software programs

v+~ Trying out search engines designed for children
1 Assessing schools on the Internet

1+ Answering kids’ health questions

v+ Looking for colleges and college scholarships

Fis chapter explains how children and parents can get the most out of
the Internet and, in the case of children, do it safely. It looks at supervis-
ing children’s online time and describes how to safeguard children as they
explore the Internet. You look at filtering software programs that weed out
objectionable material and some search engines designed especially for chil-
dren. You find many helpful Web sites in this chapter — for parenting, choos-
ing kids’ schools, getting answers to health questions, doing your homework
online, and looking at colleges and obtaining college scholarships.

When you find Web sites that you believe are worthwhile for your children,
bookmark them. This way, you can return to the Web sites quickly and
easily. Book II, Chapter 1 explains bookmarking.

Supervising Kids on the Internet

As you know if you've spent any time on the Internet, it isn’t hard to run into
objectionable material. Gruesome pictures and Web sites that espouse vio-
lence are not hard to come by. You can trip over a pornographic Web site in
the course of an innocent Internet search. As a parent, how do you keep
your children from finding objectionable material on the Internet?

The only practical way to discourage them from finding this material is to go
online with them or, barring that, put your computer in a common room in
the house — the living room or family room — where you can keep an eye
on who is using your computer. This chapter explains a dozen different
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ways to steer children away from objectionable material on the Internet. You
can enlist software to screen out objectionable material. You can point your
children toward Web sites that are kid-friendly. You can employ computer
programs that monitor children’s online activity. But you must face the fact
that most children are more computer-savvy than their parents, and they
discover ways to get around your restrictions. This is why I believe in keep-
ing the computer in a common room and why I strongly recommend against
letting children have computers in their bedrooms. Besides, letting children
have computers in their bedrooms discourages them from playing with their
friends and developing the social skills they need for a rewarding life.

Talking to Children about the Internet

Talk to your children about the Internet. Tell them that it was invented for
adults but there are many fine things for kids on the Internet, too. Children
more than others object to following rules, so I leave it to your creativity to
find ways to establish these rules for your children’s Internet use without
making them sound like rules. You could call them suggestions. You could
call them good ideas. Here are some of these ideas:

4+ Don’t give others your name, age, phone number, or other personal
information on the Internet. If a questionnaire on the Internet asks for it,
don’t fill out the questionnaire.

4+ Understand that people who chat with you on the Internet may not be
who they say they are. Sometimes adults pose as kids and kids pose as
adults.

4+ Never meet someone in person whom you met online unless you are
with an adult.

4+ Don’t send your picture to anyone over the Internet unless the person is
a family friend or family member.

4+ If anyone you don’t know asks where you will be or what time you will
do something, don’t answer, and tell your parents about it.

4+ Don’t try to buy anything online unless your parents are sitting
beside you.

4+ If anything upsetting happens on the Internet, tell your parents about it.

After hearing you talk about these rules, if your child asks why adults are so
strange and why it’s necessary to exercise so much caution when dealing
with them over the Internet, just answer, “Someday you’ll grow up and you’ll
understand.”
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Looking at filtering and monitoring software

Filtering software, also known as blocking software, is software that keeps
inappropriate material from appearing in a Web-browser window. Monitoring
software tracks the Web sites that someone has visited on the Internet. Table
7-1 describes well-regarded filtering software. Some of the programs listed in
the table are monitors as well. As you use these programs or consider using
them, remember that no filtering software can block all objectionable con-
tent all the time. The best these programs can do is block most of it.

Table 7-1 Filtering Software Programs

Program Web Address Notes Price

Content Protect www.contentwatch.com/ Offers avariety of different ~ $30
products/content features and controls.
protect.php

Cyber Patrol www.cyberpatrol.com  Filters content but does not  $40
have monitoring capabilities.

Cybersitter www.cybersitter.com  Hasthe mostthorough $40
filtering capabilities; you
can block content in 32
categories.

iProtectYou www.softforyou.com Family members can be $35
assigned “intensity levels”
for filtering, with the highest
intensity blocking the most
Web sites.

Net Nanny www.netnanny.com Customizing the list of $40
blocked Web sites for differ-
ent family members is
difficult.

NetFilter Home www.enologic.com Rather than lists, uses $48
image and text analysis to
determine whether content
is objectionable.

Filtering software programs keep lists of Web sites with objectionable
material — you can update these lists over the Internet — and they bar chil-
dren from visiting Web sites on the list. You can configure these programs
for different family members so that older siblings have access to more

Web sites than younger ones. The programs let you choose whether to block
Web sites in different categories — sex, drugs, weapons, violence, extrem-
ism, and so on. Some programs can prevent children from visiting news-
groups and chat rooms. You can download trial versions of the programs
listed in Table 7-1 by going to Cnet.com (www.cnet.com).

Book |
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The Internet Filter Review (www.internetfilterreview.com) rates filter-
ing software programs. Go to the Web site to see a detailed chart that shows
what each program does and how it compares to the other programs.

By the way, on the subject of monitoring where users of a computer have
been on the Internet, you can monitor on your own without the use of moni-
toring software:

4+ The cookie trail: A cookie is a text file that Web sites deposit on your
computer when you visit them. By studying cookies, you can tell which
Web sites someone has been to. In Windows XP, cookies are located in
this folder: C: \Documents and Settings\Your Name\Cookies.In
versions of Windows prior to XP, they are found in this folder:
C:\Windows\Cookies.

4+ Temporary Internet files: When you visit a Web page, you download
its component parts — the HTML files, graphic files, and whatnot — to
your computer. In Windows XP, these files are kept in the C: \Documents
and Settings\Your Name\lLocal Settings\Temporary Internet
Files folder. In versions of Windows prior to XP, they are kept in the
C:\Windows\Temporary Internet Files folder.

Open these folders in Windows Explorer or My Computer to see where you
or someone else has been on the Internet.

Discovering search engines designed for children

A search engine is a tool for finding information on the Internet (Book II,
Chapter 3 explains how search engines work). Search engines designed for
children find Web sites that are suitable for children and useful to children.
They do that by searching only in prescribed lists of Web sites that have
been deemed kid-friendly. Table 7-2 lists search engines for children. Figure 7-1
shows the Yahooligans! Web site, a search engine for children.

Table 7-2 Search Engines for Children

Search Engine Web Address Description

Ask Jeeves For Kids ~ www.ajkids.com Instead of keywords, start your
search by putting it in the form of a
question.

Cool4Kids www.cool4dkids.com Search the directory with 18,000
links in 14 categories.

CyberSleuth Kids http://cybersleuth-  Search a directory of Web sites

kids.com suggested by teachers.
Fact Monster www.factmonster.com Searchthe directory or enter

keywords to conduct an Internet
search.
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Search Engine

Web Address

Description

Kids Net

www.kids.net.au

Search the children’s portion of the
Open Directory Project, the world’s
leading directory of Web sites, with
this search engine.

KidsClick!

www.kidsclick.org

Search a directory of 5,000 Web
sites hand-picked by librarians.

Yahooligans!

www.yahooligans.com

Yahoo!'s search engine is meant for
children age 7 to 12.
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P With a little tinkering, you can turn a standard search engine into a search

engine that is suitable (maybe) for children. To do so, click the Advanced
Search link and, on the Advanced Search page, look for a filtering option.
For example, Google offers an option called Filter Using SafeSearch
(www.google.com/advanced_search). Yahoo! has one called Filter Out
Adult Web Search Results (http://search.yahoo.com/search/options).
Searching this way, however, is no guarantee that objectionable material
won’t come up in a search.

Finding Parenting Help on the Internet

Parenting, the cliché goes, is the hardest job in the world. Actually, the hard-
est job in the world is parenting a teenager. (I'm only kidding. My teenage
children have been treating me very kindly except for Friday and Saturday

Book |
Chapter 7

sjualed
pue uaipjiyy
10§ Jauiaju ay |



80

Figure 7-2: R : Take

activities & fun  ages & stages behavior .th
Look for crafts, garmes, parties  toddlers, teens backsalk, snger, discinline e

: child health childca '

pa rentlng ear, fever, dental dayeare, sitters picky eatar, natriticn
adVIce at halidays kids & money  leaming

birthdays, hallawesn allowance, jobs kincargarten, addfadhd

now

Parent milestones potty training stepparenting

siblings sleep working mothers FIND

Finding Parenting Help on the Internet

nights, when they insist on staying awake long past my bedtime.) Here are
some Web sites for parents:

4+ Dr. Spock: For better or for worse, Dr. Benjamin Spock had more influ-
ence on raising the Baby Boom generation than anybody else. His
Common Sense Book of Baby and Child Care was the bible of childrearing
in the 1950s and 1960s. This Web site carries forward Dr. Spock’s legacy
with advice for all stages of childhood: newborns, infants, toddlers,
preschoolers, and school-agers. Address: www.drspock.com

Parent Soup: As shown in Figure 7-2, this Web site offers a little some-
thing for every parent, no matter how old his or her child is. You can get
advice about everything from planning a birthday celebration to anger
management and nutrition. Address: www.parentsoup.com
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I need to fit Behind the Name (www.behindthename.com) somewhere in this
book, and it may as well be here, as a parent-to-be may come to this part of
the book. Behind the Name is like one of those “what to name the baby”
books in that it gives the history and etymology of first names. But what
makes this Web site special is the Popularity link. Click this link next to any
name and you get a graph generated from census data showing how the
name has risen or fallen in popularity over the years. For example, clicking
the Popularity link next to my name, Peter, shows that my name was in the
top 50 names until 1969, but it has since fallen to ranking 148. Ashley, mean-
while, has risen from ranking 662 in 1969 to become number 8 in 2003. What
the hey?
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Finding a School for Your Child Chanter 7

Apart from birth, probably no passage in a child’s life brings more anxiety
for parents than entering elementary school. Finding the right elementary
school for a child isn’t easy. You can start by searching the Web site of the
school district where you reside. The school district is supposed to maintain
an accountability report card for each of its schools. These report cards
describe the school, list the number of students, and report standardized
test results, among other things. Check out these Web sites as well for help
with choosing schools:
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4+ Great Schools: Find profiles and performance ratings for public, private,
and charter schools in 50 states. The Web site offers detailed reports
about all schools in California, Arizona, Texas, Florida, Colorado, New
York, and Washington. Address: www.greatschools.net

4+ Parents for Public Schools: PPS is a national organization devoted to
improving public schools with the help of public-spirited volunteers.
From the point of view of a parent looking for a school, the organization
can be very helpful in directing you to the right school and advising you
in how to get your child admitted. Go to this Web site and see whether
your community has a PPS chapter. Address: www.parents4public
schools.com

By the way, on my authority as the spouse of an elementary school teacher,
[ know that the best way to judge a school is not by its test scores, but by
speaking to the parents of students who attend the school. Every school is
a community, and you can find out how vibrant it is from parents, not from
statistics.

The motto of Donors Choose (www.donorschoose.org) is “Every Teacher a
Grant Writer; Every Citizen a Philanthropist.” This Web site gives you the
opportunity to fund a classroom project large or small somewhere in the
United States. Teachers are invited to come to this Web site and describe
projects for which they need a donor. Look through the hundreds of proj-
ects. If you decide to open your purse or wallet and be a benefactor, you are
guaranteed to receive a follow-up report explaining precisely how your
money was spent and a raft of thank you notes from students. Here’s your
chance to really make a difference.

Kids’ Health

Besides the numerous Web sites devoted to health in general (WedMD, CBS
News HealthWatch, and others), you can also find Web sites devoted to chil-
dren’s health on the Internet. Here are the best ones:
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Getting Help with Your Homework

Healthy Kids: This Web site is brought to you by the editors of American
Baby magazine. You can find many long, magazine-style articles. Get
advice on basic health, development issues, and nutrition. Use the
Search text box to search for information and articles. Address:
www.healthykids.com

Kids Health: This Web site is actually three in one. It offers health advice
for parents, children, and teenagers. Click the Parents, Kids, or Teens
link to read health advice tailored to parents, children, or teenage chil-
dren. Address: www.kidshealth.org

Teen Advice: Teenagers can come to this Web site and ask questions
about gender issues, family, relationships, and sex, among other topics,
and have their questions answered by volunteer advice counselors.
Search the Question Archive to see whether your question has already
been answered. Address: http://teenadviceonline.org

Teenwire: Planned Parenthood’s award-winning online magazine,
Teenwire gives frank and thorough advice to teenagers about contracep-
tion and sexual health. Address: www.teenwire.com

Getting Help with Your Homework

Someday computer homework robots will be able to do your homework for
you. Until that blesséd day arrives, however, you're stuck with doing it on
your own, although you can seek help from these Web sites:

4 Brain Pop: If you're the kind of person who learns better from short

films than books, check out this Web site. You can see simple cartoons
that elucidate topics in science, math, English, social studies, and tech-
nology. Address: www.brainpop.com

Hotmath: [s this too good to be true, or what? Says this Web site, “We
show step-by-step explanations for the actual math homework problems
in math textbooks (odd-numbered problems only).” If your math text-
book is covered at this Web site, you can find out how to solve the odd-
numbered problems in today’s homework assignment. You’'ll have to
instant-message your friends to find answers to the even-numbered
problems. Address: www.hotmath.com

Math.com: Need a refresher course in classifying angles? How about
derivative identities? You can get easy-to-understand math lessons at
this Web site. Address: www.math.com

Pink Monkey: Go to this Web site when you need help writing an essay
for an English class. According to its makers, Pink Monkey is “the
world’s largest library of literature summaries, with 389 booknotes,
chapter summaries, and study notes online currently.” Address:
www.pinkmonkey.com



Figure 7-3:
Fun Brain
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learning
games.
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Finding Colleges and College Scholarships

4+ Sparknotes: This Web site offers free online study guides in a number
of different academic areas. Click the Math link, for example, to get
help with different topics in algebra, geometry, trigonometry, and pre-
calculus. Click the Literature link to get plot summaries, character
lists, and descriptions of hundreds of different novels. Address:
www.sparknotes.com

Fun Brain, the award-winning Web site shown in Figure 7-3, offers learning
games for children. You can find games suitable for kids of different ages in
eight different subject areas. Some of these games, by the way, are suitable
for adults, too. Fun Brain is located at this Web address: www. funbrain.com.
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Finding Colleges and College Scholarships

Every college has a Web site. Start your search for the college of your
dreams by visiting college Web sites and requesting brochures. While you're
at it, check out these Web sites:

4 College Board: This is the all-purpose Web site for high school seniors
looking to go to college. Starting here, you can investigate different col-
leges, sign up to take entrance exams, and take practice SAT tests.
Address: www.collegeboard.com

4+ College Confidential: Start at this Web site if you are a novice and the
whole college admission thing just mystifies you. If what you need to
know can’t be found on this Web site, post your question on one of the
forums and wait for an answer. You won’t have to wait long, as this is a
crowded Web site. Address: www.collegeconfidential.com

Book |
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4+ FastWeb: After you enter your name and e-mail address, you can
describe yourself and enlist the help of FastWeb in finding scholarships
for which you are eligible. Be sure to submit a secondary e-mail address.
The e-mail address you enter will be barraged by junk mail. Address:
http://fastweb.monster.com

4+ FinAid: This is an all-purpose Web site for people trying to figure out
how to pay for their college education. Use the calculators to find out
how much money you need. Study your opportunities for loans and
scholarships. You can even submit a question to this Web site. Address:
www.finaid.org

4+ Thick Envelope: For a rather hefty fee of $40, this Web site claims to
give you a realistic assessment of your chances of being admitted to 80
different colleges. The idea is for you to save money by only applying to
colleges that you are qualified for. Address: www.thickenvelope.com

4+ Yahoo! College Search: To get the bare essentials about a college’s
tuition costs and enrollment, start at this Web site. Address:
http://education.yahoo.com/college/essentials
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Chapter 1: Browsing
around the Internet

In This Chapter

v Finding your way around the Internet

v+ Choosing a home page

+* Bookmarking Web pages you intend to visit again
v Sharing your bookmarks with others

+* Downloading a file over the Internet

In Internet-speak, browsing means to skip merrily along from Web page to
Web page. I'm curious why browsing was chosen to describe this activity.
Before the Internet became available, fo browse meant to feed on or nibble.
Sheep browse on hillsides. Did the makers of Web-browsing software think
we’re a bunch of sheep?

This chapter describes the basics of getting from place to place on the
Internet. It also shows how to bookmark your favorite Web pages, return to
the pages you've bookmarked, and manage bookmarks. You also discover
social bookmarking, a way to share bookmarked Web pages with other
people. Last but not least, you find out how to download and copy files from
the Internet.

In case you didn’t know, a Web browser is the software you use to view Web
pages, bookmark Web pages, and get from Web page to Web page. This
chapter mentions two browsers — Internet Explorer and Mozilla. Chapter 2
of this minibook describes these and other Web browsers in detail.

Navigation Basics

If you know the least bit about the Internet, you have my permission to skip
over this section. It describes the basics of getting around, what hyperlinks
are, and how to enter Web addresses in a browser. This information is old
hat to most people, but speaking as one who wears old hats from time to
time, [ understand that not everyone knows the basics, so I describe them
here.
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Uisiting a Web site whose address you know

Every Web page has a Web address, also known as a URL, or uniform
resource locator. While you’re online, you can read the addresses of the Web
pages you're visiting by glancing at the Address bar in your browser. (If you
don’t see the Address bar, choose View=>Toolbars=>Address bar in Internet
Explorer, or choose View=>Show/Hider>Navigation toolbar in Mozilla.) To go
to a Web site whose address you know, carefully type the address in the
Address bar and press Enter, as shown in Figure 1-1.
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Figure 1-1:
Every Web Advertising Programs - Business Solutions - About Google
page has an EE004 Google - Searching 4385190774 web pages
address. |5 @ @e ° - i
If you've entered the address before, you're in luck. Your browser may recog-
nize the address, in which case the address appears on the drop-down menu
and you can select it. If you entered the address recently, you can click the
down arrow on the Address bar and, on the drop-down menu, click the
address of the Web page you want to visit.
N When you enter a Web address, it isn’t necessary to enter the http.// at the

beginning of the address. In many instances, you don’t have to enter the
www. either, because your browser assumes that you want to enter those let-
ters and it enters them for you. For example, if you enter ebay.com, your
browser fills in the rest: http://www.ebay.com. Here’s another trick you
can use in some versions of Internet Explorer: If you click in the Address bar
and press Ctrl+Enter, your browser immediately enters http://www..com/.
All you have to do is fill in the missing parts of the Web address.



Figure 1-2:
A hyperlink.
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Clicking hyperlinks to get from page to page

After you arrive at a Web site, you're sure to find many hyperlinks.
Hyperlinks come in the form of text and images. Clicking a hyperlink takes
you to a different Web page or a different place on the same Web page. You
can tell when your pointer is over a hyperlink because the pointer turns into
to a hand with the index finger up, and a brief description of where the link
will take you appears on-screen as well, as shown in Figure 1-2. By conven-
tion, text hyperlinks are shown in blue text and are underlined, although
some Web sites break the convention. Image hyperlinks are harder to spot.
You can’t tell where they are until you move the pointer over them and see
your pointer change to a pointing hand.
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Probably the most adventurous way to explore the Internet is to click hyper-
links and see where your journey takes you. You can always backtrack by
clicking the Back button, as the next section in this chapter explains.

In the Mozilla browser, you can see a list of all hyperlinks on a Web page by
choosing Viewr>Page Info (or pressing Ctrl+]) and clicking the Links tab in
the Page Info dialog box.
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Figure 1-3:
Ways to
revisit Web
pages you
visited
before.

Navigation Basics

Revisiting Web pages you've been to before

Exploring the Internet is an adventure, but more than a few adventurers
travel too far and wish to return to a page that they visited before.
Fortunately, backtracking is pretty easy. By clicking the Back button or its
drop-down menu, you can revisit the pages you viewed since you opened
your Web browser. You can even view a Web page you visited in the past sev-

eral days.

Clicking the Back and Forward buttons
Following are the different ways to revisit sites:

+

*
from which you retreated.

+

Back button: Click the Back button to see the page you last saw.

Forward button: Click the Forward button to move ahead to the page

Back and Forward button menus: Next to the Back and Forward but-

tons are drop-down menus that you can click to leap backward or for-
ward by several Web pages, as shown in Figure 1-3. Don’t be shy about
using these drop-down menus. All you have to do to leap forward or
backward is to click the down-arrow and click a Web-page name.
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Covering your tracks

Your Web browser is watching you! Browsers
keep track of the Web sites you've visited, as
“Delving into your browsing history” explains
later in this chapter. Don't want your boss to
know which Web sites you've been visiting?
Here are instructions for removing Web
addresses from the Address bar drop-down
menu and from the History bar or History dia-
log box:

Options dialog box. You can also tell
Internet Explorer how many days’ worth of
Web sites to stockpile by entering a
number in the Days to Keep Pages in
History text box.

v+ Mozilla: Choose Edit=>Preferences and, in
the Preferences dialog box, select the
Navigator category and the History sub-
category. Then click the Clear History
button to remove all Web addresses from
the History dialog box, and click the Clear
Location Bar button to remove addresses

v~ Internet Explorer: Click the History button
to see the History bar (refer to Figure 1-3),
right-click the address you want to delete,

and choose Delete. To remove all the Web
addresses on the list, choose Tools=>
Internet Options and click the Clear History
button on the General tab of the Internet

from the Address bar. You can tell Mozilla
how many days" worth of addresses to
keep on hand by entering a number in the
Days text box.

Delving into your browsing history

Your browser is watching you! The program keeps a record of the Web sites
and Web pages you visited in the past several days. Follow these instruc-
tions to return to one of those Web pages:

4+ Internet Explorer: Click the History button and then click a Web
address in the History bar. After you click a day of the week button
or the Week Of button, you see an alphabetical list of Web addresses
(refer to Figure 1-3).

&

Histary

4+ Mozilla: Press Ctrl+H or choose Gor>History. You see the History dialog
box. Select a day and double-click a Web address.

Choosing Your Home Page

. | When you start your Web browser and connect to the Internet, the first
Ho;,:i place you go is your home page. You also go there when you click the
Home button in your browser. Unfortunately, software manufacturers and
unscrupulous Web sites sometimes commandeer the home page. When you
install new software, you sometimes discover that your home page has mys-
teriously become that of a software manufacturer. And unscrupulous Web
sites have been known to load spyware on your computer that changes your
home page. Don'’t let yourself be pushed around this way!
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Browsing more than one Web page

You can be in two (or three or four) places at
once, at least where browsing Web pages is
concerned. While you wait for one Web page
to load on your computer, you can examine
another one.

To open more than one Web page in Internet
Explorer, press Ctrl+N or choose FilecoNewr>
Window. Doing so opens a second Internet
Explorer window, where you can go to another
Web page. You can also open a second window
by Shift+clicking a hyperlink. To go back and
forth between Web pages that are open, click
buttons on the taskbar.

Mozilla is more sophisticated than Internet
Explorer when it comes to browsing more than
one Web page. In Mozilla, you can open the
second (or third or fourth) page in a tab. Use

one of these techniques to open the first tab or
another tabh:

v Press Ctrl+T or choose FileeoNewr>
Navigator Tab.

v Click the Open a New Tab button.
v~ Right-click a tab and choose New Tab.

Click tabs to go from Web page to Web page.
Use these techniques to close tabs:

v Click the Close button on the right side of
the tab bar to close all tabs.

v Right-click and choose Close Tab to close
a tab (or press Ctrl+W).

v Right-click and choose Close Other Tabs to
close all tabs but the one you're viewing.
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Choose a home page that you are genuinely interested in, one that loads
quickly, and one that you visit often. Go to the page you want to make your
home and follow these instructions to make it your home page:

4+ Internet Explorer: Choose Tools=Internet Options. You see the General
tab of the Internet Options dialog box. Click the Use Current button.

4+ Mozilla: Choose Edit=>Preferences. In the Preferences dialog box, select
the Navigator category and then click the Use Current button.
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Favorites

In Internet terminology, to bookmark means to save a Web address so that
you can return to it later. Browsers offer special commands for saving Web
addresses. After you have bookmarked a Web page, you need only click its
address to visit it. Don’t be shy about bookmarking a page — you can always
delete the bookmark later. Read on to find out how to go to bookmarked
pages, how to bookmark pages, and how to manage your bookmarks.

Going to a page you bookmarked

After you bookmark a Web page, visiting it is simply a matter of clicking once
or twice. Everything should be this easy. Following are instructions for going
to a bookmarked page in Internet Explorer and Mozilla.

Internet Explorer

Internet Explorer offers two ways to visit a favorite Web page that you
bookmarked:

4 Click the Favorites button and select the Web page in the Favorites bar,
as shown in Figure 1-4. If you put the page in a folder, select the folder’s
name and then select the bookmark.

4+ Open the Favorites menu and choose the bookmark there, as shown in
Figure 1-4. If the bookmark is kept in a folder, click a submenu name and
then click the bookmark.

Mozilla

To go to a bookmarked page in Mozilla, click the Bookmarks button on the
Personal toolbar or open the Bookmarks menu and then choose the book-
marKk. If the bookmark is in a folder, click the folder name on the submenu
and then click the bookmark.

If you are having trouble finding a bookmark, choose Bookmarks->Manage
Bookmarks (or press Ctrl+B) to open the Bookmark Manager dialog box.
Then enter a part of the bookmark name or a keyword you assigned to the
bookmark in the Search text box, and press Enter. With luck, your bookmark
appears in the dialog box, and you can double-click it there.

People who use Internet Explorer and Mozilla to browse the Web can have
their cake and eat it too. Mozilla gives you the chance to visit Web pages you
bookmarked with Internet Explorer. To visit one of these pages, choose
Bookmarks=>Imported IE Favorites. The names of pages you bookmarked in
Internet Explorer appear on a submenu. Click a bookmark there.
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Figure 1-4:
Goingtoa
bookmarked
page in
Internet
Explorer.
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Bookmarking a favorite page

You are hereby encouraged to bookmark a Web page if you feel the least

desire to return to it later. Unless you bookmark a page, finding it again can
be like finding the proverbial needle in a haystack. As you bookmark pages,
give a moment’s thought to how you want to organize your bookmarks. If
you bookmark more than a handful of pages, finding bookmarks can be diffi-
cult, unless you organize your bookmarks into folders. Your Web browser
gives you an opportunity to do that, as [ explain very shortly.

Internet Explorer
Follow these instruction to bookmark a Web page in Internet Explorer:

1. Choose Favorites>Add to Favorites.
You see the Add Favorite dialog box, shown on the left side of Figure 1-5.

2. Select a folder for the Web page (click the New Folder button, if neces-
sary, to create a new folder), and click the OK button.

Bookmarked Web pages appear on the Favorites menu, as the previous
section in this chapter explains. Unless you choose a folder for storing
favorite Web pages, the Favorites menu soon fills with Web pages, and

you have trouble finding the one you want.
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Figure 1-5:
Bookmark-
ing a Web
pagein
Internet
Explorer
(left) and
Mozilla
(right).
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You can quickly bookmark a Web page by pressing Ctrl+D. However,
doing so places the Web page on the Favorites menu, and you don’t get a
chance to put the Web page in a folder for organizational purposes.
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Do one of the following to bookmark a Web page in Mozilla:

*

+

Press Ctrl+D (or choose Bookmarks=>Bookmark This Page) to place the
Web page on the Bookmarks menu.

Press Ctrl+Shift+D (or choose Bookmarks>File Bookmark) to organize
the Web page into a folder in the File Bookmark dialog box, as shown on
the right side of Figure 1-5.

Select the folder, enter a name for the bookmark, and enter a keyword as
well if you want this page to come up in keyword searches for book-
marks. You can click the New Folder button to create a new folder.

Renaming, deleting, and managing bookmarks

A bookmark collection can be like a crowded garage — it can be a resting
place for a lot of old junk as well as useful items. If you collect bookmarks,
the time will surely come when you need to rename, delete, or move book-
marks in your collection. These pages explain how to do all that.
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Figure 1-6:
Moving a
bookmark to
a new folder
in Internet
Explorer.

Internet Explorer

The easiest way to handle bookmarks in Internet Explorer is to do it by way
of the Favorites menu. With this menu open, you can delete a bookmark by
right-clicking its name and choosing Delete on the shortcut menu. You can
move a bookmark by dragging its name up or down on the menu. You can
rename a bookmark by right-clicking its name, choosing Rename, and enter-
ing a new name in the Rename dialog box.

Another way to handle bookmarks is to choose Favoritesm>Organize Favorites
and get to work in the Organize Favorites dialog box, shown on the right side
of Figure 1-6. The Create Folder, Rename, and Delete buttons are self-explana-
tory. What is useful in this dialog box is the Move to Folder button. To move
a bookmark into a different folder, select the bookmark’s name, click the
Move to Folder button, and select a folder in the Browse for Folder dialog
box, as shown on the left side of Figure 1-6.
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Yet another way to handle bookmarks is to open My Computer or Windows
Explorer and do your moving, renaming, and deleting there. Internet
Explorer bookmarks are kept in one of these folders, depending on how
your system is set up:

C:\Documents and Settings\Your Name\Favorites
C:\Windows\Favorites\Links

Open the folder where your bookmarks are located and use standard My
Computer or Windows Explorer commands to move, rename, and delete
bookmarks. For example, to move a bookmark to a different folder, drag it
there.



Figure 1-7:
Moving a
bookmark to
a new folder
in Mozilla.
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Mozilla

To manage bookmarks in Mozilla, start by pressing Ctrl+B or choosing
Bookmarks=>Manage Bookmarks. You see the Bookmark Manager dialog box
shown in Figure 1-7. Select the bookmark that needs disciplining and follow
these instructions to discipline it:

4+ Moving: Click the Move button. You see the Choose Folder dialog box
shown in Figure 1-7. Select a folder and click the OK button.
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4+ Renaming: Click the Rename button and enter a new name in the
Properties For dialog box.

4+ Deleting: Click the Delete button, but be careful, because the bookmark
is deleted right away. Mozilla isn’t a Microsoft-made program. You don’t
see the Are You Sure You Want to Delete? warning that Microsoft spits
out in its programs.

Backing up your bookmarks

Backing up means to make a second copy of computer data and store it on a
floppy disk or other medium away from your computer. It would be a sad
day if your computer crashed and you lost all your bookmarks. To back up
your bookmark collection, open My Computer or Windows Explorer, go to
one of these folders, and back up your bookmarks to a floppy disk or other
storage medium:
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4+ Internet Explorer: Bookmarks are located at C: \Documents and
Settings\Your Name\Favorites or C:\Windows\Favorites\Links,
depending on your system setup.

4 Mozilla: Bookmarks can be found in a file called bookmarks.html.
Unfortunately, finding this file can be a chore, as it is buried in a so-
called salted (.s1t) subfolder at C: \Documents and Settings\

Your Name\Application Data\Mozilla\Profiles\Your Profile
Name\[random string].s]t. Salted folder, indeed! Sometimes the
best way to find this subfolder is to look for it with the Windows Search
command.

Social Bookmatrking, or Sharing
Bookmarks with Others

When you bookmark a Web page, it means you like it well enough to want to
return to it someday. Only the best Web pages get bookmarked. If you knew
which pages others have bookmarked, you could get a head start in finding
useful Web pages. And if you could narrow a search of the Web to book-
marked Web pages, your search would be more rewarding.

On the idea that the only good Web page is a bookmarked Web page, the
past couple of years have seen an innovation called social bookmarking.
Social bookmarking means to share bookmarks with others. Web pages that
you bookmark are entered on a master list of bookmarks. Others enter their
bookmarked pages on the list as well. The result is a database of book-
marked Web pages that you can search. Most social-bookmarking services
also give you the opportunity to store your bookmarks online and organize
them in different ways.

Here are the most highly regarded social-bookmarking Web sites:

4+ Backflip (www.backflip.com)

4 del.icio.us (http://del.icio.us)

4+ furl (www. furl.net)

4+ Spurl.net (www.spurl.net)
My favorite is Spurl.net, shown in Figure 1-8. This one is easiest to use and
install (although it only works with Internet Explorer). After you register

with Spurl.net and load its program on your computer, two buttons — Spurl!
and Spurl Bar — appear in your browser window:



Figure 1-8:
Social
bookmark-
ing with
Spurl.
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Click the Spurl! button (or choose Toolsw>Bookmark the Current Page to
Spurl.net) to bookmark a Web page and share it with others. A form
appears so that you can describe the Web page. The information you
enter goes into a database that other Spurl members can search.
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Click the Main Search link at Spurl.net to search among Web pages that
others have bookmarked (refer to Figure 1-8). Enter a keyword for the
search and click the Search button.

4 Click the Spurl Bar button to display the Spurl bar on the left side of the

browser window (refer to Figure 1-8). In the Spurl bar, you can view a list
of pages you bookmarked (click My Spurls), view a list of pages that
Spurl recommends for you, given the kind of pages you bookmarked
(click Recom), or view a list of pages recently bookmarked by Spurl
members (click Hot New). To search pages you bookmarked, enter a
keyword in the text box and click the Click to Search button.
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Downloading and Copying Files from the Internet

Figure 1-9:
Downloading
afile from
the Internet.

NG/
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Downloading means to transfer a copy of a file or program from a site on the
Internet to your computer. From time to time in your exploration of the
Internet, you are given the opportunity to download a file. Book I, Chapter 4
looks into the security implications of downloading files. If you have
antivirus software (and you should have it), the software will examine the
file after it arrives to make sure that it doesn’t carry a virus.

When you click the button to download a file, you see the File Download -
Security Warning dialog box shown in Figure 1-9. Click the Save button,
choose a folder for the downloaded file in the Save As dialog box, and twid-
dle your thumbs while the file downloads. To activate the file, go to folder
where you stored it, select the file, and double-click it.
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Before you run a file you downloaded, right-click it in Windows Explorer or
My Computer and choose Run with AntiVirus to see whether the file con-
tains a virus.

On the subject of grabbing files from the Internet, you can also copy text,
pictures, and video files by following these instructions:
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Copying text: Drag your cursor over the text and press Ctrl+C or choose
Edit~>Copy to copy the text to the Clipboard.

Copying a picture: Right-click the picture and choose Save Picture As on
the shortcut menu. In the Save As dialog box, select a folder and click
the Save button.

Downloading a video: Right-click the video image and choose Save
Target As on the shortcut menu. In the Save As dialog box, select a
folder for storing the video file and click the Save button. You can
change the file’s name by entering a new name in the File Name text box.
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Chapter 2: A Look at Different
Browsers

In This Chapter

1+ Looking at the different browsers

v Customizing Internet Explorer and Mozilla

Flis chapter takes a look at different Web browsers, the computer pro-
grams you use to explore the Internet. I explain how you can tweak
browsers and how to make them work for you. You need a Web browser to
cruise the Internet, so you may as well pick the one that works best for you,
and after you've picked it, you can then make it run the very best it can.

Compatring the Different Browsers

Table 2-1 offers a thumbnail comparison of the five most commonly used
Web browsers. All these browsers are free. The most popular by far is
Microsoft’s Internet Explorer, shown in Figure 2-1. According to
WebSideStory, a company that collects information about how people use
the Internet, 94 percent of people who browsed the Internet in July 2004
used Internet Explorer.

Table 2-1 Different Web Browsers
Browser Notes Address
Internet Explorer ~ Comes with the Windows operating www.microsoft.com/

system. |s compatible with more Web windows/ie
sites than other browsers. Version 6.0

includes pop-up blocking and new

security features.

Mozilla Offers better control of pop-up windows www.mozilla.org/
and cookies. Lets you browse more than releases
one Web page with window tabs.

(continued)
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Figure 2-1:
Internet
Exploreris
by far the
most
popular
Web
browser.

Table 2-1 (continued)

Browser Notes Address

Netscape Formerly the most popular browser. http://channels.

Navigator netscape.com/ns/
browsers/download.
Jsp

Opera Doesn't offer as many features, but WWW.Oopera.com

claims to be faster and more secure
than other browsers.

Safari Comes with the Mac operating www.apple.com/
system (0S). safari

_Internet Explorer Home - Microsoft Internat Explorer BE=
Eile [Cdit \iew Favorites Toals Help zﬂ'

0. © S @B @ | L ¥ & o 5 =

Back Ferserd stop Refrash e Seach  Favorbes  Hatory Mal Bant Edt

Jrace [ 48] et tiumssnmizeaseft o faindousiefdefaut mep

Ly =arch Micrasofs com for
f&(mnd - T rth Micrasofs com f E

Microsoft Internet Explorer

Inkermat Explorer Securdy At Home | Microsoft At Home | Microsoft At Werk -

bl New for Internet Explorer
and Outlook Express

Using Lrtarmet Leplarer

Downloads

Support

Community

Warldwide Sites Wimdows ®F Sarvica Fadk 2 enhances pour ¥sb browsing and
A = | eemail experience with new security technolegies dasigrad 1o

| raduce unwanted content and downlaads.

Siindows =F | Gther Windows verssans

windews Farnidy 3

k Eow do ] know which version 1'm using®

Internet Explorer is so popular in part because it comes with Windows. If
your computer runs the Windows operating system — and nine of ten com-
puters run Windows — Internet Explorer is installed on your computer auto-
matically. Many Windows users make Internet Explorer their Web browser
without giving it any thought. They don’t realize that they have a choice of
browser software.

Another reason for the popularity of Internet Explorer has to do with Web-
site design. Designers know that the vast majority of people who come to
their Web sites will use Internet Explorer. Accordingly, they engineer their
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Web sites to work best with that browser. The success of Microsoft’s
browser is self-fulfilling. As more Web sites are designed for Internet
Explorer, fewer display properly in other browsers, which causes more
people to abandon the browsers they are using in favor of Internet Explorer.

Internet Explorer has been the subject of controversy because of security
flaws. In June 2004, the United States government’s Computer Emergency
Readiness Team (CERT) suggested dropping Internet Explorer. Warned CERT,
“There are a number of significant vulnerabilities in technologies relating to
the IE domain/zone security model, the DHTML object model, MIME type
determination, the graphical user interface (GUI), and ActiveX. It is possible
to reduce exposure to these vulnerabilities by using a different Web browser,
especially when browsing untrusted sites.”

Microsoft responded by introducing Internet Explorer 6.0, an upgrade to

its browser, in September 2004. The company also issued a patch for
Windows XP called Service Pack 2. Between Service Pack 2 and the upgrade,
Internet Explorer was supposed to be safe from attacks.

Is Internet Explorer unsafe? It is no more unsafe than other browsers. In fair-
ness to Microsoft, its browser is more subject to attacks not necessarily
because it has more security flaws, but because it presents a bigger and
juicier target. Hackers, worm writers, Trojan horsemen, and the other motley
malcontents who make attacking browser software their pastime target
Internet Explorer because it is found on the majority of computers. If Mozilla
or Safari were as ubiquitous as Internet Explorer, they would be attacked just
as often.

Throughout this book, I give instructions for using Mozilla because I am very
fond of that browser. I think Mozilla is worth checking out. It is easier to cus-
tomize than Internet Explorer and easier to learn. It handles pop-up windows
better. Bookmarks are easier to manage. You can visit more than one Web
site at the same time, thanks to Mozilla’s window tabs (see the section on
browsing multiple Web pages in Chapter 1 of this minibook). And, | must say,
it’s refreshing to use software that’s notf manufactured by the Microsoft
Corporation. Figure 2-2 shows the Mozilla browser.

Besides the Web sites listed in Table 2-1, you can download popular Web
browsers at TUCOWS (www. tucos.com) and Cnet (www.cnet.com). All the
browsers are free.
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Figure 2-2:
The Mozilla
Web
browser.
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Customizing Your Browser

Most people don’t realize that they can do a lot inside their browser to make
exploring the Internet a more comfortable experience. They don’t under-
stand that they can trade their coach seat for first class. Or that they can sit
by the window rather than the aisle if they want to. Or that they can forsake
the chili mac for the filet mignon.

These pages explain the different ways to customize Internet Explorer and
Mozilla. Read on to discover how to make text easier to read, handle tool-
bars, control pop-up windows, and choose a default search engine for your
browser.

As well as this chapter, which discusses customizing your browser, be sure
to see Book I, Chapter 4, which explains how to protect your privacy and
security as you browse the Internet, and Book I, Chapter 6, which explains
plug-in programs such as QuickTime and Acrobat Reader that come into play
when you visit certain types of Web pages.

Matking the text easier to read

Depending on your computer setup and the Web sites you visit, you may be
able to alter the text and background of Web pages by taking advantage of
commands in your browser. These commands don’t always work, but they
are worth a try.
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The commands described in this section affect all Web pages you visit, not
just the Web page you are looking at when you give the command. If you
change the look of text, remember how you changed it in case you change
your mind and want to change it back.

Changing text size
Try these commands on your browser’s View menu to shrink or enlarge the
text on Web pages:

4+ Internet Explorer: Choose Viewr>Text Size, and select a size option on
the Text Size menu.

4+ Mozilla: Choose Viewr>Text Zoom, and then choose a setting on the Text
Zoom submenu. You can also press Ctrl+— (Ctrl and the minus sign) or
Ctrl++ (Ctrl and the plus sign) to shrink or enlarge the type. Each time
you press these key combinations, the text gets smaller or larger.

Changing fonts

Check out these commands if you find it necessary to change fonts on a Web
page. A font is a type style, the complete collection of letters, numbers, and
symbols available in a particular typeface. Some fonts are easier to read than
others.

4+ Internet Explorer: Choose Tools=>Internet Options, and on the General
tab of the Internet Options dialog box, click the Fonts button. You see
the Fonts dialog box, shown in Figure 2-3. Choose a font in the Web Page
Font list for letters shown in proportional text; choose a font in the Plain
Text Font list for letters shown in fixed-width text.

4+ Mozilla: Choose Edit>Preferences, and then go to the Fonts subcate-
gory under Appearance in the Preferences dialog box, as shown in
Figure 2-3. In this category are options for changing proportional fonts,
serif fonts, sans-serif fonts, and cursive fonts on Web pages.

Changing text color

Finally, you can change the color of text and the page background color.
Resort to these commands, for example, when you come to a Web page that
is indecipherable, one of those unreadable pages with a dark background
and dark text:

4+ Internet Explorer: Choose Tools=>Internet Options, and on the General
tab of the Internet Options dialog box, click the Colors button. You land
in the Colors dialog box. Deselect the Use Windows Colors check box.
Click the Text button to choose a color for text from the pop-up Color
dialog box, and click the Background button to choose a page back-
ground from the pop-up Color dialog box.

Book Il
Chapter 2
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Figure 2-3:
Changing
the look of
textin
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and Internet
Explorer
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4+ Mozilla: Choose Edit=>Preferences, and then go to the Colors subcate-
gory under Appearance in the Preferences dialog box. Click the Text
button and choose a color from the pop-up menu for text; click the
Background button and choose a color from the pop-up menu for the
page background.

Wrestling with the toolbars and status bar

Sometimes toolbars and other bric-a-brac along the sides of the browser
window come between you and the joy of exploring the Internet. To remove
all toolbars as well as the status bar along the bottom of the browser
window, press F11 (or choose View=Full Screen). Press F11 again to resusci-
tate the toolbars.

In all Microsoft programs, Internet Explorer included, you can right-click a
toolbar or the menu bar and select the name of a toolbar from the shortcut
menu to display or hide a toolbar. Internet Explorer also offers commands on
the View=>Toolbars menu for hiding and displaying toolbars.

In Mozilla, you hide or display toolbars by choosing Viewr>Show/Hide and
then selecting or deselecting a toolbar name on the submenu.

The status bar along the bottom of the window tells you when a page has fin-
ished downloading (you see the word Done). When you move the pointer
over a hyperlink or button, the status bar lists the address of the Web page
that will open if you click the hyperlink or button. All of that is well and
good, but if you don’t care to see the status bar, choose Viewr>Status bar in
Internet Explorer, or choose Viewr>Hide/Display=>Status bar in Mozilla.
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Ways to prevent eyestrain

People who spend many hours working in front
of a computer screen owe it to themselves
to look after their health. Computers are dan-
gerous to the lower back, the wrists, and the
eyes — especially the eyes. Here are some
techniques to help prevent eyestrain:

v~ Keep your monitor in the proper light. Glare
on a monitor screen causes eyestrain.

click OK. Try this setting on for size. If you
don't like it, return to the Settings tab and
drag the screen slider to the right. If you
can't see the OK button because the
screen is too small, just press Enter instead
of clicking OK.

Put large icons on the desktop and in fold-
ers. To make the icons on the Windows

. . . . . . Book I

Keep the monitor out of direct light to desktop and in folders larger, right-click on Chao:terz
reduce glare and use an adjustable light to the desktop and choose Properties. In the

illuminate whatever it is you are working Display Properties dialog box, select the >

with besides your computer and monitor. If Effects tab, select the Use Large Icons 5

you are using a laptop or flat-screen moni- check box, and click OK. g-’ g

a - - D

tor, you can put I e [ 018 615 Make the mouse pointer larger. Another 3 o

light because laptops and flat-screens are ; o =

g . way to make your eyes last longer is 63

meant to be sidelit or backlit. . ]

to make the mouse pointer larger. Choose e

v~ Play with the knobs on your monitor. Those
goofy knobs on the monitor can be useful
indeed. Twist them, turn them, and experi-
ment until you find a look that is comfort-
able for your eyes.

v~ Opt for smaller screen resolution. With a
smaller screen resolution, or area, every-
thing looks bigger, although things can get
cramped, too. To get a smaller resolution,
right-click on the Windows desktop and
choose Properties. In the Display Properties
dialog box, select the Settings tab. Then
drag the Screen Area slider to the left so
that the setting reads 640 x 480 pixels, and

Start=>Settings=>Control Panel. Then
double-click the Mouse icon (switch to
Classic View if necessary), select the
Pointers tab in the Mouse Properties dialog
box, and choose Windows Standard (extra
large) or Windows Standard (large) from
the Scheme drop-down menu.

v~ Gaze at the horizon. Every so often, leave

your desk, step to the window, part the cur-
tains, and stare. Stare at the most faraway
point you can see. Stare and dream. Then
blink a few times and marvel at how good
the world looks when you’re not staring at
a computer screen.

Preventing and controlling pop-ups

If you have spent any time on the Internet, you know what a pop-up is. Pop-
ups are new, unwelcome browser windows that leap onto the computer
screen when you least expect them. Most pop-ups are advertisements. At
best, they are annoying. At worst, several pop-ups appear in succession, and
you have to kill them one at a time by closing the browser windows in which
they appear. How do you prevent pop-ups? Keep reading.
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3 You can always right-click a link and choose Open in New Window if you
want a second window — in other words, if you want a pop-up window — to
appear. In Internet Explorer, you can Shift+click a link to open it in a new
window.

After you have told your browser how to handle pop-ups, go to
Popuptest.com at this address: www.popuptest.com. This Web site gives
you opportunities to test your pop-up settings.

Handling pop-ups in Internet Explorer

People who are running Version 6 or higher of Internet Explorer can prevent
pop-ups from appearing. The pop-up blocking mechanism is turned on auto-
matically. When a pop-up attempts to invade your computer screen, you
hear a “blip,” and the Information bar appears along the top of the window,
as shown in Figure 2-4. Pop-up blocked, it tells you. To see this pop-up
or additional options click here. If you are curious and want to see
the pop-up, click the Information bar and choose Temporarily Allow Pop-Ups
on the shortcut menu.

Figure 2-4:
{1 San Francisco Independant - Microsoft Internat Explorer
In Internet File Edit View Favorites Tools  Help
Explorer,.the o . o Y B O L & e - B =
Informatlon Eack Stap Refresh Ferme Search  Favontes  Hitory Tal #rnt Edt
& Foprup blacked, To see this pep-up or addbere opttns did heee..

Tempaotarily Allow Pop-ups
bar appears Ohways Allow Popaps from This Site...

when a pop- setngs | v
up has been Information Bar Help
blocked.

Internet Explorer also offers these options for controlling pop-ups:

4+ Allow pop-ups to appear: If pop-ups are your thing and you want to see
them, choose Tools=>Pop-Up Blocker and select Turn Off Pop-Up Blocker
on the submenu. You can also reach this command by choosing Settings
on the shortcut menu that appears when you click the Information bar
(refer to Figure 2-4).

4+ Allow pop-ups launched from the site you are visiting: Click the
Information bar and choose Always Allow Pop-Ups from This Site on the
shortcut menu (refer to Figure 2-4).
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To decide for yourself how Internet Explorer handles pop-ups, choose
Tools=>Pop-Up Blocker=>Pop-Up Blocker Settings. You see the Pop-Up
Blocker Settings dialog box. From here, you can keep the Information bar
from appearing, decide whether a sound is heard when a pop-up is blocked,
and disallow pop-ups in allowed sites by removing the names of allowed
sites from the Allowed Sites list.

Handling pop-ups in Mozilla

Follow these steps to stop pop-up windows from appearing in the Mozilla
browser:

1. Choose Editc>Preferences.
The Preferences dialog box opens.

2. Open the Privacy & Security category, and click the Popup Windows
subcategory.

3. Select the Block Unrequested Popup Windows check box.

4. Select the Display an Icon in the Navigator Status Bar check box if you
want to be informed when a pop-up has been blocked.

If you select this option, the pop-up icon appears on the status bar
whenever Mozilla blocks a pop-up (you must close and restart Mozilla
for the pop-up icon setting to take effect). You can click this icon to
permit pop-ups to appear on a Web site.

5. Click the OK button.

When Mozilla blocks a pop-up, the pop-up icon appears on the right side of
the status bar. Suppose you want to permit pop-ups to appear on the Web
site you are visiting? Either click the pop-up icon or choose Tools=>Popup
Manager=>Allow Popups From This Site. The Allowed Web Sites dialog box
appears. Click the Add button.

If you change your mind about permitting pop-ups at a Web site, choose
Tools=>Popup Manager=>Manage Popups. In the Allowed Web Site dialog box,
select the address of the Web site in question and click the Remove button.

Choosing a default search engine

A search engine is a Web site that is devoted to helping you search the
Internet. (Chapter 3 of this minibook explains search engines in detail.)
When you click the Search button on the Standard toolbar in Internet
Explorer, the Search bar opens and you are presented with a mini-search
engine, as shown in Figure 2-5. When you click the Search button in Mozilla,
you go straight to the home page of the search engine of your choice.

Book Il
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In both browsers, you get to choose which search engine is the default, the
one you use when you click the Search button:

4+ Internet Explorer: Click the Search button to open the Search bar, and
then click the Customize button (refer to Figure 2-5). You see the
Customize Search Settings dialog box. Select the Use Search Service
option button, and choose a search engine in the Choose the Search

Service list.

4 Mozilla: Choose Edit>Preferences to open the Preferences dialog box. In
the Navigator category, select the Internet Search subcategory. From the
Search Using drop-down menu, choose a search engine.

\
) You can make Google the default search engine in Internet Explorer, but to
do so, you have to install the Google Toolbar first. Chapter 4 of this mini-
book shows how to make the Google the Internet Explorer default searcher.



Chapter 3: Strategies for
Internet Searching

In This Chapter

v+ Understanding how search engines operate
v+ Deciding which search engine to use

v Crafting a good search of the Internet

v Searching the so-called invisible Web

v+ Determining whether information is valid at a Web site

Fe Indianapolis 500, the world’s most grueling auto race, always begins
with this announcement: “Gentlemen, start your engines.” In this chap-
ter, | invite you to start your search engine and use it to dig deep into the
Internet and find the information you need. This chapter explains how direc-
tories, search engines, and meta-search engines work. It describes how to
craft a search that brings up the information you need in the search results.
You discover how to search the “invisible Web,” the part of the Internet that
is out of the reach of search engines, and how to tell whether information at
a Web site is valuable or just a bunch of hooey.

By the way, Internet researchers often neglect two important ways to get
information apart from running a search engine: mailing lists and newsgroups.
Mailing lists are discussions conducted by e-mail among people with the
same interests and obsessions (Book IV, Chapter 3 explains mailing lists).
Newsgroups are online bulletin boards where people debate one another
and trade information (Book IV, Chapter 4 looks into newsgroups).

Finding Out about Search Engines

A search engine is a tool for finding information on the Internet. To use a search
engine, you go to the search engine’s Web site and search by category, or
you enter keywords to describe what you're searching for. The results of
your search appear on a results page like the one in Figure 3-1. For each Web
page found, you can read a snippet of text with a keyword you used in your
search. You can also see the domain names of the Web pages. By studying
the text and domain names, you can usually tell whether a Web site is worth
visiting. Click a hyperlink on the search results page to visit a Web page.
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Search engines fall in three categories: directories, standard search engines,
and meta-search engines. A directory is like a card catalog in a library. You
identify a category that describes the information you need and then you get
a list of Web sites in the category. With a standard search engine, you enter
keywords that describe the information you need, and the search engine
provides a list of Web sites with words that match the keywords you entered
(refer to Figure 3-1). A meta-search engine employs other search engines to
gather information.

How directories work

Directories, you could say, have the human touch. They are operated and main-
tained by people trained in information science or library science. People, not
computers, decide which categories to organize Web sites into and where to
place each Web site in the category scheme. Table 3-1 describes directories.
Two of them, LookSmart and Yahoo!, are also standard search engines.

Table 3-1 Directories for Searching the Internet
Directory Web Address Search  Notes
Name Engine
Also?
About www.about.com No Not truly a directory, but a net-

work of Web sites maintained by
volunteer experts, called guides.
You can search the About net-
work starting at this Web site:
http://search.about.
com/fullsearch.htm.
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Directory Web Address Search Notes
Name Engine
Also?

Librariansto  http://Tii.org No Not truly a directory, but the

the Internet categories are easy to search

Index in and the Web-site descriptions
are excellent.

LookSmart www.looksmart.com Yes Presents information in 12 cate-
gories (click the Directory tab).

Open www.dmoz.org No Largest, most comprehensive

Directory directory on the Internet. Sends

Project search results to AltaVista, AOL
Search, Google, Lycos, and
Teoma. (You can also search the
Open Directory Project starting
at this Google Web page:
http://directory.
google.com).

Yahoo! http://dir.yahoo.com Yes One of the most comprehensive

Search directories on the Internet.

Directory

Figure 3-2 shows the Yahoo! Search Directory. Searching in a directory like
Yahoo!’s is a matter of “drilling down” from broad topics to narrower topics. To
get to a list of oceanography Web sites starting at the Yahoo! Search Directory,
for example, you click the Science category, the Earth Sciences subcategory,
and the Oceanography subcategory. You can also enter keywords in the Search
text box to search for Web sites that have been cataloged in the directory.
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Volunteering for the Open Directory Project

The Open Directory Project aims to be the defin-
itive catalog of the Internet, reaching into and
mapping every corner of cyberspace. In the
democratic spirit of the Internet, the Directory
also aims to remain free of advertisements and
other sources of revenue. Rather than pay librar-
ians to catalog Web sites, it relies on volunteers.

If volunteering to catalog the Web strikes you as
a good deed, visit this address: http: //dmoz.
org/about.html. It explains what volun-
teering for the Open Directory Project entails
and how to sign up. Each volunteer is assigned
a category. Says the Project, “For just a few
minutes of your time you can help make the

Web a better place, and be recognized as an
expert on your chosen topic.”

The Open Directory Projectisn’t the only direc-
tory maintained by volunteers. Check out these
directories as well when the volunteer spirit
moves you:

v~ lllumirate: This directory works in associa-
tion with the HotBot search engine. Address:
www.illumirate.com

v Zeal: Zeal is the directory behind the
LookSmart search engine. Address: www .
zeal.com

SMBER

& Use a directory to search the Internet when you're researching a broad topic
©

and you know with a fair amount of certainty which category the topic will
be in. In other words, use a directory when you have a general question, not
a specific one. Web sites that you find in a directory are more likely to be
useful than Web sites you find with a standard search engine. After all, some-
one, somewhere, cataloged the Web site in the directory, which means it
has some merit. By contrast, Web sites you find with a search engine may
have no merit except for the fact that they include a keyword or two that
you used in your search. Search engines have it over directories when it
comes to volume. Many more Web sites can be found with a standard
search engine than a directory. Search engines illuminate all corners of

the Internet, but directories only shine a light on Web sites that catalogers
thought worthwhile.

In September 2001, About.com removed a third of the topics from its direc-
tory. That left several dozen topic guides — the self-appointed experts who
write about topics — stranded. Starting at this Web site, you can investigate
topics that were trimmed from the About directory in 2001: www. former
aboutguides.com.



Finding Out about Search Engines 117

How standard search engines work

Standard search engines are sometimes called spiders or crawlers because
they crawl along the Internet, going from link to link, recording what they
find and filing it away in a database. When you search the Internet with a
standard search engine, you are really rummaging around in the search
engine’s database. You are finding information brought home to the database
by a spider, an automated program for indexing and describing what is on
Web pages. Table 3-2 describes the major search engines. (Later in this chap-
ter, “More techniques for narrowing a search” compares the search engines’
different features.)

Book Il
Table 3-2 Major Search Engines Chapter 3
Name Web Address Notes
Allthe Web  www.alltheweb.com Gets search results mostly from Yahoo!.

Can search for pictures and video as well
as text, as well as search within domains
and search by file type.

AltaVista www.altavista.com Gets search results from Yahoo!. Can
search within domains and by file type.
Is the only search engine that permits
proximity searches.

Buiyaseag jauaju|
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AOL Search  http://search.aol.com Gathers search results from Google. Can
search for pictures and video, as well as
by file type.

Ask Jeeves  www.ask.com Groups Web sites in search results by sub-
ject. Can search for pictures as well as
within domains.

Clusty http://clusty.com Arranges search results in “clusters” —
subtopics to help you find what you are
looking for.

Gigablast http://gigablast.com Searches asmallerindex of Web sites, but

is a good, clean search engine. Can search
within domains.

Google www.google.com Ranks Web sites in search results largely
on the number of times they are linked to
other sites. The Cadillac of search engines,
it offers just about everything that the
others offer, except proximity searching.

(continued)
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Table 3-2 (continued)
Name Web Address Notes

HotBot www.hotbot.com Gathers search results from Google, Teoma,
and Yahoo!. Can search for images and
pictures, within domains, and by region.

LookSmart www.looksmart.com Excellent starting point for finding articles
by subject or author name (click the Articles
tab), but the search engine doesn't offer
many features apart from that.

Lycos www.lycos.com Gets search results from Yahoo!. Can
search within domains.

MSN Search  www.msn.com Gets search results from Yahoo!. Can
search for images and pictures, within
domains, and by region.

Teoma www.teoma.com Offers a “refine” feature for turning a
Web search in a different direction. Ranks
Web sites in search results by relevancy
based on the context of the Web pages.
Can search forimages and pictures, and
within domains.

WiseNut http://wisenut.com Does not offer advanced searching.

Yahoo! www.yahoo.com Although Yahoo! is the oldest directory, its
search engine was launched in 2004 when
it purchased the Overture search engine.

Unlike directories, standard search engines don’t employ human beings to
decide whether a Web page is relevant to a certain topic. They rely on algo-
rithms to do that. In Internet searching, an algorithm is a mathematical for-
mula for scoring a Web page’s relevance compared to other Web pages. The
Web page that scores highest goes to the top of the list of search results; the
Web page that scores lowest goes to the bottom.

Algorithms take into account a Web page’s title, headings, meta description
tag, and boldface text, among many other things. The success of the Google
search engine is usually attributed to Google’s ability to accurately rank pages
by relevancy in search results. In Google’s PageRank algorithm, pages are
ranked according to how many times other pages link to them, the idea being
that a page to which other pages link is probably more valuable, or relevant,
than a page to which no one has bothered to link.

“PageRank,” Google explains, “performs an objective measurement of the
importance of Web pages by solving an equation of more than 500 million
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variables and 2 billion terms. Instead of counting direct links, PageRank inter-
prets a link from Page A to Page B as a vote for Page B by Page A. PageRank

then assesses a page’s importance by the number of votes it receives.”

(Go to this Web site for a thorough description of how Google ranks Web
pages in search results: www.google.com/corporate/tech.html.)

Use a standard search engine to search the Internet for obscure topics or

topics that aren’t subject to being categorized. Standard search engines
reach deeper into the Internet than directories. You can find many more
Web sites with a standard search engine than a directory.

Writer and editor Danny Sullivan oversees an excellent online magazine,
Search Engine Watch, at this address: http://searchenginewatch.com.
The magazine rates search engines, describes how they work, offers tips
for using them, and even provides an online forum where lovers of search

engines trade tips and tricks. You can also get search-engine news and
notes at Search Engine Showdown at this address: http://searchengine

showdown.com.
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Google-bombing

Google's PageRank algorithm for judging the
relevancy of Web pages has made it suscepti-
ble to an armchair sport called Google-bombing.
Google-bombing means to take advantage of a
search engine’s method of obtaining search
results to artificially raise a Web page’s rank-
ing in the search results list. Google judges a
Web page’s relevancy by how many Web pages
are linked to it. By purposefully linking many
Web pages to a single page, pranksters can
manipulate the Google search results to move
a Web page higher in the search results list.

The first Google-bomb was dropped in 1999,
when pranksters engineered search results at
Google so that a search for “more evil than Satan
himself” returned a results list with Microsoft's
home page in the first position. Google-bombs

have also been launched to link searches for
“miserable failure” to online biographies of
Michael Moore and President George Bush.

The success of Google-bombers underscores
the reason why smart researchers rely on direc-
tories as well as search engines. Google is
essentially running a popularity contest with its
search results. The most popular Web site —
the one to which the most other Web pages are
linked — wins and takes the top spot on the
results list, but as everyone who has attended
junior high school knows, the most popularisn't
necessarily the best or the smartest. Searching
in a directory, you can be sure that the Web
sites you turn up are relevant to the topic you
are researching.

Book Il
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How meta-search engines work

A meta-search engine works much like other search engines, except it doesn’t
send its own automated spiders onto the Internet to index and describe Web
pages. Instead, it rides piggyback on other search engines. A meta-search
engine searches using other search engines and gathers the results in one
place. The Dogpile meta-search engine, for example, gathers search results
from Google, Yahoo!, Ask Jeeves, About, Overture, and FindWhat. Table 3-3
lists meta-search engines.

Table 3-3 Meta-Search Engines
Search Engine Web Address

37.com www.37.com

800go http://800go.com/800go.html
Dogpile www.dogpile.com

Highway61 www.highway61.com

Ixquick www.ixquick.com

Kanoodle www.kanoodle.com

Mamma WWW . mamma . com

MegaGo WwWWw.Mmegago.com

MetaCrawler www.metacrawler.com
MetaSpider www.metaspider.com

Pandia www.pandia.com/metasearch/index.html
PlanetSearch www.planetsearch.com
ProFusion www.profusion.com

Query Server www.queryserver.com/web.htm
Search.com www.Search.com

Vivisimo http://vivisimo.com

In theory, a meta-search engine is a useful way to search the Internet because
you get the benefit of using more than one search engine. In practice, meta-
search engines are a case of “too much all at once.” Searches take too long.
The search results are too numerous to be useful. Most meta-search engines
can’t weed out the duplicate Web sites that appear in search results. Duplicates
appear because the search engines on which the meta-engine relies often
find the same Web site.

Meta-search engines aren’t worth a lot unless you know precisely what you
are looking for — a digital camera with a product number you can use as a
keyword or an out-of-the-way hamlet in Central America whose name is
known to very few people. Use a meta-search engine when the topic you are
researching is narrow or obscure. This way, you don’t have as many search
results to look over.
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You may well ask how search engines such as
Google and Yahoo! make any income. All search
engines do is point you to other Web sites. They
don't sell anything. They don't carry advertise-
ments. Right?

Actually, search engines do carry
advertisements — subtle ones that point you to
different Web sites. On the right side of the
Yahoo! Directory, for example, you can find
“sponsor results” Web sites. Web sites pay
search engines to make their names appear in
“sponsor results.” When you search for a topic,
sponsor-result Web sites related to the topic

How search engines earn their keep

you are searching appear under the Sponsor
Results heading. A search with the keyword
kimono, for example, yields Web sites about
kimonos, some sponsored and some not. The
thinking is that anyone who is searching for
information about kimonos will necessarily be
interested in Web sites that sell kimonos.

Some search engines place the sponsored Web
sites at the top of the list of Web sites on the
search results page. When you review search
results, make sure that you understand which
Web sites are sponsored and which are not.

Fashion and Beauty > Kimano

Diraciory = &4e = Design Ars = Fashion and Pesuty > Kimano

Search |kimono

[CATEGORIES

Citha web & just this catagors

v

s

| Search |

= SN Ml SErac e
SITC LISTINGS

Japanase fislony

® Hornage fo babure:

Lshore of Kimone. & % - onling exhiaibon 2xpionng the Tpes of Kimono warn srcaghout

= Dlack Woon: Kimone - onlirz exhibiion of kimano dating from the fate Cdo patiod tothe present
Landsrane kimonos of ibehiky Uk ata - gallery of Kubota's sasions.
aalaing the history and eustarns ol wesrdng 3 kmono

‘s abiseralions on &

2 o kirrano and Jag

Buy Kimonos &
Yukatss a1

Zsizaldess com

caszing Kimnna

Which Search Engine Should | Use?

Which search engine to use is mostly a question of which one you are com-
fortable with and which one gives you the best results (the next section in
this chapter compares and contrasts search commands in the different
search engines). Test-drive a few search engines and directories to find the
one that gets you to your destination fastest. Meanwhile, here are some
basic guidelines for choosing a search technique:

4+ Specific subject: If the subject you are researching is specific, well
defined, and probably of interest to many people, use a directory such
as Yahoo! or the Open Directory Project. Chances are, you can find Web
sites cataloged under the subject you are interested in. For example,
Web sites devoted to mysticism, ear conditions, and the Holy Roman
Empire can likely be found in a directory.

Book

Chapter 3
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4+ General subject: If the subject is likely to have been treated already by
others because it is a general subject, see whether you can find it in an
online reference. For example, information about California, Aristotle,
tsunamis, and supernovae is found in online encyclopedias. (The next
chapter in this minibook describes online references.)

4+ Narrow or unusual subject: If the subject is quite specific or unusual
and is not well known or of interest to many people, use a standard
search engine such as Google, Alta Vista, Teoma, or Gigablast. For exam-
ple, using a search engine is the best way to investigate the pirates of
Nosy Boraha, Ravensara aromatica, Von Dutch, mustache cups, and the
Pentax Optio 750Z.

One thing to consider when choosing a search engine is the incestuous rela-
tionships between the search engines. In the previous section of this chapter,
[ explain that a meta-search engine is a search engine that rides piggyback
on other search engines. It searches using other search engines and gathers
the results in one place. To some degree, most search engines are meta-search
engines in that their search results come in part from other search engines.
Google, for example, feeds search results to Ask Jeeves and AOL Search.
Teoma also feeds search results to Ask Jeeves. MSN Search and All the Web
get some of their search results from Yahoo!. The mother of all search engines,
the Open Directory Project, feeds search results to AOL Search, HotBot, and
AltaVista, as well as Google itself. (For a graphic representation of how inces-
tuous the search engines really are, take a look at the chart at this address:
www.bruceclay.com/searchenginerelationshipchart.htm.)

P Because some search engines get their search results secondhand, you may
consider using the search engines that feed the others. This way, you get
search results straight from the source. These stars light the center of the
search engine cosmos, and I suggest getting acquainted with them first if
you are new to Internet searching:

4+ Google: The Google database of mapped and indexed Web pages is said
to be the largest. Address: www.google.com

4+ Open Directory Project: This volunteer-staffed directory is highly
respected. Address: www.dmoz.org (You can also search the Open
Directory Project starting at this Google Web page: http://directory.
google.com.)

4+ Yahoo!: Yahoo! is the oldest Internet directory. Address: http://dir.
yahoo.com

Book II, Chapter 2 explains how to choose the default Internet search engine
that gets used when you click the Search button in your Web browser.



Crafting a Thorough but Precise Internet Search 12 3

Crafting a Thorough but Precise Internet Search

Unless you craft a good Internet search, your search will retrieve far too
many Web pages. You’ll have to look through many pages to find one that
is useful. You'll develop a case of Internet search syndrome, a condition in
which the eyes get blurry from staring at too many Web pages for too long.
No one wants that.

In the interest of making sure that your Internet searches are short, sweet, and

meaningful, these pages explain how to craft a good Internet search. They

describe how to conduct a search, use Boolean operators to find useful pages,

and narrow your search with advanced search commands and techniques. Book Il
Chapter 3

Formulating your search

Not that anyone has counted how many Web pages there are, but Google
alone has cataloged over 8 billion. Because there are so many Web pages and
search engines are so good at cataloging and indexing them, even a search
for an obscure topic can capture hundreds if not thousands of Web pages in
the search results. This makes searching the Internet that much harder.

Buiyaseag jauaju|
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The trick to Internet searching is to decide exactly what you’re looking for
and then craft a search that pinpoints Web pages that are useful to you. You
need to exclude the pages you don’t need but, at the same time, reach deep
into the Internet for pages that are relevant to the topic you are researching.
With respect to the topic you are researching, take these steps to embark on
a search of the Internet:

1. Imagine the ideal Web page, the one with every scrap of information
you need.

2. Think of the words that are sure to be on your ideal Web page.

For example, if you are looking for information about John Hicks, the
19th-century chief of the Seminoles, the ideal Web page would contain
the word Hicks and the word Seminoles. To find pages with both words,
you use the AND Boolean operator and these keywords (I explain Boolean
operators shortly):

hicks AND seminoles
3. Think of an exact phrase that is likely to be on your ideal Web page.

As I explain later, you can search for exact phrases — two or more
words that occur one after the other. Rather than search for hicks by
itself, you could search using this exact phrase (I've put it in quotation
marks, the convention for using exact phrases in Internet searches):

"john hicks"
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Figure 3-3:
A search
using
Boolean
operators.

4. Think of words to exclude from the search because they may bring up

Web pages that aren’t useful.

For example, the Seminole is the mascot of Florida State University. A
search for Seminoles may bring up Web pages with that school’s name,
which isn’t necessarily a bad thing, because a Florida State University
professor may have written a paper about John Hicks. But because Florida
State University is football-crazy, a search for Seminoles is likely to bring
up Web sites about football (there are a ton of those on the Internet!).
You could exclude football Web sites from the search by using the NOT
Boolean operator, a minus sign (-) placed in front of the word or phrase
you want to exclude:

-football

. Run your search.

As shown in Figure 3-3, the Internet search for information about John
Hicks, chief of the Seminoles, looks for Web pages that contain the
word seminoles and the phrase john hicks but don’t contain the word
football (entering uppercase letters in keywords isn’t necessary in
Internet searches):

seminoles AND "john hicks" -football

Google

Web |magss Goups MNews Froogle more »
seminoles AND “john hicks® -football e
[ Google Search [ I'm Feeling Lucky ] ~Andudne Lol

. Refine your search.

In a typical Internet search, you have to try, try, try again, and you craft
your search as you learn more about the topic you are investigating. You
find out which words to exclude. You discover more words to use as key-
words in the search. For example, my search for information about John
Hicks led me to his Seminole name: Tuko-see-mathla. By searching with
that name — with that exact phrase — I was able to narrow the number
of Web sites in my search results considerably. Later in this chapter,
“Using Boolean operators for searching” describes Boolean operators

in detail and explains all the different ways of narrowing a search.
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Figure 3-4:
The same
search as
Figure 3-3
using
advanced
commands.
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In a long Web page, finding the keyword — the word you are searching for —
can be a problem. Press Ctrl+F in your browser to search for a keyword in
the Find dialog box. In Google search results, you can click the Cached link
to see a copy of the Web page with all keywords highlighted.

Avoiding Booleans with advanced search commands

If you read the last couple of pages and you despaired at the idea of using
Boolean search operators, you will be glad to find out that you don’t neces-
sarily need to know or use Boolean operators to conduct a search. Everything
you can do with Boolean operators you can also do by clicking the Advanced
Search link at a search engine. Every search engine offers advanced search
commands. | suggest always using them. You can run a simple search or a
very intricate one from an Advanced Search page.

Figure 3-4 shows the Advanced Search page at Google. In the figure, I am
running the same search [ ran in Figure 3-3, but without entering Boolean
operators (Google enters the operators for me after I tell it how to search).
This page offers many ways to narrow a search. I explain all the different
ways to narrow a search later in this chapter.

GOUS[Q Advanced Search fianced Soarh T | Ao o
T sarmacles 10 et Goagle Search

with the exact phrase john nicks
with at laast one of the words
witheut |he words foatkall
Language Return pages writtan in .s-r_.' |ahiuage =|
File Farmat Only || resurn resulls of the file farmal any formal ¥
Date Return wek pages updated in the .;mlme e
Numeric Range  Retun web pages conaining numbars between ane

Qceurrances Return resuls where my temns acour snywhere n1he page ¥

[romnain Only (%] return resulis fram the sila or domain y
: e goegle cor, ong Sore sl

SafeSearch & Madilaing O Filter using SafeSearch

Using Boolean operators for searching

Boolean operators are named for their inventor, George Boole, a 19th-century
English logician. Use the operators — AND, OR, NOT, and NEAR — in Internet
searches to tell search engines how to use keywords in a search. You can
enter the operators directly in a search engine’s text box or, by going the to
Advanced Search page, choose commands and let the search engine enter
the Boolean operators for you (see the previous section in this chapter).
Enter Boolean operators in all capital letters. Figure 3-5 shows how three
Boolean operators work. The following pages explain Boolean operators
(sometimes called search operators) in detail.

Book Il
Chapter 3
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AND search
India ARC China
Finds Web pages with both the worg indiz and the word Ching,
OR search
. India GR China
. Finds Weal pages with either the ward Chineg or the word india, not necessarly both weards.
Figure 3-5:
The Boolean NOT search
operators India
AND OR Inchia WOT China
and NOT i
Finds Yveh pages vath the wors froia, but sxcludes pages i the word Crpe s alsa found
at work.
\‘&MBER Boolean operators are entered in different ways in the different search
Y

¢ engines. In Google, for example, you can enter the AND operator with a plus
sign (+) instead of the word AND. Check the instructions at a search engine’s
Web site to find out how to enter Boolean operators. In every search engine,

enter the operators in all capital letters.

AND operator

The AND operator tells the search engine to return only Web pages with all
the keywords you enter. This operator narrows the search and returns fewer
search results. Use it to make your search more specific. At some search
engines, the operator is entered with a plus sign (+). Some search engines
assume when you enter more than one keyword that you want an AND
search. Here are examples of the AND operator at work:

melungeon AND "charles gibson"
ginkgo +glycosides +flavonoids

OR operator

The OR operator tells the search engine to return Web pages if they contain
one or more keywords. This operator broadens your search. Use it in searches
for esoteric or obscure subjects that are unlikely to turn up many Web pages.
Some search engines assume when you enter more than one keyword that
you want an OR search. Here are examples of the OR operator at work:

ravensara OR "camphor laurel" OR "ravintsara oil"
"monkey's mushroom" OR "hericium erinaceus"
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NOT operator

The NOT operator tells the search engine to exclude Web pages from a
search if they contain the keywords. This operator narrows your search.
Use it to disqualify Web pages that would otherwise inflate the search
results. In some search engines, this is called the AND NOT operator. In
some search engines, you enter the NOT operator with a minus sign (-).
Here are examples of the NOT operator at work:

portland NOT maine
weverka -robert -karen

NEAR operator

The NEAR operator tells the search engine to return Web pages in which

the keywords appear within a certain number of words of each other. This
operator is like the AND operator, only more so. Use it to find Web pages
with keywords not just on the same page, but within a certain distance of
one another. As of this writing, only one search engine, Alta Vista, provides
proximity searches with the NEAR operator (see “Proximity searching,” later
in this chapter). Here are examples of the NEAR operator at work:

"david bossie" NEAR whitewater
mexico NEAR immigration

Quotation marks

Quotation marks tell the search engine to look for an exact phrase or a string
of words. (This one isn’t really a Boolean operator, but I'm including it in this
list so that you are sure to discover it.) Enclose words in quotation marks to
find a name, address, or phrase on a Web page. Here are examples of using
quotation marks to find word strings on Web pages:

"10086 sunset blvd"
"new york" AND omfug

More techniques for narrowing a search

Crafting a good search means cutting to the chase and getting only pages
that are useful to you in the search results. By using advanced search com-
mands, you can tailor a search so that it produces a good yield. Table 3-4
lists commands for narrowing a search. It tells you which search engines
offer which commands (see Table 3-2, earlier in this chapter, for the Web
addresses of these search engines). I describe commands and techniques
for narrowing a search in the pages that follow. Combine these techniques,
and you will be able to zoom like a laser beam precisely to the Web page
you need.
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Table 3-4 Search Engines’ Advanced Commands for Narrowing a Search

Name  Domain Date Language Page Web  File Region Links Similar Proximity
Title Address Type Pages

Allthe v o/ v

Web

AltaVista v v v v v

AOL v o/ v v v

Search

Ask v v v v v

Jeeves

Gigablast v/ v

Google v v / 7/ v v v

HotBot v o/ v 7/

Lycos v  / 7/

MSN v v v v o/

Search

Teoma v o/ v v v

Yahoo! v o/ v v v o/

Here’s a handy technique for narrowing the search results when you are run-
ning the Google search engine: Click the Search Within Results link at the
bottom of the search results page. You go to a Web page for searching only
the Web pages that your previous search captured.

Searching inside a domain

Search inside a domain when you want to narrow your search only to Web
pages at one Web site. Searching inside a domain is a great way to get infor-
mation if the Web site you are searching offers information of a specific kind.
For example, to get information about computers and computer programs,
you can do no better than to search pcwor1d. com, the domain owned and
operated by PC World magazine. To get information about traveling to
Madagascar, you could search the TonelypTlanet.com domain and use
Madagascar as the keyword for your search.

Don’t confuse domain searching with URL searching. Searching a URL means
to search the text in Web addresses; searching a domain means to search all
the Web pages in one Web site.
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Searching by date

Unfortunately, search engines can’t accurately tell how up to date Web
pages are. Some search engines can tell when a Web page was last modi-
fied, or edited. Others record date information merely by noting when they
catalog each Web page in their database. By-date searches are not reliable.
Still, you can try searching by date when you want recent news about a
topic.

Searching by language

Obviously, you are more likely to get information about a French-speaking
country by looking on the Internet for Web pages written in French. Language
searches turn up Web pages written in a single language to the exclusion of
other languages. Search by language if doing so can help you find information
and if you either speak the language you are searching for or you can toler-
ate computerized translations. The next chapter in this minibook describes
computerized translation services.

Searching in Web page titles

The most descriptive part of a Web page is its title. Making Web page titles
part of a search is a good way to narrow a search to Web pages of interest.
Google offers two ways to search by title, with the intit1e (in title) opera-
tor and the allintitle (all in title) operator. Enter these operators in all
lowercase letters:

4+ intitle operator: Only the first keyword (or exact phrase in quotation
marks) entered in the search box must appear in the page title; the other
keywords must or can be on the Web page itself. For example, this search
finds Web pages with Barry Bonds in the title and the word Balco or the
word steroid on the Web page (the intitle operator is followed by a
colon and no space):

intitle:"barry bonds" balco OR steroid

4+ allintitle operator: All keywords entered in the search text box must
appear in the Web page title. For example, this search finds Web pages
with the words manga and American in the title (the allintitle opera-
tor is followed by a colon and no space):

allintitle:manga american

Book Il
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Searching in Web addresses (URLs)

Searching in Web addresses, also called URLs, is similar to searching in
Web-page titles, except you search for text in the Web address of Web pages
instead of in Web-page titles. Because people choose Web addresses and
folder names that help describe where their Web pages are located, search-
ing by Web address can be a useful way to find information. Google offers
two operators, inurl (in URL) and al1inurl (all in URL), for searching the
text in Web addresses. Enter these operators in lowercase letters and follow
them with a colon and no space.

4+ inurl operator: Only the first keyword (or exact phrase in quotation
marks) entered in the search box must appear in the Web address; the
other keywords must or can be on the Web page itself. For example, this
search finds Web pages in which the name Asawa is in the Web address
and the name Ruth and the word Nihonmachi are on the Web page:

inurl:asawa ruth nihonmachi

4+ allinurl operator: All keywords entered in the search text box must
appear in the Web address. For example, this search finds Web pages
with the words lions, tigers, and bears in the Web address:

allinurl:lions tigers bears

Searching by file type

As Book I, Chapter 6 explains, file types apart from HTML files can be pub-
lished on the Internet. At some search engines, you can search for these file
types: Adobe Acrobat (. pdf), Adobe Postscript (. ps), Microsoft Word
(.doc), Microsoft Excel (. x1s), Microsoft PowerPoint (. pps), rich-text files
(.rtf), and others. For example, search by file type when you know that the
information you need is posted on the Internet in an Adobe Acrobat file.

Searching by region

At some search engines, you can search by region, usually from a drop-down
menu with the names of the different continents. If the information you want
is specific to a region or continent, you may as well search by region. Go
ahead. Give it a shot.

Searching for links

Searching for links means to find Web pages with hyperlinks that, when you
click them, take you to a certain Web page. Searching for links is a great way
to find out who or whether anyone has linked his or her Web page to one of
yours. Figure 3-6 shows a link search on the Google Advanced search page.
This search finds Web pages that have hyperlinks leading to pages at the
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address shown. You can also conduct a link search at Google with the link
operator, like so:

link:http://phatmike.motime.com

Page-Specific Search

Figure 3-6: —
A ||nk search S FindHagns wmnrcee e vt S WWALSOOgE Do Rela it
at G OOgle. Links Fitd pagas thet link to the page Ftpeifphatmike rnotins. carm Seah
Proximity searching
Proximity searching means to search for keywords that are near to one another.
Only one search engine, Alta Vista, offers proximity searches. To construct a
proximity search, enter the NEAR operator between the keywords or exact
phrases, like so:
"peter weverka" NEAR "office 2003"
Figure 3-7 shows a proximity search at Alta Vista. The search engine finds
Web pages in which the keywords are within ten words of one another. Use
proximity searches to research related ideas or to make your AND operator
searches more concentrative.
altavista
Welb TEgas MRV Adic Wideo Divaciary awrs
“zanche panza® MEAR cantinflas ﬁiﬁnﬂh
SEARGH: ( Wordwide 4 UGA  RESULIS IH: 0 All lsnguages T Eaglish, Spanich
Figure 3-7: Translate  Toolbar Shopping  Yellow Pages  People Finder  “ore »+
A proximity e e e i
search at '
Alta Vista.

Getting “similar pages”

Google offers a special command for finding Web pages that are similar to

a page whose address you enter. If you are fond of a particular Web page,
Google may be able to find its cousins, uncles, and aunts, which you may
find just as useful or enjoy just as much. Look for the Similar text box on the
Google Advanced Search page (refer to Figure 3-6).
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Searching the “Invisible Web”

A\

The so-called invisible Web is the part of the Internet that search engines
can’t penetrate. This part of the Internet is private, either because entering
requires permission or entering requires a subscription. As I explain earlier
in this chapter in “How standard search engines work,” search engines troll
the Internet, gathering information about Web sites by going from link to
link. But in the case of the invisible Web, there are no links to follow. This
part of the Internet has been walled off. It consists of private resources —
mostly databases such as Lexis-Nexis, UMI Proquest, Infotrac, and JSTOR —
that are privately held. The good news about these databases is that, after
you’ve found them, most have excellent searching tools.

Here are some Web sites for searching the invisible Web:

4+ Complete Planet: “Discover over 70,000+ searchable databases and spe-
cialty search engines,” this Web site claims. A search starting here brings
up a lot of dreck as well as useful stuff — you’ve been warned. Address:
http://aip.completeplanet.com

4+ GPO (Government Printing Office) Access: Search databases main-
tained by the United States government, including annual budgets, bills,
and government manuals. (Also try searching Google Uncle Sam at this
address: www.google.com/unclesam.) Address: www.gpoaccess.gov/
multidb.htm]l

4+ InfoMine: Search databases of use to scholars and academic researchers.
Address: http://infomine.ucr.edu

4+ The Invisible Web Directory: This directory divides the invisible Web into
several broad categories for searching — Library Catalogues, Health and
Medicine, Public Records, and others. Address: www.invisible-web.net

To search the invisible Web, search by category and subcategory. A keyword
search for a specific topic is likely to swamp you with far too many search
results. See “Discovering Specialty Search Engines,” in the next chapter of
this minibook, for a list of more search engines that can help you penetrate
the invisible Web.

Evaluating Whether Information at a Web Site Is Valid

If “don’t believe everything you read in the newspaper” is true, and civilized
people think it is, then “don’t believe everything you read on the Internet” is
the undisputed truth. Most newspaper articles, at least, are fact-checked by
editors, but any fool can post anything on the Internet and be certain that
somewhere another fool will read and believe it. You owe it to the people
who will make use of research you do on the Internet to make certain you
get the facts straight. And that begs the question: How do you know whether
it’s genuine? How do you know whether what you read at Web site is valid?
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You can start by examining the Web site itself. [ don’t mean to be a snob,
but a sloppy Web site with grammatical errors and many misspellings is
automatically suspect. Next, consider the motive of the people who con-
structed the Web site. Many sites have a commercial motive. Others are
pushing a political agenda. These Web sites have ulterior motives and
should be regarded skeptically.

Is the information on the Web site up to date? News about technology and
political news, for example, gets stale quickly. Online articles should be
marked with the date of publication in plain display. Without the date, it’s
hard to tell how relevant an online article is. A Web page with a number of
dead links — hyperlinks that lead nowhere — is most assuredly out of date
and doesn’t deserve your attention.

Another thing to consider is how close the information is to the original
source and whether sources are cited. The Internet can be like Telephone,
the children’s game in which one person whispers a word or two into the
next person’s ear, the next person whispers into the next person’s ear, and
so on, until the original message turns into something completely different.
Unless the author or publisher of a Web page can cite a source or preferably
give a hyperlink to the source, how do you know what you're getting isn’t
innuendo or hearsay?

Maybe the best way to judge whether information at a Web site is valid is to
use your intuition. What does your gut tell you? When someone stops you on
the sidewalk with a long tale about needing a quarter to make a phone call
because the car has broken down on account of the rain, et cetera, et cetera,
you can usually tell right away whether you’re being conned. You just know.
The same is true when judging the validity of a Web site.
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Chapter 4: Advanced Tools for
Scholars and Researchers

In This Chapter

v Using a specialty search engine

v+~ Taking advantage of the Google Toolbar

1 Searching the Internet for images, audio, and video files
v Getting answers from a Google researcher

v Translating text from one language to another

Fis chapter picks up where the previous one left off and explains com-
mands and techniques for the advanced searcher. In this chapter, you
discover a handful of specialty search engines designed for looking into
particular parts of the Internet — the sciences, technology, the law, and
others. You also find out how convenient the Google Toolbar really is and
how to search for images, video files, and audio files on the Internet. Finally,
this chapter looks at online translation services and explains how you can
search your computer with Google as well as search the Internet.

Discovering Specialty Search Engines

Specialty search engines, sometimes called vertical search engines, look into
one aspect of the Internet — for example, science, the law, engineering, or
the humanities. Most specialty search engines offer advanced commands to
make searches more accurate. Table 4-1 describes specialty search engines.
If the subject you're interested in happens to be, well, special, you're in luck.
Chances are, a specialty search engine can take you precisely where you
want to go.
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Table 4-1 Specialty Search Engines

Name Address Description

All-Purpose

DOAJ http://www.doaj.org Search the Directory of Open

Access Journals for scholarly and
scientific articles.

Google Scholar

http://scholar.google.com

Search for scholarly literature —
theses, abstracts, peer-reviewed
papers, and technical reports.

INFOMINE http://infomine.ucr.edu Search “124,710 academically
valuable resources” in nine
categories.

LookSmartFind www.findarticles.com Search for articles by topic, by

Articles author name, or in selected
publications.

SMEALSearch  http://smealsearch?. Search the Academic Business

psu.edu

Literature Library for business
documents about a subject or by
a specific author.

Computers and Technology

Google Apple/  www.google.com/mac Search the Internet for information

Macintosh about Macintosh computers.

Search

Google BSD www.google.com/bsd Search the Internet for information

Search about BSD (Berkeley Software
Distribution) open-source operat-
ing systems, including Unix.

Google Linux www.google.com/Tinux Search the Internet for information

Search about the Linux operating system.

Google www.google.com/microsoft  Searchthe Internet for information

Microsoft about Microsoft software.

Search

Tech Search www.techweb.com/search/ Search six computer publications.

advancedSearch. jhtml
Economics
WebEc www.helsinki.fi/WebEc Search the Internet for information

about economics with the search
engine or by browsing in the
directory.
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Name Address Description

Health and Medicine

Combined http://chid.nih.gov/ Search a bibliographic database
Health simple/simple.html from health-related agencies of

the federal government.

Merck Manual

www.merck.com/mrkshared/
mmanual/home.jsp

Search by disease name or symp-
tom name in the Merck Manual, a
physician’s desk reference.

MedHunt www.hon.ch/MedHunt Search for health care information
on the Internet.
PubMed www.ncbi.nlm.nih.gov/ Search the National Library of
entrez/query.fcgi Science’s 15 million citations for
biomedical articles dating to the
1950s.
RxList www.rxlist.com Search by name or imprint code

for information about drugs.

The Humanities

Artcyclopedia

www.artcyclopedia.com

Search museum Web sites by
artists’ names, artwork names,
and museum names.

Art Bridge www.art-bridge.com Search a directory with cate-
gories ranging from Art History
to Tribal Art.

Project www.gutenberg.org/catalog Searchthe online library for

Gutenberg 7,000 different books, most of

them classics published prior
to 1950.

Social Science

http://sosig.esrc.bris.

Search for information related to

Information ac.uk the social sciences, business,

Gateway and law.

Voice of the http://vos.ucsb.edu Research online Web sites

Shuttle pertaining to the humanities —
art, literature, philosophy, and
more. Offers a directory and a
search engine.

Law

FindLaw http://lawcrawler.find Search for information about

Taw.com

laws, cases, and codes.

(continued)
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Table 4-1 (continued)

Name

Addvress

Description

Science, Math, and Engineering

Cite Seer

http://citeseer.ist.
psu.edu

Search for literature about com-
puter and information science.

Internet Guide
to Engineering,

www.eevl.ac.uk/index.htm

Search full-text online scientific
journals selected by the editors

Mathematics, for relevance and quality.

and Computing

NASA Image http://nix.nasa.gov Search among the 300,000
Exchange images in the NASA databases.
NatureServe www.natureserve.org/ Search a database with informa-
Explorer explorer tion about more than 60,000 plants,

animals, and ecosystems of the
United States and Canada.

Online Journal
Search Engine

Www.0Jjose.com

Search scientific publications in
in 60 databases.

SciCentral www.scicentral.com Search for recent news in several
scientific disciplines.
Scirus WwWw.Scirus.com/srsapp Search over 167 million

science-related Web pages.

By the way, the specialty search engines listed in Table 4-1 are by no means
the only ones on the Internet. Book VIII, Chapter 2, for example, describes
specialty search engines for finding airline tickets and hotel rooms. Some
people believe that Internet searching technology is in its infancy, and as
search technology is refined in the coming years, we are soon going to see
many more specialized search engines.

Finding Out about the Google Toolbar

If you are a fan of Google, consider using the Google Toolbar, as shown in

Figure 4-1. This toolbar makes it possible to do just about anything you can
do with the Google search engine without visiting the Google Web site. The
toolbar is there at the top of your browser, ready and willing to provide you
with a Google service at a moment’s notice.

Installing the Google Toolbar

To install the toolbar, go to this Web-site address: http://toolbar.google.
com. Then click the Download Google Toolbar button. You will be asked



Figure 4-1:
The Google
Toolbar.
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whether you want to disable or enable advanced features. If you enable the
advanced features, you can see a page’s rank on the Google Toolbar when
you surf to the page. However, to gather this ranking information, Google
tracks users’ surfing habits. What the advanced features question really asks
is whether you consent to sending information about your surfing behavior
to the Google database. Google uses the information to compile data about
people’s surfing habits.

| Google~ w| Epseachwen < gl PRkl o Bhopicied T agcRil waoptos Nesr
“aakegkt 2l » Search Web Cachesl Snapshot of Fage
_:h’;_"“’f_m" I Curtent Site Similar Pages
oot I'm Faaling Lucky Backwari Links
“gnnghe restorches” Google Images Translate Into English
“aercming = ceecle resss - _
“ascoming ¢ grekys resea Goagle Groups
googk unde san’ Web Directory
westber underground Seaich News
vauw durmeves,com
F = Search Froogle
DHetionary
Stock Quotes
Linux
BSI Unix
US Government
Apple Macintosh
Micrasoft

To turn off the Google Toolbar, right-click any empty place on any toolbar in
your Web browser and deselect the Google option. To remove the Google
Toolbar, do it as though you were removing a computer program. Choose
Starte>Control Panel=>Add or Remove Programs. Select Google Toolbar in the
Add or Remove Programs dialog box, and click the Change/Remove button.

If you've installed the Google Toolbar, you can conduct a search without
manually entering keywords. Either double-click a word on a Web page or
drag across words to highlight them, and then right-click and choose Google
search to run a search.

Using the Google Toolbar

The Google Toolbar is essentially a way to search with Google without visit-
ing the Google Web site. You can find these amenities on the Google Toolbar
(refer to Figure 4-1):

4+ Google menu: A drop-down list for going directly to Google.com and its
various pages.

4+ Search Terms text box: A text box for entering search terms and
embarking on a new search. Press Enter after you enter a keyword.

4+ Search Web: A drop-down list for conducting a specialty search with
Google. Choose Google Images, for example, to search for images.
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4+ News: Click this button, which is to the right of the Search Web drop-

down list, to go to the Google News Web site and see what’s happening
in the world.

PageRank: Displays the page ranking (if you enable the advanced fea-
tures of the toolbar).

Blocked: Click this button to allow or disallow pop-up ads from appear-
ing when you visit this Web site. Allowing pop-ups with this button does
not override your browser settings.

AutoFill: Click this button to enter your address, name, and credit card
information automatically on Web forms. Click the Options button and
fill in the AutoFill tab of the Toolbar Options dialog box to provide the
Google Toolbar with your name, address, and credit card information.

Options: Click this button to open the Toolbar Options dialog box and
choose which buttons appear on the Google Toolbar (the Options tab),
to describe your search preferences or add more buttons (the More tab),
or to enter AutoFill information (the AutoFill tab).

Highlight: Click this button to highlight keywords from your search on
the Web page you are viewing. This is an excellent way to locate the
information you need on a Web page.

Find Next Occurrence: Click this button to jump from search term to
search term on a Web page. The button is named after a keyword you
entered.

By the way, Google isn’t the only search engine to offer a toolbar. You can
also find the Yahoo! Toolbar (http://toolbar.yahoo.com), the Dogpile
Search Toolbar (www.dogpile.com/info.dogpl/tbar), and the AltaVista
Toolbar (www.altavista.com/toolbar).

Making Google the Internet Explorer
default searcher

When you click the Search button in Internet Explorer, which search engine
appears by default in the Search pane, the panel on the left side of the window?
You can click the Customize button in the Search pane and choose a search
service, but Google is conspicuously absent from the list of services you can
choose from. If Google is your favorite search service and you want Google
search options to appear when you click the Search button in Internet Explorer,
follow these steps:
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1. Click the Options button on the Google Toolbar.

2. Select the More tab in the Toolbar Options dialog box.

3. Select the Use Google as My Default Search Engine in Internet

Explorer check box.
4. Click the OK button.

On the subject of Internet Explorer, you can attach special Google buttons to
the Standard Buttons toolbar in Internet Explorer: The Google.com button
takes you to the Google home page, and the Google Search button runs a
search on a word or group of words you highlighted. To add these buttons
to Internet Explorer’s Standard Buttons toolbar, go to this Web address:
www. google.com/options/buttons.html. It explains how to attach the

buttons to Internet Explorer.

Googlewhacking

A Googlewhackoccurs when a search with the
Google search engine turns up only one Web
page. In Googlewhacking, players enter key-
words in Google with the aim of producing a
single, solitary Web page in the Google search
results. At Googlewhack (www. googlewhack.
com), Googlewhacking's official Web site, you
can read a list of keyword combinations — for
example, shantytown diddler, serpentine dicky-
bird, and panda nosebags — that have produced
Googlewhacks.

Ironically, a Googlewhack ceases being a
Googlewhack afteritis recorded at the Google-
whack Web site because from that point
forward, the keyword combination that pro-
duced the Googlewhack appears on more than
one Web page. Here are the official rules
of Googlewhacking according to the game’s
Web site:

v All keywords you enter must be legitimate
words found in the online dictionary at
http://dictionary.reference.com.

+ You may not enter exact phrases in quota-
tion marks.

v If the keywords appear in a list — an
encyclopedia, glossary, or thesaurus, for
example — the search doesn't count as a
Googlewhack.

Google has inspired a number of oddball games
besides Googlewhacking. You can also find
Google-bombing (described in the previous
chapter of this minibook), Googlelaar
(www.northernlake.com/googlelaar),
GoogleFight (www.googlefight.com), and
The Random Google Page (www.bleb.org/
random), but none is as odd as elgooG
(www.alltooflat.com/geeky/elgoog/m/
index.cgi), a backward Google Web page.
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Searching for Images, Audio, and Video

As you know if you've spent any time exploring the Internet, Web pages are
apt to include images as well as text. And some Web pages offer video and
audio as well. Suppose you want to purloin one of these multimedia files for
your personal use. You need a photograph of a shiitake mushroom for a
PowerPoint presentation. You need a video of a wave crashing to illustrate
your ideas about next year’s stock market behavior. Maybe you just want to
see a video of a late-breaking news event.

Unfortunately, searching the Internet for multimedia files can be a hit-or-miss
affair. Be prepared to spend time browsing through Web pages until you find
a suitable image or file. Search engines index media files according to their
filenames and proximity to words on a Web page. You can’t really search by
keyword for multimedia files except when the keyword name happens to
have the same name as a file. As shown in Figure 4-2, for example, a search
for butterfly images with the keyword butterfly finds image files with butterfly
in their names as well as assorted other images, depending on the search
engine’s criteria for indexing image files.

‘Wabo Images  Groups  Mews  Froogls  Lesal™™  Des<top  more s
Google w.s
Images hiaderate SafeSaarch ic or
Images Reaults 1- 20 oF abaut 495,000 for butterfly [defintion]. (013 sacends)

Show: Al sizes - Largs - Madiym - Smal

Tip. Sewe tima by hiting tha ratum key instaad of clicking on “sesmch’

Blki2Z.ail ors |gr-\-butterﬂyjpg butterfly jpa ce-moth butterfly ol

A58 ESE per 1 800 « EOD pixels - SEE & 240 pixels - 107k 4B5 % 803 gixels - 14k
U\U\r ETET .’ 3 b vstre :Ie-' digtiopoeticoweblog com.pt!  wwnenpe gowbafffgraphicss cb-

paesiebuchdd A0, Kl moth¥20katiarfly. gif
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Searching
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Table 4-2 lists search engines that are capable of searching for multimedia
files. In my experience, Google Images is the best choice for searching for
images; AltaVista and Singingfish are the best for searching for video. At
AltaVista and Singingfish, you can search by file type for .avi, .mpeg, .mov,
QuickTime, or .wma videos. When searching for audio, best of luck to you. I
know of no search engine that does an adequate job of searching for audio
files. Find Sounds is fine for what it is, but it only finds short .wav files.

Table 4-2 Search Engines Capable of Searching for Multimedia Files

Search Web Address Images Uideo Audio Notes

Engine

Allthe Web www.alltheweb.com v v v Click the Pictures, Video,
or Audio link on the All
the Web home page.

AltaVista ~www.altavista.com v v v Click the Images, MP3/
Audio, or Video link on
the Alta Vista home page.

AOLSearch http://search.aol. v Click the Images link

com/aolcom/image_ on the AOL Search
home. jsp home page (http://
search.aol.com).

Ask Jeeves http://pictures.ask.v Click the Pictures link

com/pictures on the Ask Jeeves home
page (www.ask.com).

FindSounds www. findsounds.com v Search the Internet for
.wav sound effects.

Google www.google.com/imghp v Click the Images link on
the Google home page
(www.google.com).

Ljudo www.1judo.com v Get sound effects from
this Web site.

Lycos www.lycos.com v v v Click the Advanced
Search link on the Lycos
home page and then
click the Multimedia tab.

Singingfish http://search. v v On the left side of the

singingfish.com window, choose which
kind of files to search for.

Yahoo! http://gallery. v Search by keyword or

Picture yahoo.com by category for pictures

Gallery

and photographs.
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Asking a Google Expert

By the way, if you come across a multimedia file during your adventures
on the Internet and you want to copy it to your computer, follow these
instructions:

+ Image: Right-click the image and choose Save Picture As. In the Save
Picture dialog box, choose a folder for storing the image and then click
the Save button.

4+ Video: Right-click the video image — not the image as it plays, but the
still image of the video on the Web page — and choose Save Target As.
The Save As dialog box appears. Choose a folder in which to store the
video file and click the Save button.

4+ Audio: Right-click the button or link that starts playing the audio file and
choose Save Target As. Then save the file in the Save As dialog box.

This talk of grabbing images, video, and audio from Web sites brings up an
important topic: copyrights. Files you take from the Internet were lovingly
created by someone, and they belong to their creator. You can use them only
under the “fair use” provisions of the copyright laws. These provisions don’t
allow you to use an image, video, or audio file on a Web site without the cre-
ator’s permission. One way to find out who owns material is to go to Whols.net
(www.whois.net) and enter the name of the Web address with the copyright
material you need. You may be able to find the owner’s name that way.

Asking a Google Expert

As fine as the Internet is, sometimes you can’t get an answer by searching
the Internet, and you have to seek the help of a live, human expert. You can
do that by enlisting the services of Google Answers. Google Answers main-
tains a staff of researchers who are paid to answer questions from registered
Google members. It costs 50 cents to post a question. Obtaining an answer
costs between $2 and $200, depending on how much you are willing to shell
out. Three-quarters of this fee goes to the researcher and one-quarter goes
to Google.

To explore the Google Answers Directory, a directory of already-asked
questions and already-given answers, you must have a Google account
(see Appendix C). To post a question, you must provide Google with your
credit card name and number as well.



Figure 4-3:
Questions
posted to
the Google
Answers
Directory.
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Either of the following methods takes you to the Google Answers home page:

4+ Go to the Google home page (www.google.com), click the More link and,
in the Google Services window, click the Answers link.

4+ Open your Web browser to this address: http://answers.google.
com/answers.

Google Answers isn’t the only Web site where you can get advice from a
living, breathing expert. You can also try out AllExperts at this Web address:
www.allexperts.com.

Exploring the Google Answers Directory

At the bottom of the Google Answers home page is a directory with ten cate-
gories called the Google Answers Directory. Explore one of the categories or
conduct a search to get a sense of the questions being asked and answered.
As shown in Figure 4-3, some answers are rated. A five-star answer is consid-
ered very satisfactory. Notice the prices and the number of days remaining
for questions to be answered. Anyone with a Google Answers account can
comment on a question.
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Logging in to your Google Answers account

To log in to Google Answers, click the Log In link on the Google Answers home
page. The first time you log in, you are asked to create a Google Answers
account. Choose a nickname, choose an e-mail notification option, accept
the terms of service after you read them, and click the Create My Google
Answers Account button.

You go to your Account page. No matter where you travel in Google Answers,
you can get to this page by clicking the My Account link. Your Account page
offers three tabs for managing your account:

4+ My Questions: See a list of questions you asked, questions that are
awaiting an answer, or questions that were answered.

4+ My Profile: Change your personal and credit-card information, as well as
choose how to be notified by e-mail when a question is answered.

4+ My Invoices: See what you were charged for submitting questions and
getting your questions answered.

Asking a question

To ask a question, enter it in the Google Answers home page and click the
Ask Question button. On the following page, enter the subject of your ques-
tion, choose a category, and name your price. The higher the price, the more
likely your question will be answered. The first time you ask a question,
Google requests that you provide credit-card information. Your question is
posted immediately.

The answer will arrive by e-mail if you opted to be notified by e-mail when a
question is answered. Whether you want the answer delivered by e-mail, be
sure to revisit your question in the Google Answers Directory to see if it has
received any comments.

Online Traunslation Services

No, translation services on the Internet are not up to the task of doing your
French or your Spanish homework for you. Computers are only machines.
They have no native concept of language, as Figure 4-4 shows (this transla-
tion of Shakespeare’s “All’s well that ends well” is rendered in Spanish into
something like “All’s flow that flow to the extremities”). You can, however,
cut or copy text from a document or Web site and get an approximate trans-
lation of the text at one of these Web sites:

4+ Babel Fish Translation: Type or paste the words in the Translate a
Block of Text box, choose a From and To language combination from



Figure 4-4:
Translating
from English
to Spanish at
Babel Fish.
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the drop-down menu, and click the Translate button. Address: http://
world.altavista.com

4+ Google Language Tools: Type or paste the words in the Translate Text
box, choose a From and To language combination, and click the Translate
button. (You can also get to this Web page by going to the Google home
page at www.google.com and clicking the Language Tools link.) Address:
www.google.com/language_tools

a th_; ista

Jated Text G2

Home » Tools » Babel Fish Translation » Tr

O Help

En esparfiol:

All's manan gue manan los extremaos.

[ Search the web with this text ]

Translate again - Enter up ko 150 vords
All's well that ends well.

Usze the World Keyboard to enter 4 or Cyrillic charack

:“Er@i.ish to E;panish [

Sponsored Matches

Perilla's Mew Spanish Eves Tour

An elegant 12-day, all-inclusive tour visiting Madrid, Cordoba, Sewlle,

Costa del Sol, Granada and more. One low price covers all, including free

domesiic air coast to coast.

o perillotours.com |

Babel Fish Translation and Google Language Tools both have commands for
translating an entire Web page from one language to another. Enter the Web
address of the page you want to translate, choose a language combination,
and click the Translate button. The Web page appears, but it’s rendered in
the language you chose, not its original language. In my experiments with
Babel Fish Translation and Google Language Tools, Web-page translations
were identical, which leads me to think both services run the same transla-
tion software.

Google Language Tools does something that Babel Fish can’t do: translate
Web pages into English as they are found in search results. On the Google
Language Tools page, choose a language on the Search Pages Written In
drop-down menu, enter keywords for a search, and click the Google Search
button. In the search results, click the Translate This Page link to read the
Web page in English.
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Desktop Search: Searching your
computer with Google

The Windows Search command isn't the best.
The command is supposed to search your com-
puter for files or text within files, but it doesn't
do a very good job. In my experience, at least,
it often overlooks files, even when the files are
right under its nose.

As of this writing, Google is developing a soft-
ware program for searching a computer’s hard
drive using Google search techniques. The pro-
gram is called Desktop Search and, I'm happy
to report, it works great. The program is a big
improvement over the Windows Search com-
mand. (Microsoft is playing catch-up and is
developing a desktop search program of its own
called the MSN Toolbar Suite. You can read
about it at this address: http://beta.
toolbar.msn.com.)

Here are instructions for downloading and
using Google's Desktop Search:

+* Downloading the software: Go to the Web
site at this address and click the Agree and
Download button: http://desktop.
google.com. As soon as the installation
is complete, you see a Set Preferences
Web page. Choose how you want Google
Desktop to work (you can change your
mind later), and click the Set Preferences
and Continue button. Then click the Start

Searching button so that Google can start
indexing the files on your computer —
making a map of what is inside it. Indexing
may take several hours, but you can work
on your computer while Google indexes its
contents in the background.

Starting Desktop Search: Click the Google
Desktop Search shortcut icon on your
Windows desktop or choose Start>All
Programs=>Google Desktop Search. Your
browser opens to the Google Desktop
Search page. It looks and works just like
the Google home page.

v Running a search: Enter a keyword or key-
word combination, and click the Search
Desktop button. You can use search opera-
tors and conduct an exact search. If files
are found, they appear in a search results
page. The page tells you where on your
computer the files are located. Files are
listed by date, with the most recently opened
atthe top of the list. You can click a filename
to open a file.

v~ Declaring your search preferences: Click
the Desktop Preferences link on the Google
Desktop Search page and choose how you
want to search in the Preferences window.

Weh Images Groups

antioxidant AND "dimethyl sulfoxide”

Goagle

Desktop Search

Mews Froogla

Desktop  mote o

Daddop Preterences

| Search Deskiop .|

Search the Web

Search your own computer.




Chapter 5: The Internet as a
Reference Library

In This Chapter

v Finding general-purpose resources
v~ Finding online encyclopedias, dictionaries, and thesauruses
1 Searching for people on the Internet

v Looking up phone numbers and addresses on the Internet

M any of the cumbersome reference books found on the shelves of the
library can be found on the Internet. I'm not suggesting that you
forgo a trip to the library the next time you need to consult a reference
book, because the walk may do you good and I'm of the opinion that people
already spend too much time in front of electronic devices like computers
and televisions. Still, if you're in a hurry, you may as well consult one of the
online references described in this chapter.

In this chapter, you discover where to find online encyclopedias, dictionaries,
and thesauruses, as well as how to find lost friends and look up telephone
numbers and addresses anywhere in the world.

Finding General-Purpose Information

First, here are a few general-purpose Web sites where you can get statistics
and information about a range of topics:

4+ FedStats: Starting at this Web site, you can search United States govern-
ment databases for statistics about different states or from different
federal agencies. Address: www. fedstats.gov

4+ How Stuff Works: How Web servers, time, and the Bugatti Veyron’s
16-cylinder engine work are among the many subjects you can find at
this remarkable Web site, which offers easy-to-understand explanations
of many different topics. You can search by topic in the search text box
or search by browsing, as shown in Figure 5-1. Address: www.howstuff
works.com
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4+ InfoPlease: This Web site is a sort of old-time country store for
information — it offers a little bit of everything, including an almanac,
encyclopedia, atlas, and thesaurus. Address: www.infoplease.com

4+ Nation Master: “Where facts come alive!” this Web site boasts. What
makes this place special are the comparison graphs and charts. Compare
nations by longevity rates, productivity, and other criteria, and see the
results in the form of a chart, not a boring statistical table. Address:
www.nationmaster.com

4+ Statistical Abstract of the United States: This is the U.S. Census Bureau’s
statistical abstract of the United States divided into 32 categories, from
population to industrial outlook. Address: www.census.gov/prod/www/
statistical-abstract-us.html
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The Internet has relieved the strain of many bookshelves across our land.
No longer do as many bookshelves creak and groan from having to support
many-volume sets of encyclopedias, hefty dictionaries, and thesauruses. The
pages that follow explain how to find the online editions of reference books.

Encyclopedias

You are hereby invited to dip into one of these online encyclopedias when
you have a question that’s begging to be answered:
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Britannica Online: Fncyclopcedia Britannica is the old warhorse of
encyclopedias; this is the online edition. For $70 per year or $12 per
month, you can read full articles in all 32 online volumes. Address:
www.britannica.com

Encyclopedia.com: At last, a free online encyclopedia! Many of this Web
site’s 57,000 articles come from the Columbia Encyclopedia, Sixth Edition.
Address: www.encyclopedia.com

MSN Encarta: With all its resources and wealth, Microsoft ought to be
able to offer a better encyclopedia than this one. Besides text articles,
Encarta offers pictures and short videos, but you have to be a subscriber
to get the good stuff. Subscribing costs $5 per month or $30 per year.
Address: http://encarta.msn.com

Wikipedia: In computer jargon, wiki is the term for software that allows
collaborative writing at a Web site or blog (the word comes from the
Hawaiian for “quickly”). Wikipedia, shown in Figure 5-2, is an online
encyclopedia that anyone can read, edit, and help write. It is also a quite
interesting ongoing experiment in collaborative writing. Definitions of
anything having to do with computers or technology are excellent; avoid
the political. (For those who are interested, Wikipedia also offers a thing
called a wiktionary, a collaboratively written dictionary. You can find it
athttp://en.wiktionary.org). Address: http://en.wikipedia.org
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Dictionaries

Next time someone tells you, “I don’t know, why don’t you look it up?” look it
up in one of these online resources:

4 Acronym Finder: Acronyms, like moss and certain kinds of fungi, keep
spreading and taking over more of the earth. Go to this Web site when
you are stumped for the meaning of an acronym, a word formed from the
successive first letters of other words. Address: www.acronymfinder.com

4+ Merriam-Webster Online: This is the online edition of the old standby
dictionary. You can also use the thesaurus starting at this Web site.
Address: www.m-w.com/dictionary.htm

4+ OneLook Dictionary Search: This Web site is a meta-search engine of
dictionaries. Enter a word and click the Search button. You get a list
of dictionaries on the Internet that offer definitions of your word. Click
a dictionary name to go to the online dictionary and read the definition.
Address: www.onelook.com

4 Online Slang Dictionary: Go to this Web site to decode the speech
of your children, nephews, and nieces. You can find a dictionary of
American slang. (For English slang, check out A Dictionary of Slang at
www.peevish.co.uk/slang). Address: www.ocf.berkeley.edu/
~wrader/slang

4+ Your Dictionary: This online dictionary doesn’t have anything over the
other dictionaries listed here. [ include it in the list because it can send
you a word and its definition each day if you register and are good enough
to give it your e-mail address. I'm fond of getting my word of the day in
the mail. My vocabulary is increasing. Address: www.yourdictionary.com

Here’s a quick way to get a word definition: Use the define operator in Google
(www.google.com). Enter define, a colon (:), and then, without entering a
blank space, the word that needs defining. After you click the Search button,
Google gives you a list of Web sites with definitions of the word you entered.
For example, enter the following in the Google search text box to find defini-
tions of the word spyware:

define:spyware

Thesauruses

Rooting around in a thesaurus for a good synonym isn’t what it used to be
now that word-processing programs have built-in thesauruses. In Microsoft
Word, for example, you just have to click a word for which you need a syn-
onym and press Shift+F7 to get a list of synonyms for the word. Still, the
paltry list of synonyms you get from a word processor can’t compare to the
synonym lists you can get at these online thesauruses:



Figure 5-3:
The Visual
Thesaurus.
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4+ Thesaurus.com: This is the online edition of Roget’s Thesaurus, every-
body’s favorite thesaurus. Address: http://thesaurus.reference.com

4+ The Visual Thesaurus: This thesaurus could use some improvements.
The application that runs it works too slowly for my taste. I include it in
this book because it is such an interesting idea. Instead of synonyms
appearing in a list, they appear in constellation, with lines showing the
words’ relationships with one another, as shown in Figure 5-3. You can
look up five words in the Visual Thesaurus before you have to pay to
download the software. Address: www.visualthesaurus.com
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Looking up quotations

A good quote is a great way to enliven a speech. When you’re hunting for a
good quote, go to these hunting grounds:

4+ Bartleby Quotations: You can look up quotations with keywords at this
Web site. Address: www.bartleby.com/quotations

4+ The Quotations Page: Starting here, you can search by keyword or by
author name. Address: http://quotationspage.com

I'm not sure where to put the next highly unusual Web site in this book, so |
may as well put it here. At the Speech Accent Archive (http://classweb.
gmu.edu/accent), you can hear some 400 examples of different accents,
from Afrikaans to Zulu. Says the Web site, “This site examines the accented
speech of speakers from many different language backgrounds reading the
same sample paragraph. Currently, we have obtained 399 speech samples.”
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Finding Lost Friends and Lovers

You’'re supposed to be able to find everything on the Internet. Does that
include long-lost friends and lovers? Maybe. You can try your luck with these
lookup services. At some of these Web sites, you can pay a fee to run a back-
ground check or criminal-history check on someone. You can also trace old
telephone numbers and addresses at these sites:

+

<+

+

Docusearch: This is an online detective agency. Says the Web site,
“Docusearch is as intrusive as you need us to be. We investigate the
identity, reputation, conduct, affiliations, associations, movements, and
whereabouts of just about anyone.” Address: www.docusearch.com

Intelius: The motto at this Web site is “We know.” For some lookups, you
can get ages and birthdays. Address: http://find.intelius.com

Yahoo! People Search: Search by first and last name. Address:
http://people.yahoo.com

Looking Up Phone Numbers and Addresses

The days of the bulky telephone book are coming to an end, thanks to the
Internet. Next time you want to look up a telephone number or address, look
it up online at one of these Web sites:

+

<+

Anywho: This online directory is owned and operated by AT&T. Address:
www.anywho.com

International White and Yellow Pages: A directory for looking up
addresses and telephone numbers in all continents except Antarctica.
Address: www.wayp.com

Phonenumber: Offers a reverse telephone and reverse address direc-
tory. Enter a phone number or address, and you get a person’s name,
if it’s available. Address: http://www.phonenumber.com

Reverse Phone Directory: This one specializes in reverse telephone
number and address lookups. Address: www.reversephone
directory.com

Smartpages: This is SBC’s online directory. You can also get maps, driv-
ing directions, and city guides. For a fee, you can look up someone’s
criminal history or run a background search on someone. Address:
http://smartpages.com

White Pages: Offers people searching, as well as reverse address and
telephone number lookups. Address: www.whitepages.com



\\J

Looking Up Phone Numbers and Addresses 155

You can look up phone numbers and addresses in Google by using the
phonebook operator (for looking up residences and businesses), the
rphonebook operator (for looking up residences), or the bphonebook
operator (for looking up businesses). At Google (www.google.com), enter
the operator name, a colon (:), and without entering a blank space, a name
followed by the two-letter abbreviation of a state. For example, this search
finds people named Dexter Donovan in California:

phonebook:dexter donovan ca

If you want to opt out of the Google Address book so that your name doesn’t
come up in searches, go to this Web address: www.google.com/help/pb
removal.html.
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Chapter 6: Read All about It

In This Chapter

v~ Using aggregators to gather the news

1 Getting the latest news in a Google alert
v Searching for news in a search engine
v~ Visiting a news portal

+* Reading newspapers online

1 Getting the news from abroad

Long before the Internet, radio, and television, late-breaking news was
delivered by newsboys on the street. They shouted, “Extra! Extra! Read
all about it!” to peddle the extra editions of their newspapers. An extra edi-
tion was a special edition of the newspaper published in the late afternoon,
especially to cover a late-breaking news story of importance.

The Internet offers many different ways to “read all about it.” This chapter
starts by looking at an exciting innovation in Internet news called an aggre-
gator. Aggregators are special programs that collect headlines and story
summaries from many news sources so that you can get the latest news
without having to travel here, there, and everywhere on the Internet. This
chapter also shows how to enlist the help of Google to get the latest news in
the form of alerts — e-mail messages sent to you. You also discover search
engines designed especially for finding news, news portals, and good
sources of foreign news.

Gathering the News with an Aggregator

News fiends who make it their goal to keep up with the latest news get their
news from many different Web sites. They get late-breaking news from one
place and sports news from another. They get local news from the local
daily and financial news from an online financial newspaper. They read their
favorite columnists on different Web sites. Some of them even get news from
blogs. To catch up on the news, they have to visit many different Web sites.

But instead of going to different Web sites to get the news, what if you could
get the news to come to you? Computer programs called aggregators and a
new Web standard called RSS, or Really Simple Syndication, are making this
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possible. Using an aggregator, you can capture dozens of headlines and story
summaries, as shown in Figure 6-1. When you see a headline that interests
you, you click it in your aggregator and open a Web page to read the story.
Aggregators are convenient. They save time. And they save you the trouble of
searching different Web sites for news that matters to you, because you can
view part of what is on a Web site — the headlines and story summaries —
without actually having to visit the site.

These pages explain how aggregators work, how to subscribe to a Web site
with an aggregator, and how to use the Bloglines and Yahoo! aggregators.

How aggregators work

Aggregators are a good thing from the point of view of Web-site developers.
The headlines whet readers’ appetites and increase the number of Web-site
visitors. To make their Web sites available to aggregators, Web-site develop-
ers encode headlines and story summaries using the RSS standard. These
encoded headlines and story summaries are called RSS feeds. To show that
their Web sites have been encoded for RSS — that is, to show that their Web
sites are capable of feeding headlines and story summaries to aggregators —
Web-site developers mark their Web sites with RSS feed icons like the ones
shown in Figure 6-2.
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Figure 6-2:
RSS feed
icons.
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When you see one of these RSS feed icons on a Web site, it means that the
Web site can feed headlines and story summaries to an aggregator. Making
the connection between your aggregator and a Web site that interests you is
called subscribing. To subscribe to a Web site so that it can feed your aggre-
gator, you click the RSS feed icon and copy a Web address to your aggregator
(I show you how to subscribe in a minute).

The aggregator keeps a list of Web sites to which it subscribes (refer to
Figure 6-1). Periodically, or when you ask it to, the aggregator polls each Web
site on the list to see whether anything is new, and if something is new, the
aggregator downloads the RSS feed from the Web site and displays a new set
of headlines and story summaries. In this way, aggregators always present
an up-to-date record of what is on each Web site to which they subscribe. In
this way, you can keep track of the news at your favorite Web sites.

Aggregators fall in two categories. Some are software programs that you
download and install on your computer. Others are Web based; you open
them in your Web browser and run them by way of the Internet. Table 6-1
describes the different aggregators, whether they are Web based or are run
from a computer, and how much they cost.

Table 6-1 Aggregators

Aggregator Web Site Web Based Software Cost

Aggie http://bitworking. Y Free
org/Aggie.html

Activerefresh www.activerefresh.com Y $30

Awasu WwW.awasu.com Y Free

Bloglines www.bloglines.com Y Free

BottomFeeder www.cincomsmalltalk. Y Free
com/BottomFeeder

FeedReader www . feedreader.com Y Free

InfoSnorkel www.blueelephant Y $40
software.com

NewsApp http://server.com/ Y Free
WebApps/NewsApp

(continued)
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Table 6-1 (continued)

Aggregator Web Site Web Based Software Cost
NewsGator www.newsgator.com Y Free
Newz Crawler www.newzcrawler.com Y $25
Rocketinfo http://reader. Y Free
rocketinfo.com/
desktop
RssReader www.rssreader.com Y Free
SharpReader www.sharpreader.com Y Free
Shortwire www.shortwire.com Y Free
Wildgrape www.wildgrape.net Y Free
Newsdesk
WinRSS www.brindys.com/ Y Free

winrss/iukmenu.html

Yahoo! http://my.yahoo.com Y Free

I prefer Web-based aggregators. The problem with software aggregators is
knowing which stories you have read. Aggregators keep track of this for you,
but if you have one aggregator on the computer at home and one on your
computer at work, the two programs soon get out of sync, and you can’t tell
which stories you've read. I also like Web-based aggregators because they
are more convenient than their software counterparts.

Subscribing to a Web site

In a moment, [ describe the particulars of subscribing to a Web site with
Bloglines and Yahoo!, but no matter which aggregator you use, the proce-
dure for subscribing is the same:

1. At a Web site that offers RSS feeds, click an RSS feed icon, as shown in
Figure 6-3.

Later in this chapter, “Finding RSS feeds with a search engine” explains
how to find Web sites with RSS feeds. You can expect to see more RSS feed
icons on Web sites in the years to come. Earlier in this chapter, Figure 6-2
shows examples of RSS feed icons. As of this writing, the majority of the
icons are marked XML (because RSS feeds are encoded using XML, or
eXtensible Markup Language). Some RSS feed icons — Yahoo!, Bloglines,
and Newsgator — are named after aggregator programs. Some show the
word Subscribe; others are labeled Atom, which is the name of an RSS
encoding format; and others show the letters RSS.

As soon as you click an RSS feed icon, your browser opens a window
with RSS XML feed codes, as shown on the right side of Figure 6-3. Yikes!
These codes are scary! But don’t worry about it. All they do is tell aggre-
gator programs how to fetch RSS feeds.
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a Web page.

Gathering the News with an Aggregator 161

Below is a selection of the BEC News pages available for syndication

LM News Front Page

ECM Africa 27 hp:inews.bbe.co.uk/ss) line_world_edition/europe/ss091.xml == =]

L Americas File Edit View Favorites Tools Help i

ELH Asia-pacific Addiess | ] Witpiinews e co.ukirssinewsonline_world_edbion/eurapefrssnat vl v
~

<tuml version="1.0" encoding="150-28859-1" 7> Cut
- <rss version="0.91"= -
- «channel> Lopy {%

EL8 Business <title>BBC News | Europe | World Edition</title Paste

ELTH Health <link=http:/ fnews.bbe.co.uk/go/clickfrss/0.9  Delete

Ef[M science/Nature f2/hifeurope/default.stm</link=

ElMTechnology <description=Updated every minute of every dé

EL¥ Entertainment PERSONAL USE OMLY </descriptionz

Ell[¥Have Your Say zlanguace>en-gb</anguace>

EQMMagazine <lastBuildDate=Fri, 07 Jan 05 17:05:01 GMT=/lastBuldDatex

ELQM week at a Glance <copyright>Copyright: (G) British Broadcasting Corporation,

ELM Programmes http://mews bbc.co.uk/1/hi/help/3281849 . stm</copyright=

<docs=http://www.bbe.co.uk/syndication/ </docs>
- <image:
=title=BBC News=/title>
b
< | >

2. Right-click in your browser’s address bar and choose Copy on the
shortcut menu to copy the address to the Windows Clipboard, as
shown in Figure 6-3.

Make sure that the Web address in the address bar is highlighted when
you choose Copy. The address should be highlighted automatically
when you right-click, but if it isn’t, drag over the address before right-
clicking. If the address bar isn’t displayed in your browser, right-click the
main menu and choose Address Bar on the shortcut menu.

3. Go to your aggregator and follow the procedure for subscribing.

You are asked to paste the Web address you copied in Step 2 into a text
box. The Web address tells your aggregator where to go on the Internet
to fetch an RSS feed.

Using the Bloglines aggregator

Bloglines (www.bloglines.com) is my favorite aggregator. I like its clean
interface (refer to Figure 6-1). Changing around the headline and story sum-
mary displays is easy. Canceling a Web-site subscription is easy as well. You
can also use Bloglines to create a blog and search for Web sites that offer
RSS feeds.

To use Bloglines, click the Register link to register and create an account.
You are interrogated in the usual fashion as you create your account. You are
asked for your e-mail address and a password. To activate the account,
respond to the validation e-mail message.
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Subscribing with Bloglines

To subscribe to a Web site, start by signing in and clicking the My Feeds tab.
Then open a second browser window and follow the directions in “Subscribing
to a Web site,” earlier in this chapter, to obtain the Web address of the RSS
codes you need to subscribe. Follow these steps to subscribe after you have
copied the RSS codes:

1. Click the Add link.
A new panel opens on the right side of the window.

2. Right-click in the Blog or Feed URL text box in the right side of the
window and choose Paste on the shortcut menu.

The Web address of the RSS codes appears in the text box.
3. Click the Subscribe button.

The Options window appears so that you can tell Bloglines how to
deliver headlines and story summaries to your Bloglines account. You
can change these settings at any time by selecting a feed on the My
Feeds tab and clicking the Options link.

4. Click the Subscribe button in the Options window.
The name of the Web site you subscribe to appears on the My Feeds tab.

To unsubscribe to a feed, select its name on the My Feeds tab and then click
the Unsubscribe link. You can find this link on the right side of the window,
above the feed name.

Viewing headlines and story summatries

Feed names on the Feeds tab appear in boldface text if you have not selected
them yet. To view headlines and story summaries from a feed, click its name
on the Feeds tab. The right side of the window displays headlines and story
summaries (refer to Figure 6-1). If a story intrigues you, click its headline to
open the story in a Web-browser window.

To see stories from the past that you have already reviewed, click a feed
name. On the right side of the window, open the drop-down menu and
choose a time period, as shown in Figure 6-4. Then click the Display button.

Using the Yahoo! aggregator

As shown in Figure 6-5, Yahoo! offers an aggregator on the My Yahoo! page.
You must be registered and signed in to Yahoo! to take advantage of the
Yahoo! aggregator. (Appendix A explains how to register with Yahoo!.) To get
to your My Yahoo! page, click the My Yahoo! icon or point your browser to
this address: http://my.yahoo.com.
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Figure 6-5:
The Yahoo!
aggregator
on the My
Yahoo!
page.
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Follow these steps to make RSS feeds appear in the My Yahoo! aggregator:

1. Follow the instructions in “Subscribing to a Web site,” earlier in this
chapter, to obtain the Web address of the RSS feed codes you need to

subscribe.
2. On your My Yahoo!
You land in the Add

page, click the Add Content button.

Content window.
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3. Click the Add RSS by URL link.

You can find this link to the right of the Find button. You go to the Add
RSS by URL window.

4. In the URL text box, right-click and choose Paste to enter the Web
address of the RSS feed codes.

5. Click the Add button.
The Add window appears.
6. Click the Add button in the Add window.

To remove RSS feeds from your My Yahoo! page, click the Remove button
(the X) next to the headlines. Click the Edit button and choose Edit
Content on the shortcut menu to change how headlines are delivered.

Where you see the My Yahoo! RSS feed icon at a Web site, you can click the
icon and instantly subscribe to a Web page (as long as you're signed in to
Yahoo!, of course).

Finding RSS feeds with a search engine

You can expect to see more RSS feed icons on Web sites in the years ahead.
Meanwhile, finding Web sites that offer RSS feeds can be a chore. One way to
find them is to enter the name of your favorite news source in Google along
with the phrase “RSS feed” (include the quotation marks). I've found many
RSS feeds that way. You can also search for RSS feeds with a search engine
especially designed for that purpose. Table 6-2 lists RSS-feed search engines.

Table 6-2 RSS-Feed Search Engines
Search Engine Address

BloogZ www.bloogz.com/rssfinder
Daypop www.daypop.com

Feedster www . feedster.com

NewslsFree www.newsisfree.com

Syndic8 www.syndic8.com

Getting News Alerts from Google by E-Mail

To help you stay on top of your favorite subject, academic endeavor, or pas-
time, Google can alert you by e-mail when it discovers something new on the
Internet that may be of interest to you. As you know if you read Chapter 3 of
this minibook, Google’s spiders crawl the Internet looking for updated Web
pages and new information, and this information is entered in the Google



Figure 6-6:
Creating a
“Google
alert.”
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database. With Google alerts, you can be informed when new information in
a particular area has been cataloged by Google. For example, if your area of
interest is the hissing cockroach of Madagascar, you can arrange for Google
to alert you by e-mail when a Malagasy cockroach hisses anew on the
Internet. The e-mail tells you the name of the Web site where the new infor-
mation is found and invites you to click a link to go straight to the Web site
and examine the new information yourself.

Do one of the following to go to the Google Alerts page and tell Google how
to alert you:

4+ Go to the Google home page (www.google.com), click the More link, and

. . . Book II
on the Google Services page, click the Alerts link. Chapter 6

4+ Open your Web browser to this address: www.google.com/alerts.
=
As shown in Figure 6-6, describe what you want to be alerted about and how g
you want to be alerted: >
-
4+ Search Terms: Enter keywords to describe the news or information you E-
seek. Be very specific, or else you will be inundated with e-mail alerts. =

4+ Type: Declare whether you want Web pages from news Web sites, from
the Internet, or from both places.

4+ How Often: Choose from the drop-down menu how often you want
Google to send the e-mail alerts.

4+ Your Email: Enter your e-mail address.

FAQ | Sign in

G OC )8 [e Google Alerts (BETA)

Alerts

Welcome to Google Alerts Create a Google Alert

y Enter the topic you wish to monitor.
Google Alerts are email updates of the latast relevan R
Google results fwab, news, etc.) based on your choice i frieins: Wladasas hi
of query or topic. Search terms: Madagascar, “hissing coc
Typer News & Yabh

Some handy uses of Google Alerts includa T

Howe often once aweek ||

= ronitoring a developing news story Your emall:  JohnDoe@remain. com
» keeping current on a competitor or industry )

= getling the latest on 2 celebrity or event [ Creste Alen

= keeping tabs on your favonte sports teams

Google mill not sell o1 share your email addiess.

Create an alert with the form on the right.

fou can also siqn in fo manage your alerts

Click the Create Alert button. Google sends you a verification e-mail. Click
the link in the e-mail message to start receiving alerts.
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News Search Engines

When you want to get the latest news about a topic, search for it with a news
search engine. These search engines work just like other search engines. Enter
a keyword or a keyword combination in the Search text box to describe the
information you are looking for. Table 6-3 describes news search engines (later
in this chapter, Table 6-4 describes search engines that focus on international

news).

Table 6-3

News Search Engines

Search Engine

Web Address

Notes

All the Web News

www.alltheweb.
com/?cat=news

Search for news by keyword on
the Internet. Click the Advanced
Search link to search for news by
category. On the All the Web
home page (www.alltheweb.
com), click the News tab.

AltaVista News

http://news.
altavista.com

Search for news by keyword. You
can make choices on the Topic,
Region, and Time Period drop-
down menus to direct your
search. At the AltaVista home
page (www.altavista.com),
click the News tab.

Ananova

WWW.ananova.com

Browse late-breaking news sto-
ries in different categories. Also
offers oddball news stories it calls
“quirkies.”

Columbia
Newsblaster

wwwl.cs.columbia.
edu/nlp/newsblaster

This is an experiment of the
Columbia Natural Language
Processing Group that draws
material from 17 Internet news
services and “rewrites” the sto-
ries onto one page using artificial
intelligence techniques.

Daypop

www.daypop.com

Search for news by keyword in
traditional news sources as well
as blogs, RSS news headlines,
and RSS blog posts.

Google News

http://news.
google.com

Search for news by keyword in
4,500 news sources or by brows-
ing in different categories. On
the Google home page (www .
google.com), click the

News link.
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Search Engine Web Address Notes

NewsTrove.com www.newstrove.com Search for news by keyword or by
browsing. Includes many links to
online newspapers and newspa-
per columnists.

Yahoo! News http://news. Search for news by keyword or by
yahoo.com browsing in different categories
for stories collected by Yahoo!
editors. On the Yahoo! home page
(www.yahoo.com),click the
News link.

At Today’s Front Pages, you can see what the front page of several dozen
daily newspapers look like as of today. Move the pointer over a thumbnail
image of a front page to see it on the right side of the screen, as shown in
Figure 6-7. Click a thumbnail to see a front page at high resolution in a pop-
up window. Today’s Front Pages is located at this address:
www.newseum.org/todaysfrontpages.

£ Map View // Listby Region // About // Help // FAQ // ContactUs // NEWS=UM

Figure 6-7:
Newspaper
front pages,
unfolded
and ready to
read.

Starting from a News Portal

In Internet talk, a portal, also called a Web portal, is a Web site that delivers
many different things — Internet searching, e-mail, shopping, and more. A
news portal does the same, only for news. It gives you the news in many dif-
ferent categories. The Web sites listed here represent news organizations.
They gather the news on their own without relying on Web sites:
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4+ BBC: You can search for world news very easily at this refreshing news
portal. Click the name of a continent on the left side of the screen to search
for news in one part of the world. Address: http://news.bbc.co.uk

4+ CNN: Get news in different categories by clicking links on the left side of
the window. Address: www.cnn.com

4+ MSNBC News: What do you get when you cross a software monolith
with a news behemoth? You get MSNBC News. With so many news cate-
gories, finding anything at this Web site is like searching a labyrinth.
Address: www.msnbc.msn.com

4+ Reuters: Open the drop-down menu and choose an edition — one tailor-
made for your part of the world. This Web site gathers news from its
2,000 reporters in the field. Address: www.reuters.com

Memigo is a novel Web site that only presents news stories that are of inter-
est to its registered members. Members submit stories and rate stories as
they read them. Stories with the highest rating are moved to the top of the
Memingo home page. What’s more, Memingo keeps track of stories you have
rated highly and suggests stories based on your ratings. To check out
Memingo or become a registered member of the Web site, go to this address:
www.memigo.com.

To search for online video news reports, start at Blinkx TV Video Search
(http://bTinkx.tv) and enter a keyword. This search engine looks for
video reports in 20 different news sources, including the BBC, CNN, ESPN,
and British Television.

Reading Online Newspapers

Chances are, your local newspaper publishes an online edition. Try search-
ing for its name to find out. The following newspapers are on my all-star list
because they offer high-quality writing and reporting, and because you can
search their archives and use them for historical research:

4 Christian Science Monitor: This newspaper is known for its even-tempered
reporting and the breadth of its coverage of world news. Read articles
since 1999 for free; to read articles published before that date, you must
pay a fee. Address: www.csmonitor.com

4+ The New York Times: That the Gray Lady (as the Times is known
because the Times building is a shade of gray) is online is almost too
good to be true, but you can also search back issues of the Times to 1996
for free; you pay a fee to read articles published between 1851 and 1996.
You must register to read articles. Address: www.nytimes.com

4+ Washington Post: By registering, you can read the Washington Post
online. For a fee, you can search the newspaper’s archives dating to
1877. Address: www.washingtonpost.com
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@EB Sirg Newslink (http://news1ink.org) offers links to hundreds of small-town

/ I/;_~ newspapers in the United States. You can also find alternative newspapers,
\“\“ ""I// online radio stations, and newspapers from other continents. Metagrid
@’ (www.metagrid.com) is a search engine for locating newspapers’ home

pages. Enter the name of the town that the newspaper serves and click the
Search button. At Crayon.net (www.crayon.net), you can create your own
newspaper — well, sort of. After registering, you pick a name for your news-
paper and tell the Web site from which sources to get the news. Then
Crayon.net creates a Web page with links to all your favorite news sources.
Over morning coffee, you can go to your “newspaper” at Crayon.net and
click a link on the list to quickly check the news.
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Getting the News from Abroad

What’s going on in the outside world? Table 6-4 shows how you can find out
by searching for international news with a search engine. If you aren’t using a
search engine to get the news of the world, test-drive one of these Web sites:

Jjnoqe ||y peay

4+ All Africa: This Web site focuses on news from Africa. Search by country
from the drop-down menu or investigate a topic by clicking its name on
the left side of the window. Address: http://allafrica.com

4+ Kidon Media Link: Search by country, not just for newspapers but also
for magazines, news agencies, and online radio stations. Address:
www.kidon.com/media-Tink/index.shtml

4+ Kiosken: Find and read online newspapers starting at this Web site by
selecting a continent and then a country name. This Web site is brought
to you by the Esperanto Federation, an organization bent on teaching
the world how to speak Esperanto. Address: www.esperanto.se/
kiosk/engindex.html

4+ World Press Review: This excellent Web site covers compelling world
news that doesn’t reach our part of the world. Click a region name to
read news from one part of the world, or enter a keyword to search the
site for news. Address: www.worldpress.org

Table 6-4 International News Search Engines

Search Engine Web Address Notes

NewsTrawler www.newstrawler.com Search for news by country or by
category.

World News Network ~ www.wn.com Click the Advance